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FCC Compliance Statement

FOR YOUR OWN SAFETY

NOTE: Shielded cables should be used for a composite interface. This is to
ensure continued protection against radio frequency interference.

FCC WARNING STATEMENT

NOTE: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and receiver.

•  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

•  Consult the dealer or an experienced radio/TV technician for help.

CAUTION

Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Shielded interface cable must be used in order to comply with the emission limits.

LABEL WARNING

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause
undesired operation.

Pinnacle Systems                       miroVIDEO DC50

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
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About the User’s Guide

This User’s Guide explains how to install and use the miroVIDEO DC50
hardware and software. Instead of using the complete product designation,
the abbreviation DC50 is used for a better readability.

In the margins are subheadings to help you quickly find your way through
this manual.

Important text passages are marked with the “notepad” and this format.

Numbers mark step by step instructions:

1. Start TitleDeko.

Bullets mark instructions for optional steps the order of which is not
important.

•  Connect the board to the camcorder.

All keyboard commands appear in this font:

install

 

 Menus, commands, options or buttons which the user can select are written
in italics.

Subheadings
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For your own safety

In the interest of your own safety and the flawless functioning of your new
product and computer system please note the following:

� Computer components are sensitive to static charge. Divert any
electrostatic charge from your person before touching the components
with your hands or any tools.

� Before opening the computer make sure that the power plug is
disconnected from the wall outlet.

For changes or supplements that could not be included in the printed
documentation, please, refer to the ReadMe file on the CD-ROM supplied
with your system!



Welcome  1

 

Welcome

The following section gives you an overview of the features and the fields
of application of the DC50 hardware and software, and tells you what you
need to set up a working DC50-based editing system.

WHAT IS DC50?

DC50 is a professional non-linear video and audio editing system for the
Windows NT, Windows 95/98 platform.

State-of-the-art technology offers not only highest performance and
productivity, but also best signal quality.

Speed optimized codec technology provides enormous rendering power for
fast video editing, compositing and animation.

A professional breakout box ensures high quality connection to studio
equipment like Betacam SP machines and other component video devices.
All connectors and signals totally comply with the ITU.R 601 studio
standard.

The studio-quality output, delivered by DC50, makes it the ideal system for
high quality video and audio post production needs.

Videos produced with DC50 can be broadcast.

How does it work?

DC50 converts analog video and audio signals into a digital, computer-
editable format by recording video sequences into Motion-JPEG
compressed AVI files at Betacam SP quality.

The video can then be edited digitally on the computer, adding digital
effects and doing any number of layers without generation loss. During
editing, the DC50 hardware does all required compression / decompression
operations and generates the monitor output signals.

The resulting digital video can then be output to tape at Betacam SP quality,
or it can be transformed into lower quality CD/internet video.
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What is it good for?

The DC50’s video post-production hardware capabilities combined with the
bundled video editing software (Adobe Premiere, After Effects) provide a
complete video studio on your desktop.

DC50 meets all requirements for creating industrial video, commercial
video, corporate presentations, training tapes, wedding videos, or event
videos.

You can

� quickly do online nonlinear editing with hour long projects

� compose videos with unlimited layers and complexity

� add titles, transitions, 3D-effects, video filters

� output 3D rendered computer animations to video tape

� edit up to 99 tracks of stereo audio

� work with still frames from your video source

� combine all the above

� and much more

� all this at high speed, maximum quality and easy to use.

System components

The DC50’s capabilities result from optimally integrated hardware and
software:

The DC50 board is a state-of-the-art PCI video digitizer and player working
with YUV 4:2:2 signals.

It includes a JPEG processor to compress/decompress video at up to 7MB/s
compressed data rate as well as an audio codec to digitize and output audio
signals at up to 48kHz, 16bit stereo.

All this in real time, using just a single PCI slot with busmaster mode.

The DC50 breakout box offers comfortable connections to all kinds of
professional and prosumer video and audio equipment, including component
video, XLR audio and reference / genlock I/O. All signals comply with the
ITU-R 601 studio standard and offer broadcast quality.

The DC50 driver software controls the video capture, compression,
decompression, and playback. It's speed optimized for high data rates and
low response times, and includes user friendly dialog boxes to do all
required settings.

miroVIDEO EXPERT is a hard disk benchmark utility that allows you to
make best use of your system.

miroINSTANT Video is a software that connects Adobe Premiere directly
to the DC50 hardware, giving you massive productivity gains and other
advantages.

Hardware

Software
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Adobe Premiere is the industry standard application for PC-based video
editing. It does online non-linear editing with lots of transitions, filters,
titling, as well as off-line editing and much more. No matter if you are a
beginner or an expert - with Adobe Premiere you can easily produce digital
videos in high quality. Adobe Premiere enables the combination of video
sequences with animations, still images, and graphics.

Adobe After Effects is the best selling professional compositing
application. Adobe After Effects is an efficient tool for producing 2D
animations and special effects for film, video, multimedia, and web projects.
After Effects enables the production of high quality video sequences. With
Adobe After Effects you can produce on-air-clips, commercials, music
videos, complex animations on several levels, web-based movies, and
impressing special effects on your desktop system.

TitleDeko is a plug-in program for Adobe Premiere. This plug-in is
designed to work with your miroVIDEO DC50 board. As an integrated title
editor program, TitleDeko allows you to create professional quality titles
and graphics quickly and easily. Titles can contain words, shapes,
background colors, and photos or graphics imported from other programs.
TitleDeko offers professionally developed Preset Styles for quickly making
titles, along with virtually endless custom styling. You can modify titles for
a variety of effects, such as titles that roll in vertically or crawl horizontally.
You can also adjust the duration the title appears in your movie.

WHAT ELSE IS REQUIRED?

To set up a complete editing system with DC50 and work successfully with
it, you need a few things that aren't in our box:

� A PC fulfilling the DC50 system requirements. Old, slow components
will lead to problems or reduce the achievable data rate and quality.

� A well functioning PC – first make sure that all other hardware and
software components work well together, then start installing the DC50
system.

� Video equipment, at least one VCR that can be used as both player and
recorder, of course with tapes.

� Video cables, depending on your type of equipment. And a basic
knowledge of video terminology.

� If you never did nonlinear editing, we suggest that first of all you install
Premiere and get familiar with some basics, then start working with
DC50.

� A minimum amount of patience to read this manual, the ReadMe file and
the online help.

� And then, creativity, because with your DC50 system you are able to do
everything with video you can imagine, not more and not less. Have fun!

Bundled
Applications
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ABOUT THIS USER’S GUIDE

Welcome
The following chapter gives a short instruction of the user's manual and an
overview of the features of the DC50 video capture boards.

Before you begin
The chapter “Before you start” describes the system requirements and the
package contents of DC50. Please read this chapter carefully, before you
start the installation of the board.

Quick start
Do only use the “Quick Start”, if you have already worked with other video
boards and Premiere, and if you are familiar with the installation of
hardware and software under Windows.

Installing Adobe Premiere
The chapter “Installing Adobe Premiere” gives a short description of the
software installation. Adobe Premiere must be installed before installing
DC50. For more detailed information about Adobe Premiere, please refer to
the corresponding user's manual.

Installing the hardware
In the chapter “Installing The Hardware” you will find important
information on how to delete an already installed video capture board from
your computer and how to mount DC50.

Connecting the breakout box and the video devices
The chapter “Connecting the breakout box and the video devices” gives a
detailed description of the possible connections and the cabling of DC50,
the breakout box, and the video devices.

Installing the software for Windows 95 / 98
The installation of the software under Windows 95 / 98 is described in detail
in the chapter "Installing The Software under Windows 95 / 98".

Installing the software for Windows NT
The installation of the software under Windows NT is described in detail in
the chapter "Installing The Software Under Windows NT".

Editing videos under Windows 95 / 98
The chapter “Editing Videos Under Windows 95 / 98” contains a
description of the first steps in video editing under Adobe Premiere.
Furthermore, the audio application is described in this chapter.

Editing videos under Windows NT
The chapter “Editing Videos Under Windows NT” describes the
applications DC50 Control and miroVIDEO Capture.

miroINSTANT Video
The chapter “miroINSTANT Video” describes this application in detail.

FreeFX
The section “FreeFX” explains how to use the accelerated 3D effects made
available by Pinnacle FreeFX.
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TitleDeko
The chapter “TitleDeko” explains how to use the TitleDeko character
generator to add titles, rolls and crawls, with a variety of text effects.

Video SpiceRack
The chapter “Video SpiceRack” introduces Video SpiceRack, a collection of
300 top-quality transitions and dynamic effects.

Optimizing the performance
In the chapter “Tips & Tricks” you learn how to optimize, if necessary, your
computer for capturing and editing digital videos.

Troubleshooting
If you face problems while working with DC50, please refer to the chapter
“Troubleshooting”.

Technical data
The chapter “Technical data” contains all important data of DC50.

Appendix
The “Appendix” gives you general information about digital video, and it
contains furthermore the support questionnaire, which you can fill out and
send us back in case of problems.

Index
A detailed index concludes this User’s guide.
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Before you begin

This chapter tells you which computer system components are required for
the operation of the DC50, which devices you can connect to the board, and
what is included in the DC50 package contents.

SYSTEM REQUIREMENTS

Please make sure your system meets the following requirements before
installing the DC50:

Minimum

The following system configuration summarizes all minimum requirements
on the system.

Pentium133 PC or compatible computer

One free 32-Bit PCI-Slot (bus-master), Version 2.1

64 MB

The reachable data rate and the video quality depends to a large amount on
the used PC-motherboard or the chips. Please pay attention to the
compatibility list on the http://www.pinnaclesys.com website.

500 MB free hard disk space for system software

Hard disk with 10 MB/s continues data rate

Do absolutely use one hard disk for the system software and applications,
and at least a second one exclusively for the video data.

16 Bit (HiColor) graphics board

In order to display the played back video footage jerkylessly on the PC-
monitor, your graphics board needs to support DirectDraw in the set
Windows resolution. Furthermore, it must be able to display at least 16 Bit
color depth (65,536 colors). Please pay attention to the compatibility list on
our website).The color depth necessary for an overlay is determined by the
DirectDraw driver.

CD-ROM drive for the software installation

Windows NT 4.0 or Windows 95/98

Processor
Slot

Memory
Motherboard

System disk
Video disk

Graphics board

CD-ROM drive
Software
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Recommended system configuration

We recommend the following system configuration. Such a system allows
you to use DC50 at its highest quality and speed.

Pentium III 500 PC or compatible computer. When working under Windows
NT 4.0, dual CPU system, if necessary. Motherboard see below.

One free 32-Bit PCI-Slot (bus-master), Version 2.1

256 KB. Important: The motherboard must be able to cache the whole
primary store.

The reachable data rate and the video quality depends to a large amount on
the used PC-motherboard or the chips. Please pay attention to the
compatibility list on the http://www.pinnaclesys.com website.

Fast E-IDE or Ultra Wide SCSI hard disk

Ultra Wide SCSI AV hard disk(s) with 9 GByte hard disk space. When
using Windows 95 / 98 formatted with “FAT16”.

Please do absolutely use one hard disk for the system software and
applications and at least a second one exclusively for the video data.

24 Bit (TrueColor) graphics board

In order to display the video footage jerkylessly on the PC-monitor, your
graphics board needs to support DirectDraw in the set windows resolution
and must be able to display a color depth of 16 bit (65,536 colors). Please
pay attention to the compatibility list on our website) The color depth
necessary for an overlay is determined by the DirectDraw driver.

CD-ROM drive for the software installation

Windows NT 4.0 or Windows 98

External video monitor

Processor

Slot
Memory

Motherboard

System disk
Video disk

Graphics board

CD-ROM drive
Software
Monitor
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Video/audio devices

Video input
Via the Breakout Box the DC50 connects to any video source (VCR, video
camera, TV tuner, laser disk) generating a component video, composite
video or S-Video signal in PAL, NTSC, or SECAM quality.

Video output
Via the breakout Box the DC50 video output connects to any video device
(television set, VCR, camcorder) that supports a component video,
composite video or an S-Video signal in NTSC or PAL.

Audio input/output
Via the Breakout Box you can connect the audio inputs/outputs of your
video and audio devices (i.e. microphone, CD player or powered speakers)
to the DC50.

Cables

To connect video/audio devices to the DC50 board, you need suitable cables
(Cinch, S-Video or BNC cables).
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PACKAGE CONTENTS

Please make sure your DC50 system is complete before you begin the
installation. The system includes*:

DC50 board** Breakout box

CD-ROM with drivers, extended Adobe Premiere
Adobe Premiere presets, After Effects
miroINSTANT Video
Pinnacle FreeFX and
online documentation

Pixèlan Video SpiceRack Effects TitleDeko

Documentation 2 Adapters
(Cinch to BNC / BNC to Cinch)

If any parts are missing, please contact your retailer.

Computer components are sensitive to electrostatic charge. Do not take the
DC50 board out of its antistatic package until you install it.

                                                          
* Depending on the delivery scope, the package contents may vary from the contents listed in this manual.
** For model and  serial number of your board, refer to the label on the board.
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EXISTING MOTION-JPEG CAPTURE BOARD

If you have already installed a Motion-JPEG video board in your computer,
it is recommended that you remove this board before installing the DC50
board. To do so, it is required that you also remove the corresponding
software. You have to remove the software while the board is still installed.
(Start > Settings > Control Panel > Software)

For doing so, please try the following possibility first:
Go to the program group of your video capture board via the Start menu and
the command Programs. Then start the deinstallation. Please follow the
program instructions.

If no program for deinstalling your video capture board is available, try the
second possibility:
Select Settings in the Start menu, select Control Panel and System, Device
Manager and Sound, video and game controller. Click on your video board
and on Remove.

After having finished and having switched off the computer, you can
remove the video capture board from your computer.

For doing so, please try the following possibility:
Go to the program group of your video capture board via the Start menu and
the command Programs. Then start the deinstallation. Please follow the
program instructions.

If no program for deinstalling your video capture board is available, try the
second possibility:
Select Settings in the Start menu, select Control Panel and System, select
Devices, select your video capture board, click Startup, chose the Disable
option and click OK.

After having finished and having switched off the computer, you can
remove the video capture board from your computer.

DEFRAGMENTING THE HARD DISK

Before installing and configuring the DC50 you should defragment your
hard disk/s. You find the Windows 95/98 defragmentation utility under
Start, Programs, Accessories, System Tools, Disk Defragmenter. If you use
the DC50 under Windows NT, format the video hard disk again, or use a
newly formatted partition.

Windows 95 / 98

Windows NT
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Quick start

The following chapter is designed so that you can start using your DC50
board immediately. This is useful, if you have already experience in
working with other video boards and Premiere, and if you are familiar with
the installation of hardware and software under Windows.

For more detailed installation instructions, please refer to the subsequent
chapters in the manual.

INSTALLATION

Proceed as follows to install the DC50 hardware and software:

Install Adobe Premiere.
� Place the Adobe Premiere-CD-ROM in your CD-ROM drive.
� Select Run… from the Start menu.
� Depending on your drive, enter, for example:

e:\setup\setup,
then click OK.

� Follow the installation instructions on the screen.

Install the DC50 board.

� Turn your computer and all peripherals off.

� Remove the necessary cables.

� Open the computer's housing.

� Remove the slot cover.

� Insert the board.

� Reassemble your computer.

� Reconnect all cables.

Connect video source(s) to the video input(s)*.
� Connect the video source, depending on the output signal, to the

component, composite, or S-Video input of the breakout box.

Connect a VCR/television to the video output *.
� Connect the VCR/television to the appropriate video output

(composite, S-VHS or component).

                                                          
* For help with this, refer to the layout of the breakout box on page Fehler! Textmarke nicht definiert..
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Establish the audio link *.
� Connect the audio source to the audio input of the breakout box.
� Connect the balanced audio source to the balanced audio input of

the breakout box.
� Connect the recording device or active loud-speakers to the audio

output of the breakout box.
� Connect the recording device or the active loud-speakers to the

balanced audio output of the breakout box.

Connect the breakout box to the DC50.
� Connect the breakout box to the 62-pin connector of the DC50,

screw it tight. Afterwards, please do not bend or pull the cable.
� Switch your computer on.

Install the DC50 software.
� Place the CD-ROM in the CD-ROM drive.
� Follow the installation program instructions on the screen.

Configure the DC50 (Windows 95/98 only).
� Test your hardware to make sure it is operating correctly.
� miroVIDEO EXPERT starts up automatically to check your

system's performance level.
� Quit configuration by clicking OK.

VIDEO RECORDING (WINDOWS 95/98)

Start Adobe Premiere.
Start Adobe Premiere from the Premiere program group.

Choose Preset.
Choose the appropriate miroDC50 preset (miroDC50 TV-cropping).
Note down the displayed image resolution.

Save the Project.
Choose File and Save, and save the (still empty) project to a video hard
disk with a sufficient amount of free storage space (on this hard disk
several video effects will be saved).

Choose Movie Capture.
Choose File, Capture, and Movie Capture.

Make Settings for Video Source.
Choose Movie Capture and Video Source.... Choose under Connector
the type of video source and under Video the video standard.
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Set frame rate.
Choose Movie Capture and Record settings... . Choose for PAL and
SECAM 25 fps, for NTSC 30 fps.

Choose Video Format.
Choose Movie Capture, Record settings..., and Video Format. Click on
Default, if necessary, modify the preferences. The resolution must be
the same as the one you wrote down before.

Choose Audio Format.
Choose Movie Capture and Audio recording options.... Choose
44.1kHz, 16bit, stereo, non-compressed.

Activate Overlay, if necessary.
Choose Movie Capture and Video Display.... Choose Overlay while
recording.

Activate Record Audio.
Activate the command Record Audio via Movie Capture, if necessary.

Save the Settings.
Save the settings via Movie Capture and Save settings... .

Choose hard disk.
Choose the hard disk, which has been detected as being optimal for
recording by miroVIDEO EXPERT, via File, Preferences, and Scratch
Disk... .

Capture Video.
Click on the Record button, in order to start video recording. Click
<Esc>, in order to stop video recording.

VIDEO RECORDING (WINDOWS NT)

Start miroVIDEO Capture.
Start miroVIDEO Capture from the DC50 program group.

Adapt Video Settings.
Choose the Video Standard and TV-Cropping from the Projects tab.

Check the Audio Settings.
Activate Audio capture, choose 44.1 kHz.

Determine Video and Audio Inputs.
Choose the corresponding inputs on the Settings tab, if necessary adjust
the audio level.
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Determine the Recording Drive.
Determine the recording drive on the Settings tab.

Recording Movie Sequences.
Click on the Record button on the Record tab, in order to start
recording. Click on the Stop button, in order to stop recording.

VIDEO EDITING

Proceed as follows to edit your recorded video sequence:

Set up the video output.
Using windows 95/98: Double-click the  in the Taskbar to activate the
DC30 series Control tool. Modify the current settings as necessary.

Using Windows NT: Select Start/Programs/miroVIDEO
DC50/Tools/miroVIDEO DC50 control to activate the miroVIDEO
DC50 Control tool. Modify the current settings if necessary.

Start Adobe Premiere.
Start Adobe Premiere from the Adobe Premiere program group, and
select the appropriate settings from the list of DC30 project defaults.

Open the video sequence.
Select File and Import and the desired *.AVI file(s). Move the file(s)
from the clip window to the project window.

Edit the video sequence.
Add effects as desired. See the Adobe Premiere Manual for details.

Play the video sequence..
With the timeline window selected, hit the <Enter> key. Adobe
Premiere will ask you to save the project if you did not do it before, do
so.
Now Premiere will process the effects you have added.

After that the miroINSTANT Video playback of the work area will
automatically happen. The output can be recorded to tape.
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PLAYBACK WITH MEDIAPLAYER

Proceed as follows to play the edited video sequence on a television or to
record it on videotape:

Start media playback.
Start MediaPlayer from the miroVIDEO DC30 series program group.

Select the video output.
Use the DC50 Control to select the video output (Window, S-VHS,
Composite video) and define the output standard if required.

Play the file back.
Select Device and miroAVI Cache and then select the AVI file to play
back.

VIDEO REPLAY UNDER ADOBE PREMIERE

(WITH miroINSTANT VIDEO 5)

To use the features of miroINSTANT Video 5 you need Adobe
Premiere 5.1!

Start Adobe Premiere 5.1.
Start Adobe Premiere 5.1 from the Adobe Premiere program group and
open or create a project, drag it into the timeline and save the project.

Press <Enter>.
In the activated timeline window press the <Enter> key to start the
video playback.

What's next?

For more detailed instructions concerning any of the above functions, please
refer to the appropriate section below.

You can also find information concerning the installation of a PCI
expansion board in the documentation supplied with your computer.
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Installing Adobe Premiere

The following chapter describes the procedure to install Adobe Premiere.

You must install Adobe Premiere before installing the DC50 board in your
computer, because the DC50 presets must be copied to the appropriate
Adobe Premiere folder during the installation of the DC50 software, and
software installation starts immediately after the hardware installation.

Proceed as follows to install Adobe Premiere:

1. Place the Adobe Premiere CD-ROM in your CD-ROM drive.

2. If the installation program is not started automatically, select Run… from
the Start menu.

3. Depending on your drive, enter, for example:

 e:\premiere\setup.

If your CD-ROM drive has a different drive designation, change the path
accordingly.

—or—

Click on Browse..., switch to your CD-ROM drive and to the directory
mentioned above and double-click the setup.exe file.

4, Click OK.

5. Follow the program installation instructions on the screen.

After you have installed Adobe Premiere on your computer, you can install
the DC50 board.

If you ever need to reinstall Adobe Premiere, please remember to run the
DC50 installation again, selecting at a minimum the Presets and PlugIns.
DC50 will not work correctly if these components are missing.
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Installing the hardware

The following chapter explains how to install the DC50 board into your
computer.

REMOVING A VIDEO CAPTURE BOARD

If you have already installed a Motion-JPEG video board in your computer,
it is recommended that you remove this board before installing the DC50
board. To do so, it is required that you also remove the corresponding
software. You have to remove the software while the board is still installed.

Therefore proceed as follows:

Go to the program group of your video capture board via the Start menu and
the command Programs, and start the deinstallation. Please follow the
program instructions.

If no program for deinstalling your video capture board is available, proceed
as follows, depending on your operating system:

Windows 95 / 98

Select Settings in the Start menu, select Control Panel and System, Device
Manager and Sound, video and game controller. Click on your video board
and on Remove. After having finished and having switched off the
computer, you can remove the video capture board from your computer.

Windows NT

Select Settings in the Start menu, select Control Panel and System, select
Devices, select your video capture board, click Startup, chose the Disable
option and click OK. After having finished and having switched off the
computer, you can remove the video capture board from your computer.
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INSTALLING THE DC50

To insert the DC50 into your computer, proceed as follows:

1. Discharge yourself.

Discharge yourself charge by touching the metal case of your computer.

2. Switch off the computer, disconnect the cables.

Switch off the computer and all peripheral devices. Pull out the power
cord and disconnect all necessary cables.

3. Remove the cover.

Loosen the screws of the computer's cover and remove the cover.

4. Select a PCI slot.

Select a free (busmaster) PCI slot.

Slots

Slot shields

Power
supply
unit

PCI slots

5. Remove the slot shield.

Remove the slot shield at the back of the computer. If necessary, remove
the screw at the cover.
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6. Insert the board.

Insert the board carefully in the selected slot. Hold the board at the top
edge and push both ends simultaneously into the slot. Press the board's
top edge to make sure that the board is firmly seated in the slot. If any
components, as e.g. the chilling unit and the fan, on the CPU are in your
way, please choose another slot.

If the board cannot be inserted without problems, do not force the board into
place. The contacts at the connector could bend. Instead, pull the board out
carefully and try again.

7. Reconnect the cables.

Screw the slot sheet tight and reassemble the computer's casing.
Reconnect the cables. Do not yet switch your computer on.

The DC50 hardware installation is completed.

In the next step, you connect the breakout box to DC50 and to your video
equipment, as described on the following pages of the chapter
“Connecting the breakout box and the video devices”.
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Connecting the breakout
box and the video devices

The following chapter tells you how to connect your video devices to the
miro VIDEO DC50 via the breakout box, with the computer turned off.
To do so you need appropriate cables.

The following illustration shows the DC50 board with its connections:

Internal Audio Plug

D-Sub62 Connector

The following illustration shows the connections of the breakout box:

Video InputsAudio Inputs

Audio Outputs Video outputs

L R L R S-Video Comp. Y B-Y R-Y Ref
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CONNECTING THE BREAKOUT BOX

In order to connect the breakout box to the DC50, connect the 62-pin plug
of the breakout box with the D-Sub62 connection of DC50. Screw the plug
tight.

If the breakout box and DC50 are connected, please be careful with the
cabling. By pulling or pushing the cable, the DC50 board may be lifted out
of its slot. This may cause malfunctions and in the worst case a destruction
of the board or the PC!

CONNECTING THE VIDEO DEVICES

Via the breakout box you can connect S-Video and Composite video
devices as well as video devices with component connections to DC50.

First of all the possible cabling of your player is described, which provides
the video signal for digitalization and the following editing process on the
PC.

Player: s-video device

Choose this type of connection, if as a player an s-video device is used.

The following table and the illustration give an overview of the connections:

Player Breakout Box In

S-Video Output � S-Video Input �

Audio Output R � Audio Input R �

Audio Output L � Audio Input L �

L R L R S-Video Comp. Y B-Y R-Y Ref

���

If your player is equipped with S-Video outputs as well as with Composite
video outputs, please choose S-Video for quality purposes.
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If your player does not have cinch audio connectors for the direct
connection to the breakout box, you need an equivalent adapter available in
a specialist store for electrical devices.

Player: Composite video device

Choose this type of connection, if as a player a Composite video device is
used.

The following table and the illustration give on overview of the
connections:

Player Adapter Breakout Box In

Composite Video Output � Cinch-BNC* � Composite Video Input �

Audio Output R � Audio Input R �

Audio Output L � Audio Input L �

L R L R S-Video Comp. Y B-Y R-Y Ref

Cinch on BNC-Adapter

��� *

* If the Composite video output of your player is a BNC plug, the
connection does not require the supplied cinch on BNC adapter .

If your player does not have cinch audio connectors for the direct
connection to the breakout box, you need an equivalent adapter available in
a specialist store for electrical devices.
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Player: component video device

Choose this type of connection, if as a player a component video device is
used.

Player Breakout Box In

CH-1 Output � Balanced Audio Input L �

CH-2 Output � Balanced Audio Input R �

Y Video Output � Y Video Input �

B-Y Video Output � B-Y Video Input �

R-Y Video Output � R-Y Video Input �

L R L R S-Video Comp. Y B-Y R-Y Ref

� � � � �

If at the output of your player the sync signal is not included in the Y-signal
as usual, but is transmitted via the BNC connector instead, connect this
connector with an additional BNC cable to the Composite or Reference
input connector of the breakout box (depending on which one is free).

In this case, you need to select Reference as Sync source for the component
signal. If you use a component video device as player, and a s-video or
composite video device as recorder you need to select Reference as Sync
source for the component signal. You can do this via the miroVIDEO DC 50
Control, which has been installed on your computer during the software
installation, in the dialog box Extended settings component input (start
Adobe Premiere, select File, Capture and Movie Capture. Click Movie
Capture, VfW Settings, Video input and Extended).

If your player is not equipped with balanced audio output connectors, you
may use the line audio inputs of the breakout box instead.
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Recorder: S-Video device

Choose this type of connection, if an S-Video device is used as a recorder.

The following table and the illustration give an overview of the connections:

Breakout Box Out Recorder In

S-Video Output � � S-Video Input

Audio Output R � � Audio Input R

Audio Output L � � Audio Input L

L R L R S-Video Comp. Y B-Y R-Y Ref

���

If your recorder is equipped with S-Video inputs as well as with Composite
Video inputs, please choose S-Video for quality reasons.

If you use a component device as video source, then you must additionally
connect a cable between a video out jack (comp. or ref., not a component
output) of the component device and the reference input of the connection
box.

If your player does not have cinch audio connectors for the direct
connection to the breakout box, you need an equivalent adapter available in
a specialist store for electrical devices.

Recorder: Composite video device

Choose this type of connection, if as a recorder a Composite video device is
used.

The following table and illustration give an overview of the connections:

Breakout Box Out Adapter Recorder IN

Composite Video Output � � BNC-Cinch* � Composite Video Input

Audio Output R � � Audio Input R

Audio Output L � � Audio Input L
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L R L R S-Video Comp. Y B-Y R-Y Ref

BNC on Cinch adapter

���

* If the Composite video input of your recorder is a BNC female
connector, the connection does not require the supplied BNC on Cinch
adapter.

If you use a component device as video source, then you must additionally
connect a cable between a video out jack (comp. or ref., not a component
output) of the component device and the reference input of the connection
box.

If your player does not have cinch audio connectors for the direct
connection to the breakout box, you need an equivalent adapter available in
a specialist store for electrical devices.

Recorder: component video device

Choose this type of connection, if as a recorder a component video device is
used.

The following table and illustration give an overview of the connections:

Breakout Box Out Recorder In

Balanced Audio Output L � � CH-1 Input

Balanced Audio Output R � � CH-2 Input

Y Video Output � � Y Video Input

B-Y Video Output � � B-Y Video Input

R-Y Video Output � � R-Y Video Input

Reference Output � � Reference Video Input
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L R L R S-Video Comp. Y B-Y R-Y Ref

� � � � � �

If your player is not equipped with balanced audio output connectors, you
may use the line audio inputs of the breakout box instead.

By default, DC50 generates the video timing for the analog output signals
on its own.

If you use DC50 in a studio environment where several video sources are
linked to a common house sync, you can link the DC50 output timing to that
common sync as well.

To do this, you must connect a sync signal to the reference input connector
of the DC50 breakout box, and must do the appropriate settings in the DC50
Control.

If the DC50 Control has not been placed as program into the task bar, start
the DC50 control via the Start menu, the command Programs, and the
program group DC50. If the DC50 Control has already been started, activate
it by clicking on the symbol in the task bar. Click on the More button, and
determine the genlock sync source under General.

Note that if DC50 is set to genlock playback, meaning if it's not in the
freerunning playback mode, there must be a stable video sync signal at the
selected sync input. Otherwise DC50 video output doesn't work.
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PLAYER AND RECORDER IN ONE DEVICE

Up to now player and recorder have been treated as two separate devices. In
video editing with DC50 it is also possible to have both functions combined
in one single video device. In this case, connect the device to the breakout
box as a player and as a recorder, as described above. In order to avoid
signal feedback, you need to deactivate the options Video loopthrough and
Activate reference output in the DC50 Control software.

CONNECTING THE MONITOR

The video display on the PC monitor gives a preview during editing.
Usually, the video is not displayed in full quality.

In order to check the image and the sound quality during digitalization,
editing and displaying you should connect a monitor and eventually
additional loudspeakers. There are two possibilities:

� Connect the monitor to the video and audio outputs of your recorder. In
this case the output signal of DC50 is transmitted to the input of the
recorder ( see cabling above), through the recorder and arrives then at the
monitor.

� Connect the monitor directly to the free outputs of the DC50 breakout
box. If your recorder is for example connected to the component output,
the monitor can be connected to the S-Video or Composite Video output
of the breakout box. If the recorder is connected to the XLR audio
outputs of the breakout box, the control monitor or the control
loudspeakers will be connected to the line audio output connectors of the
breakout box.
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CONNECTING A SOUND BOARD

If your system is additionally equipped with a further sound board (plug-in
card or audio hardware on the mother board) it is used for the output of
system sounds and for some sound outputs during video editing. Connect
this sound board to commercially available PC loudspeakers.

The audio hardware of DC50 ensures a lip synchronous digitalization and
output of the sound to the recorder. The connection will be handled as
already described with player, recorder, and monitor.

Audio data can only be output with miroINSTANT Video via the DC50
board.
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Installing the
software for Windows 95 / 98

Once you have installed the DC50 into your computer, you can install the
DC50 drivers and software. The installation steps for the Windows 95,
Windows 98 and Windows NT are slightly different.

Windows 95
If you have Windows 95 installed on your computer, please proceed with
the section “Installing the drivers for Windows 95 as of page 30.

The complete installation consists of the following steps:

� Installing drivers for Windows 95 as of page 30.

� Installing the software for Windows 95 / Windows 98 as of page 33.

Windows 98
If you use Windows 98, please proceed with the “Installing the drivers for
Windows 98” section on page 32.

The complete installation consists of the following steps:

� Installing drivers for Windows 98 as of page 32.

� Installing the software for Windows 95 / Windows 98 as of page 33.

Windows NT
If you use Windows NT, please read the “Installing the software for
Windows NT 4.0” chapter as of page 40.

Among other things, installing the DC50 software copies the DC50 drivers
to your hard disk. The DC50 program group is created, and the expanded
Adobe Premiere project defaults (Presets) are copied to your hard disk.
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INSTALLING DRIVERS FOR WINDOWS 95

Before installing the DC50 drivers for Windows 95, we recommend you to
identify the Windows version you use first. This is necessary, as the
different versions react differently during the installation of the drivers.

You can check which Windows 95 version you use by entering the DOS
command ver. The Windows 95 OSR 2 (OEM Service Release 2) version
has the version number: Windows 95. [Version 4.00.1111] or [Version
4.00.950b]; the August Windows 95 Release has the version number:
Windows 95. [Version 4.00.950]. For detailed information on how to use
the DOS ver command refer to the appendix in the section “Identifying the
Windows 95 version” (page I).

To install DC50, please refer to the corresponding sections.

� Installing the drivers for Windows 95 (Release August 95) as of page
30.

� Installing the drivers for Windows 98 (OSR2) as of page 31.

Windows 95 (Release August 95)

1. Switch computer on.

Switch your computer on. Windows 95 is started automatically.

If your computer is configured in such a way, that Windows 95  is not
started automatically, please start Windows 95 now.

After Windows 95 starts, the New hardware found dialog box will
appear.

2. Select Driver from disk provided by hardware manufacturer,
click OK.

If this option is not selected, click on the Driver from disk provided by
hardware manufacturer option in the New hardware found dialog box.
Click OK.

3. Insert CD-ROM.

If not already done so, insert the installation CD-ROM into the CD-ROM
drive.

4. Click Browse... .

Click on the Browse... button.

5. Switch to the \SETUP directory, click OK.

Switch to your CD-ROM drive and go into the \SETUP directory. If a
file is shown, click OK.

6. Click OK.

Click the OK button again.

Windows 95
(Release

August 95)
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The drivers are now being installed. After the drivers have been copied,
the installation program starts automatically. Proceed with the “Installing
the software for Windows 95” section as of page 33.

Windows 95 (OSR 2)

1. Switch on computer.

Switch on your computer. Windows 95 is started automatically.

If your computer is configured in such a way, that Windows 95 is  not
started automatically, start Windows 95 now.

After Windows 95 starts, the New hardware component found dialog box
appears followed by the Update Device Driver Wizard dialog.

2. Click Next.

Click on the Next button.

3. Insert the CD-ROM.

If not already done so, insert the installation CD-ROM into the CD-ROM
drive of your computer.

4. Click Other Locations... .

Click on the Other Locations... button.

5. Click Browse... .

Click on the Browse... button.

6. Switch into the \SETUP directory, click OK, OK.

Switch to your CD-ROM drive and go into the \SETUP directory. Click
OK. Click OK again.

7. Click Finish.

Click on the Finish button.

8. Click OK.

You are asked to insert the CD-ROM. Please click OK in this dialog box.

9. Click Browse....

Click on the Browse... button.

10.Switch into the \SETUP directory, click OK, OK.

Switch to your CD-ROM drive and go into the \SETUP directory. Click
OK. Click OK again.

The drivers are being installed. After the drivers have been copied, the
installation program starts automatically. Proceed with the “ Installing the
software for Windows 95 / 98” section as of page 33.

Windows 95
(OSR 2)
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INSTALLING THE DRIVERS FOR WINDOWS 98

1. Switch on computer.

Switch on your computer. Windows 98 is started automatically.

If your computer is configured in such a way, that Windows 98 is not
started automatically, start Windows 98 now.

After Windows 95 starts, the new hardware is found, and the Add New
Hardware Wizzard dialog appears.

2. Click Next.

Click on the Next button.

3. Select Search for the best driver for your device (Recommended), click
Next.

Chose the Select Search for the best driver for your device
(Recommended) option , and click on the Next button.

4. Enter Specify a location, click Browse... .

Activate the checkbox Specify a location, and click on Browse... .

5. Change on the CD-ROM drive and into the :\SETUP directory, click
Next.

Change on the CD-ROM drive and into the \setup directory, and click
the Next button.

6. Click OK.

To finish the installation, click on the OK button.

The drivers are being installed. After the drivers have been copied, the
installation program starts automatically. Proceed with the “ Installing the
software for Windows 95 / 98” section as of page 33.
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INSTALLING THE SOFTWARE FOR WINDOWS 95 / WINDOWS 98

After installing the driver, you can install the remaining DC50 software
(miroINSTANT Video, Adobe Presets etc.) using the installation program.

The installation program

The installation program is started automatically in the language specified
via the Regional Settings (Start Menu, Settings, Control Panel, Regional
Settings) of the installed Windows version.

If you use other regional settings than English, German or French, you will
have to select the language in which the installation should be carried out.

1. If necessary, change the language, click Next.

If necessary, select the language in which the installation should be
carried out.

If you have activated the German, English, or French Regional Settings
and nevertheless want to change the language of the installation program,
click the button Back first and then select the language.

Click on the Next button.

This installation step is not required, if you have activated the German,
English, or French Regional Settings.

2. Select a setup type.

In the Setup Type window, select whether you prefer a typical, a
compact, or a user-defined installation.
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� Typical: Installs all components and uses the default settings.

� Compact: Skips some components (e.g. online manual) and uses the
default settings. You should not choose this option.

� Custom: Lets you select the components and allows to adjust the
settings individually. You should only choose this option, if several
versions of Premiere are installed on your computer, if your system
hard disk is very slow.

3. If necessary, change the hard disk / directory.

If you wish to copy the files to another hard disk / another directory, click
on the Browse... button and define the hard disk / the directory. The
driver software should be installed on the system hard disk and not on the
video hard disk!

4. Click Next.

Click on Next to proceed with the installation.

5. If necessary, select the components.

If you have chosen Custom as setup type, you can directly choose those
components in the dialog box Select Components, which you want to
install. By clicking on Details... you open the window Select Sub-
components. Here you can determine the components even more
precisely.

� System Software
DC50 driver and Microsoft DirectX. The system software must be
installed in order to use the functions of DC50.

� Utilities
Tools, helps and ReadMe file. You should absolutely install and use
them.
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� miroINSTANT Video
Adobe Premiere plugin allows to save valuable computing time when
creating projects. You should absolutely install miroINSTANT
Video, if you want to use Premiere 4.2.
The Details... button lets you choose between two intro movies for
PAL and NTSC. The intro movies (*.avi-sequences) help you switch
on the VCR just in time when recording video. Therefore you should
install the equivalent intro files. For this purpose choose a hard disk
of sufficient speed.

� Extended presets for Adobe Premiere 4.2
Presets for Adobe Premiere which have been developed especially for
the DC50 board and the PAL / SECAM and NTSC standard. If you
want to work with Premiere 4.2, do absolutely install and use these
presets.

� Documentation
The user's guide is also available in PDF format and can be opened
with the Acrobat Reader. If Acrobat Reader 4 has not already been
installed on your computer, use the Documentation option to install it.

After having determined the components, click Next.

This installation step is not required, if you have chosen Typical or Compact
as setup type.

6. Select video standard, click Next.

Select the video standard you use and click on Next.

7. Click Next.

In the Start copying files window, all components you chose are listed. If
you wish to change the settings you chose, click on Back. Click Next to
start copying.

Now the selected components will be installed.

8. Click Finish.

In the Complete Setup window you are asked to restart Windows 95.
Please carry out this prompt and click on Finish to complete the
installation of DC50.
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Hardware Test
After the restart, the DC50 Hardware Test program starts. The hardware test
program is used to test your DC50 hardware and to analyze your computer
system.

Click on the More>> button to expand the dialog window to include the
Extended Settings area. For further information, click on the Help button.

9. Click Test.

To test the hardware, click on Test.

You will be shown the following information:

All the drivers and programs used by the DC50, together with their
version numbers, are listed under this heading.

DirectDraw found
If during the hardware test, a current version of DirectDraw together with
the corresponding graphics board’s driver will be found on your
computer, a green symbol will automatically appear in front of the option
DirectDraw found.

If no current version of DirectDraw is found, a red symbol will appear
instead, and no overlay will be possible.

DDraw primary surface supported
If your computer supports the Primary Surface in the current graphic
mode, a green symbol automatically appears in front of the option
DDraw primary Surface supported.

If, currently, the primary surface is not supported, there will be no
overlay representation with the function primary surface at the moment.

DDraw overlay surface supported
If your computer supports Overlay Surface in the current graphic mode,
the DDraw overlay surface supported check box will be activated
automatically.

Version info

PCI video
overlay with

graphics board
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Here, the results of the hardware test (Test button) are displayed. This
indicates whether all the DC50 components are operating correctly. If a
faulty function is detected, a corresponding message appears. In this case,
insert the DC50 board in a different slot and test it there.

This section displays notes regarding the current hardware of DC50.

If the DC50 is not working properly, install the video board in a different
slot.

miroVIDEO Expert

If you are installing the DC50 for the first time, the hard disk transfer test
program will automatically start once the hardware test has been
successfully completed. miroVIDEO EXPERT  determines your hard disk’s
performance capabilities. If you have linked more than one hard disk to your
system, you should test them all and use the hard disk with the fastest data
rate for video work.

The online help function contains detailed information about all
miroVIDEO EXPERT’s options.

Tests

Notes
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10.Select hard disk, click Start test.

Select the hard disk whose performance you wish to test, then click Start
test. In order to provide you with realistic values, the disk being tested
should be defragmented.

The program indicates that you have installed a DC50 board.
miroVIDEO Expert also works together with other miroVIDEO boards,
this is for example the reason for the audio setting of lower quality.

The main purpose of miroVIDEO Expert is to detect the reachable data
rates of the hard disks - for this purpose you can ignore the settings on
top of the Save button.

The hard disk test first examines the speed with which data can be
written to, or read from, the hard disk. After this, the test determines the
optimum frame format with its corresponding compression factor .

Using the PCI storage link data together with your hard drive’s write
speed, the program calculates the data rate at which an M-JPEG video
sequence with sound can be recorded with no image loss (“dropped
frames”). For more detailed information, refer to the chapter, “Tips &
tricks”, beginning on page 117.

The optimum frame formats and compression factor together with the
attainable data rate are displayed.

Please keep in mind that your hard disk will exhibit a lower data rate on its
inner tracks. When recording, hard disk tracks are written to starting at the
outer edge and working inwards.

11.Enable Audio recording checkbox.

To determine the attainable video data rate in conjunction with audio
data, activate the Audio recording checkbox. Specify the quality with
which you want sound to be recorded.

12.Test additional hard disks.

If necessary, test additional hard disks.

13.Select hard disk for recording, click Store.

Select the hard disk (if more than one is available) that you wish to use
for recording. Click Store to save the settings. The last measured value
will be taken into consideration when later setting the data rate in the
Video Format dialog box.

14.Click Close.

Click Close to return to the configuration dialogue.

15.Click OK.

To complete the installation procedure, click OK to exit the
DC50 Hardware Test dialog.
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Starting the DC50 hardware test at a later time
There are two methods of starting the DC50 hardware test at a later time
(e.g., to select another language version, receive information about the
driver version, or to test the hardware):

1. By using the Start menu and the commands Programs, miroVIDEO
DC50, Tools, and miroVIDEO DC50 Hardware Test.

2. By using the Start menu and the commands Settings, Control Panel,
Multimedia, Advanced (Windows 98: Devices), Video Recording Device,
miroVIDEO DC50, Properties, Settings.
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Installing the
software for Windows NT 4.0

Once you have installed the DC50 into your computer, you can install the
DC50 drivers and software. The installation steps for the Windows 95
(OSR2), Windows 98 and Windows NT are slightly different.

Windows NT
If you use Windows NT, please read the “The Installation program” section
as of page 41.

Windows 98
If you use Windows 98, please proceed with the “Installing the drivers for
Windows 98” section on page 32.

The complete installation consists of the following steps:

� Installing drivers for Windows 98 as of page 32.

� Installing the software for Windows 95 / Windows 98 as of page 33.

Windows 95
If you have Windows 95 installed on your computer, please proceed with
the section “Installing the drivers for Windows 95 as of page 31.

The complete installation consists of the following steps:

� Installing drivers for Windows 95 as of page 31.

� Installing the software for Windows 95 / Windows 98 as of page 33.

Among other things, installing the DC50 software copies the DC50 drivers
to your hard disk. The DC50 program group is created, and the expanded
Adobe Premiere project defaults (Presets) are copied to your hard disk.
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THE INSTALLATION PROGRAM

To install the drivers for Windows NT, proceed as follows:

1. Switch on the computer.

If you have not done so already, switch on the computer.

2. Insert CD-ROM.

If have not done so already, insert the installation CD in your CD-ROM
drive.

Under Windows NT the installation program should start automatically. If
this is not the case, the Autostart function of your CD-ROM drive has
probably been disabled. In this case, you have to start the installation
program manually. To do so, elect the Run... command in the Start menu
and enter [your drive letter] :\SETUP\SETUP.EXE. Click on OK to start
the installation program.

The installation program is started automatically in the language specified
via the Regional Settings (Start Menu, Settings, Control Panel, Regional
Settings) of the installed Windows version.

If you use other regional settings than English, German or French, you will
have to select the language in which the installation should be carried out.

3. If necessary, change the language, click Next.

If necessary, select the language in which the installation should be
carried out.

If you have activated the German, English, or French Regional Settings
and nevertheless want to change the language of the installation program,
click the button Back first and then select the language.

Click on the Next button.

This installation step is not required, if you have activated the German,
English, or French Regional Settings.

4. Select a setup type.

In the Setup Type window, select whether you prefer a typical, a
compact, or a user-defined installation.
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� Typical: Installs all components and uses the default settings.

� Compact: Skips some components (e.g. online manual) and uses the
default settings. You should not choose this option.

� Custom: Lets you select the components and allows to adjust the
settings individually. You should only choose this option, if several
versions of Premiere are installed on your computer, if your system
hard disk is very slow.

5. If necessary, change the hard disk / directory.

If you wish to copy the files to another hard disk / another directory, click
on the Browse... button and define the hard disk / the directory. The
driver software should be installed on the system hard disk and not on the
video hard disk!

6. Click Next.

Click on Next to proceed with the installation.

7. If necessary, select the components.

If you have chosen Custom as setup type, you can directly choose those
components in the dialog box Select Components, which you want to
install. By clicking on Details... you open the window Select Sub-
components. Here you can determine the components even more
precisely.
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� System Software
DC50 drivers. The system software must be installed in order to use
the functions of DC50.

� Utilities
The capture application miroVIDEO Capture, tools, helps and
ReadMe file. You should absolutely install and use them.

� miroINSTANT Video
Adobe Premiere plugin allows to save valuable computing time when
creating projects. You should absolutely install miroINSTANT
Video, if you want to use Premiere 4.2.
The Details... button lets you choose between two intro movies for
PAL and NTSC. The intro movies (*.avi-sequences) help you switch
on the VCR just in time when recording video. Therefore you should
install the equivalent intro files. For this purpose choose a hard disk
of sufficient speed.

� Extended presets for Adobe Premiere 4.2
Presets for Adobe Premiere which have been developed especially
for the DC50 board and the PAL / SECAM and NTSC standard. If
you want to work with Premiere 4.2, do absolutely install and use
these presets.

� Documentation
The user's guide is also available in PDF format and can be opened
with the Acrobat Reader. If Acrobat Reader 4 has not already been
installed on your computer, use the Documentation option to install it.

After having determined the components, click Next.

 

This installation step is not required, if you have chosen Typical or Compact
as setup type.
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8. Select video standard, click Next.

Select the video standard you use and click on Next.

9. Click Next.

In the Start copying files window, all components you chose are listed. If
you wish to change the settings you chose, click on Back. Click Next to
start copying.

Now the selected components will be installed.

10.If necessary, install Acrobat Reader.

If the current settings include the online manual and on your computer
the Acrobat Reader is not installed, you are asked, if you want to install
the Acrobat Reader. If necessary, click on Yes, to install the Acrobat
Reader.

11.Click Finish.

In the Complete Setup window you are asked to restart Windows NT.
Please carry out this prompt and click on Finish to complete the
installation of DC50.
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Using the DC50
under Windows 95 / 98

This chapter provides an introduction into working with the DC50. You can
find additional information about working with the DC50 in the “Tips &
tricks” section (page 117).

Important: If you use Windows NT, you should skip this chapter and see
“Using the board under Windows NT” on page 56.

Recording quality

You can adjust the recording quality to your hard disk’s speed by changing
the data rate or the compression factor.
If the hard disk is too slow to write all the images, some will not be stored
(“dropped”), and the video playback will look jerky and stuttering. Solution:
Select a lower data rate.

Overlay

If your system contains a graphics board that supports DirectDraw, the
DC50 board can add a real-time overlay. Check whether displaying an
overlay while simultaneously recording weakens the recording. This may be
due to a lower transfer rate on the part of the graphics board. In this case,
either reduce the overlay resolution or simply turn off the overlay function
while recording.

You should always use your television to control the video colors. Because
of gamma values, phosphors, etc., that differ from those of a TV, the
computer may not show the correct colors.



46  miroVIDEO DC50

DIGITIZING VIDEO CLIPS

In order to digitize video clips, it is necessary to connect the breakout box to
the DC50 and to connect a player to the breakout box. The player must be
switched on, so that it provides a video signal.

First you need to set the preferences necessary for the digitalization. This
manual describes the necessary steps for digitizing video clips under Adobe
Premiere. The settings you need to determine in the miroVIDEO DC50
Video Input and miroVIDEO DC50 Video Format dialog boxes, must also
be determined when using other capture programs as e.g. VidCap 32.

Please carry out the following steps in order to digitize videos under
Premiere:

1. Start Adobe Premiere.

Start Adobe Premiere from the Start menu with the commands Programs,
Adobe, and Adobe Premiere.

2. Choose the project preset.

In the window New Project Settings, choose an appropriate miro DC50
project preset. We recommend miroDC50 ITU.R 601.

3. Choose File, Capture, Movie Capture.

Choose the commands Capture and Movie Capture from the File menu.
In the menu the additional menu item Movie Capture will be displayed.

4. Choose Movie Capture and VfW Settings... .

Choose the command VfW Settings... from the Movie Capture menu.

5. Select Video Input.

Click on the Video Input button.

The miroVIDEO DC50 Video input dialog box appears. Please make the
necessary settings.
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Video Input

The dialog box miroVIDEO DC50 Video input allows you to
determine all the settings concerning your video source. Please refer to
the on-line help for further information about all options of the dialog
box.

Connector
Here, you choose the connector of the breakout box to which your video
source is connected to. Composite, S-Video (Y/C) or Component (Y, R-Y,
B-Y). Several sources can be connected at the same time, but only the
selected signal will be digitized. Refer to the chapter “Connecting
breakout box and video devices” in the miroVIDEO DC50 user's manual.

Video
Here, you determine the video standard of the connected video source:

� PAL

� NTSC

� SECAM

DC50 does not convert between standards, i.e. if you digitize PAL video,
you need to choose a PAL-Premiere preset and the result will be output in
PAL format by DC50.

Video loopthrough
If you activate the Video loopthrough check box, the input video signal
will be directly transmitted to the output connectors of the breakout box
and will be output on a connected control monitor. Deactivate the check
box in order to view a test picture on the monitor.

If your player is at the same time the recording device, i.e. it is connected to
the video input as well as to the video output of the breakout box, you need
to deactivate the Video loopthrough check box in order to avoid video
feedback.
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Activate reference output
The Activate reference output is activated by default. If your BetaCam
deck is reference clock source and recording device at the same time, you
need to deactivate the check box.

Video settings
Allows you to modify the Brightness, the Contrast, the Saturation and
the Sharpness. Under NTSC you can additionally change the NTSC Hue.

This will have an impact on the video signal during digitalization. If you
want to edit the unchanged video material, you need to set the sliders on
the default settings.

Extended
The extended settings for the video inputs are only used for special
applications circumstances. The usage requires a certain knowledge in
the field of video technology. If you are not sure about these settings,
please do not change them, as, otherwise, problems might occur during
video digitalization!

6. Click OK.

Click OK, in order to close the miroVIDEO DC50 Video Input dialog box
and to take over the determined settings. The settings will be saved.

If you connect another video source to the breakout box of DC50, you
might need to open the miroVIDEO DC50 Video Input dialog box again,
in order to make the corresponding settings.

Once the dialog box is closed, an image should be seen in the video
window, if a connected player is switched on and overlay is activated. If
this is not the case, please refer to the chapter “Troubleshooting” starting
on page Fehler! Textmarke nicht definiert..

7. Choose Movie Capture and VfW Settings... .

Choose the command VfW Settings... from the Movie Capture menu.

8. Select Video Format.

Click on the Video Format button.

The miroVIDEO DC50 Video Format dialog box will be opened. Please
make the necessary settings.
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Video Format

The miroVIDEO DC50 Video Format dialog box allows you to set the
resolution and the quality for video digitalization. For further information
about all options of the dialog box, please refer to the more detailed on-
line help.

Capture resolution
Here, you need to determine the image capture resolution. For NTSC
capturing you may select between the following:

� [720x486]: ITU-R.601

� [672x464]: TV-cropping

� [352x240]: Quarter size.

For PAL capturing, the resolutions are accordingly 720 x 576, 672 x 560,
and 352 x 288.

[720x486]: ITU-R.601 corresponds to the standardized sampling format.
This format produces an overscan effect, i.e. black stripes or other
interferences on the edges of the digitized video. This is no error
produced by DC50. It is rather due to the fact that according to the ITU-
R.601 standard, as a precaution, some more pixels are digitized than are
in fact available in form of image data in the analog signal.

[672x464]: TV-cropping digitizes a slightly smaller image section. This
does not produce a visible difference, as the missing edges usually do not
contain a useable image and are always beyond the edges of the TV tube.
The advantage is that the digitized video clips now contain faultless
image material up to the edges. This allows to use video effects such as
push-transitions or picture-in-picture, without making faults or black
edges visible. Therefore we recommend to select [672x464]: TV-
cropping for on-line video editing with DC50.
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Please use [352x240]:Quarter size, if you do not want to produce video
tapes, but MPEG-1 encoded video on CDs or something similar. This
resolution is also useful in order to save hard disk space during off-line
editing.

Quality settings
Here, you determine the amount of data of the compressed video and thus
the quality. The entries for compression, data rate, frame size, and
capture time depend on each other.

Compression
The slider Compression helps you to determine the compression factor.
This factor reduces the amount of data of the digitized video sequence
compared to the uncompressed data during capturing. A low compression
factor stands for high quality, a high compression factor stands for lower
quality. If you change the position of the compression slider, you
automatically change the position of the data rate slider as well. The
minimal compression at a capture resolution of [672 x 464]: TV-cropping
is 2.5:1.

For Betacam material usually a compression factor of 4:1 to 5:1 can be
chosen without producing visible quality losses. A further reduction of
the compression factor, meaning at the same time increasing the data rate,
would mean wasting hard disk space. Therefore experimenting with
different compression factors is more effective than generally choosing
the smallest value.

Data rate
The data rate slider allows you to determine the data rate for capturing
the video sequence. Changing the position of the Data rate slider,
changes automatically the position of the Compression slider. The set
data rate will be displayed.

High data rate means high quality. If a certain, material dependent data
rate is reached, the maximum quality is reached as well (no visible
difference compared to the input signal), a further increasing of the
quality is impossible.

If the determined data rate is getting too high for your computer system, a
warning message will appear. For that, it is necessary to previously
measure the performance of the hard disk with miroVIDEO Expert.

9. Click OK.

 Click on the OK button in order to close the miroVIDEO DC50 Video
Format dialog box and to accept the determined settings.

10.Determine the drive for the temporary outsourcing file, click OK.

Choose the commands Preferences and Scratch Disk... from the File
menu. Select that drive for the temporary outsourcing file, which has
been detected by miroVIDEO EXPERT as being the fastest one. Click on
OK.

 Now you have made all settings, which are necessary before digitizing
the first video clip.
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11.Click on Record.

 Cue your player to that position, from which you want to begin
recording, and click on the Record button in the Movie Capture window,
in order to start recording.

 Click on the capture window or use the <Esc> button, in order to stop
recording.

 Record some clips of about 30 seconds length, in order to edit them later
on in Adobe Premiere.

VIEWING VIDEO CLIPS

After having recorded some clips, you can view them in Adobe Premiere or
in the media player.

In the Clip window under Adobe Premiere, you can playback single clips,
by clicking on the Play button.

If you are working in the construction window, and you have edited several
clips, you can view them via the File menu, the Export command and
miroINSTANT Video.

If you want to playback a clip via the media player, please choose the option
miroAVI Cache from the menu Devices, in order to produce a jerkyless
playback. The program miroAVI Cache is optimized for jerkylessly playing
back video clips.

EDITING VIDEO CLIPS

If you want to edit recorded clips with Adobe Premiere, you should consider
the following information:

� When creating a project (compositing several video clips), you
absolutely need to choose the same project preset as for video recording.

� The DC50 project presets determine a data rate for effect rendering, at
maximum video resolution 4MB/s. This rate is also used for video
capture
If you are using another rate for video capture, you should adapt the data
rate for effect rendering correspondingly (menu Make, command
Compression). Please check, if the hard disk, on which the .ppj project
file has been saved to, is fast enough.

� The settings, determined by the DC50 project presets, should not be
changed (video standard, resolution, codec).

For further details on how to work with Adobe Premiere, please refer to the
Adobe Premiere user's manual.

Adobe Premiere

Media player
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After mounting...

To use the features of miroINSTANT Video 5 you need Adobe
Premiere 5.1!

After having mounted the video clip, proceed as follows:

1. Save the project.

Save the project via the File menu and the Save command. Enter the
drive, the directory, and the file name, then click OK.

2. Press <Enter>.

In the activated timeline window press the <Enter> key to start the video
playback.

For further information on miroINSTANT Video, please refer to the
chapter „miroINSTANT Video“ starting on page 72.

SOUND SETTINGS

Use the Microsoft Mixer application to define the settings for sound
playback and recording.

Audio playback

This application is identified by a speaker icon on the task bar. Simply
double-click the icon to start Playback Control. The application starts in the
Playback Control mode. In this mode, you can make the settings required
for audio playback.
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Playback

The sliders in the Playback column allow you to control the audio playback
of all devices, connected to the DC50 board, via the breakout box in a range
from -82.5 dB to +12 dB. The Playback slider serves as master controller
for the level adjustment of both inputs. Balance control is not possible in
this case. This is done via the balance control of the inputs. The audio
outputs Line Out and Balanced Out can be controlled simultaneously.

Line Out

The Line Out-slider allows you to control the audio output of the device
connected to the line output of the breakout box.

Balanced Out

The Balanced Out-slider allows you to control the audio output of the
device connected to the Balanced Output of the breakout box.

Internal In

Lets you adjust the input level and the balance for the device you connected
to the internal DC50  audio input (i.e., the audio cable of a CD-ROM drive
or a sound board).

Line In

The Line In-slider allows you to control the input levels and the balance of
the device (e.g. a VCR) connected to the line input of the breakout box in a
range from -6 dB to +15 dB.

Balanced In

The Balanced In-slider allows you to control the input levels in a range of -6
dB to +16,5 dB and the balance of the device (e.g. a VCR) connected to the
balanced input of the breakout box.

Wave

Use the Wave controller to control the level in a range from 0dB to -33 dB
and the balance of audio output from Wave and AVI files.

Mute

The Mute control box turns the volume of the corresponding audio source
(internal, external, wave) off. The Mute settings of the internal and the
external input depend on each other: If you switch one input on, the other
input is automatically muted (Mute). The control of the Wave is not affected
by these settings.

Mute all

The Mute all control box mutes all inputs.
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Advanced (Playback)
The Advanced buttons let you make further settings. If these buttons are not
visible, select Advanced Controls from the Options menu.

� Set Default Values
The Set Default Values option sets all sliders to default settings. The
default settings are the ones that were enabled after you first installed the
DC50 software.

� Audio Loopthrough
If you activate the checkbox Audio loopthrough, the audio signal that is
present at the audio input of the DC50 will also be looped through to the
audio output of the DC50.

Advanced (Balance)

The Advanced buttons let you make further settings. If these buttons are not
visible, select Advanced Controls from the Options menu.

� Mic. Boost On
The Mic. Boost On button lets you enable an additional amplification of
20 dB for the external input, if you want to connect a microphone.

Sound recording

The settings for recording audio are made in the Recording Control mode.
To start the Recording Control application, select the Options menu from
the Playback Control window, then select the Properties and Record
commands.

You can only select one device at any one time for recording.



Usingt the DC50 under Windows 95 / 98  55

Record Control

The Record Control is the master control for adjusting the levels of both
inputs. Controlling the balance is not possible. To adjust the balance, use the
balance sliders of these inputs. The level sliders have an adjustment range
from -6 dB to 16.5 dB. Normally, the slider should be set to the lowest
setting, it can however be used in order to amplify quiet sounds.

Internal

Lets you adjust the input level and the balance for the device you connected
to the internal DC50 audio input (e.g., the audio cable of a CD-ROM drive
or a sound board).

External

Lets you adjust the input level and the balance of the device (e.g. VCR),
connected to the Line input of the breakout box, via the DC50 board.

Balanced Input

The Balanced Input-slider allows you to control the input level and the
balance of the device (e.g. VCR), connected to the balanced input of the
breakout box, via the DC50.

Mute

The Mute control box turns off the volume of the corresponding audio
sources (line, balanced, internal).

Mute all

The Mute all control box mutes all inputs.

Advanced (Record)

The Advanced buttons let you make further settings. If these buttons are not
visible, select Advanced Controls from the Options menu.

� Set Default Values
The Set Default Values option sets all sliders to default settings. The
default settings are the ones that were enabled after you first installed the
DC50 software.

Advanced (External)

The Advanced buttons let you make further settings. If these buttons are not
visible, select Advanced Controls from the Options menu.

� Mic. Boost On
The Mic. Boost On button lets you enable an additional amplification of
20 dB for the external input, if you want to connect a microphone.
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Using the DC50
under Windows NT

Important: If you use Windows 95 or 98, you should skip this chapter and
see “Using the board under Windows 95/98” on page 45.

miroVIDEO DC50 CONTROL

miroVIDEO DC50 Control allows you to make all settings for the video in-
and output.

In addition to the general settings, miroVIDEO DC50 Control contains
advanced settings for the analog in-and outputs of the breakout box. These,
however, are not necessary for the normal usage of miroVIDEO DC50
Control. Please do not change them, unless this is necessary for special
applications, or if you really know how to use these settings!

To start the miroVIDEO DC50 Control select Programs, miroVIDEO
DC50, Tools and miroVIDEO DC50 Control from the Start menu.

The user surface is divided into several pages (tabs), out of which always
one is visible and active. You can change between the tabs by clicking on
the upper edge of a tab.
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General

On the tab General you make the settings for the video overlay (displaying
the video in the window of the PC monitor), the volume of the audio output,
and the video cabling (genlock, video loopthrough.

Stand. In.

On the tab Stand. In. (advanced settings for the Composite and S-Video
inputs) you select the type of the video source (tape device/camcorder or
others). In addition to that, as a control function, the tab displays, if a video
signal is present at the chosen input, and if it contains color. The other
settings are only useful for special applications. Please do not change these
settings, if you are not sure about the technical background!

Stand. Out.

The tab Stand. Out. (advanced settings for the Composite and S-Video
outputs) allows you to determine, if the output signals for the Composite or
the S-Video output of the breakout box are to be optimized (video
bandwidth). The other settings are only useful for special applications.
Please do not change these settings, if you are not sure about the technical
background.

Comp. In

On the tab Comp. In. (advanced settings for the component input) you select
the type of the connected component signal player (standard). In case of a
separate sync signal, you choose the connector (sync source) used for this
signal. In addition to that, as a control function, the tab displays, if a video
signal is present at the component input. The other settings are only useful
for special applications. Please do not change these settings, if you are not
sure about the technical background!

Comp. Out.

On the tab Comp. Out. (advanced settings for the component output) you
determine settings, which change the component output into an RGB output,
or the use of further S-Video and Composite outputs. These settings are only
useful for special applications. Do not change these settings, if you are not
sure about the technical background!

The Help button gives detailed information about each page and each
element on it.
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DIGITIZING VIDEO CLIPS

The DC50 also lets you capture movies with the miroVIDEO Capture
application in the Windows NT environment. In this regard, please refer to
the next chapter, “miroVIDEO capture”, which begins on page 67 of this
manual.

With the DC50 you get a capture plugin that works with Premiere and
Windows NT.

Please carry out the following steps in order to digitize videos under
Premiere:

1. Start Adobe Premiere.

Start Adobe Premiere from the Start menu with the commands Programs,
Adobe, and Adobe Premiere.

2. Choose the project preset.

In the window New Project Settings, choose an appropriate miro DC50
project preset. We recommend miroDC50 ITU.R 601.

3. Choose Capture Settings.

After loading one of the appropriate settings, select Capture Settings... .
This is required to make Adobe Premiere initialize the capture module.

4. Click Settings... .
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By clicking on the Settings... button you can open the DC50 Settings
dialog box. Here you can set several parameters for the video and audio
inputs. The box consists of three tab pages:

� Format

� Settings

� Input.

Format

The Format tab allows you to choose the capture format. It is recommended
to not change these settings. They are automatically established according to
the setting you have selected. If you do make changes here, the capture
format would be different from the Premiere Rendering and Output format
so that you might not be able to use miroINSTANT Video.

If you want to create a new project with other capture format settings you
should load the appropriate Preset. This is the only way to keep capture
format and Premiere playback format the same.
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Video standard

Allows you to determine the video standard of the signal, supplied by your
player: NTSC, PAL, SECAM, or NTSC 4.43 (NTSC video signal, PAL
color carrier).

Depending on the installed Windows version, one video standard has been
preset.

The DC50 is not capable of transforming standards, meaning footage
recorded with a PAL source can only be played back as PAL video.

Frame resolution

Allows you to determine the image resolution for capturing:

ITU-R.601 corresponds with the standardized format (720 x 486 [NTSC] /
720 x 576 [PAL/SECAM]). This selection creates on overscan effect, which
means black stripes or other interferences occur on the edges of the digitized
video. This is no error produced by DC50, but is due to the fact that
according to the ITU-R.601 standard it is necessary to digitize, as a
precaution, more pixels than in fact are present in form of image data in the
analog signal.

TV cropping (672 x 464 [NTSC] / 672 x 560 [PAL/SECAM]) digitizes a
slightly smaller image section. This will not cause visible restrictions, as the
suppressed edge does usually not contain a usable image and is always
located beyond the edges of the TV tube. The advantage is, that the digitized
video clips now contain trouble-free image data up to the edges. Thus, you
can use video effects, such as push-transitions or picture-in-picture, without
making disturbances or black stripes become visible. Therefore, we
recommend the selection [672x464]: TV cropping for on-line video editing
with DC50.

Please use Quarter size (352 x 240 [NTSC] / 352 x 288 [PAL/SECAM]), if
you do not want to record video tapes, but MPEG-1 encoded video on CDs
or similar material. This resolution is also useful, in order to save hard disk
space during off-line editing. Due to the low resolution, editing under
Adobe Premiere is faster, but the result has only VHS quality.

Audio

If the check box Capture audio is activated, sound is recorded in CD quality
simultaneously while the video is captured. This is normally the case.

•  If necessary, enable the check box.

Sample rate

•  Determine the audio sampling rate: You may choose between 44.1 kHz
and 48 kHz.

Sample format

As Sample format, 16 bits stereo are used, which corresponds to audio CD
quality.

ITU-R.601

TV cropping

Quarter size.
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Settings

The Settings tab allows you to choose the Image settings, control the Audio
level and to adjust video compression/data rate. For details please refer to
the online help by clicking the Help button.

Image settings
Here you can select the Brightness, the Contrast, the Saturation, the
Sharpness and the Hue (the latter for NTSC only). Thus the video is
changed while recording in real-time. Please do not change the position of
the sliders unless, you want to make specific changes in complete video
clips. Further image changing / alienation effects can be made under Adobe
Premiere.

If you want to digitize the unchanged video footage, please do not change
the standard position of the sliders.

Use this slider, to adjust the brightness.

Use this slider, to adjust the contrast.

Use this slider, to adjust the saturation.

Use this slider, to adjust the sharpness.

Use this slider, to adjust the hue*.

                                                          
* Ror NTSC only.
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Audio level

On the left side you find the two sliders for the level adjustment of the two
audio channels with dB scale, and on the right side the level adjustment
display for supervision.

If your audio source supplies a signal with standardized level, the slider
position 0 dB will be appropriate, i.e. in this position—depending on the
current volume of the sound—there will be motion on the level adjustment
display. The red section will not be reached and the red exclamation mark
will not be displayed either.

If this is the case, please do not change the position of the slider.

If the level adjustment display often shows the red section, or if even a red
exclamation mark appears, you need to position the slider a little lower. An
overload distorts the recorded audio signal.

If the level adjustment display does not show any motion at all, or only
weak motion even during loud audio sections, you need to push the slider a
little higher. Is the audio adjustment too low, the sound will be low too and
noises might occur.

Linked together
Usually, the Linked together check box is activated, i.e. the adjustment of
the audio channels' level is the same. If you want to adjust the audio level of
the two audio channels independently from each other, deactivate this check
box.

+ 20 dB input gain
If the + 20 dB input gain check box is activated, the audio input signal will
be amplified by 20 dB. Accordingly, the scale of the level adjustment sliders
will change. This option should only be used, if a microphone with a low
output level is connected to the Line audio outputs of the breakout box.

If you have chosen the Balanced option under Input selection, the + 20 dB
input gain will not be available. If this option has been activated
accidentally, the input signal will be enormously overloaded and can not be
adjusted properly with the level adjustment sliders. Please deactivate the +
20 dB input gain in this case.

Default

The Default button resets all values to the default setting.

Data rate

The Data rate slider allows you to determine the date rate, with which the
video sequence is to be recorded. If you change the position of the data rate
slider, the compression factor will change automatically.
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A high data rate signifies high quality. If a certain, material dependent data
rate is reached, the maximum quality (no visible difference compared to the
input signal) is reached as well, further increase of the quality is not
possible.

•  Specify the data rate.

If the set data rate exceeds the performance of your computer, the maximum
data rate will appear in red letters.

It displays the data rate (KB) and the compression factor.

Drive info

Displays all the connected drivers, on which video clips can be recorded,
with the necessary additional information:

Name
The name of the drive, i.e. of the hard disk, the partition, the removable disk
or something similar.

Max. drive rate
If the measurement has already been completed (Testing... button), the
maximum data rate<+> of the drive is displayed.

Max. recording time
If the measurement has already been completed (Testing.. button), the total
duration<+> of video clips, which can still be saved on the drive at the
currently chosen data rate is displayed.

Testing

The Testing button allows you to test your hard disk with regard to the
maximum data rate and the maximum capture time. The detected values will
be saved automatically.

Please make sure to detect the hard disk which you selected within Adobe
Premiere as your capture hard disk via the File menu and the Preferences
and Scratch Disk... commands. For further information see the Adobe
Premiere user's guide.
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Input

The Input selection tab allows you to select the Audio and Video inputs.

Audio

Allows you to determine, if you want to use the Line or the Balanced input
of the breakout box for audio capturing. If you choose the option Balanced,
the option + 20 dB input gain is not available under Audio level adjustment.

The chosen input connectors are marked in the figure of the breakout box
below the options.

Audio data will only be recorded, if Capture audio has been activated on the
Format tab.

Video

Allows you to determine which video input of the breakout box you want to
use for video capturing: S-Video, Composite, or Component.

The chosen input connector (for Component connectors) will be marked in
the figure of the breakout box below the options.

If you use the Component input, and the synchronous video signal is not
transmitted as a part of the Y-signal, as usual, you need to enter the used
connector in the miroVIDEO DC50-Control via the Comp. In. tab.
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5. Click OK.

 Click on the OK button in order to accept the determined settings.

6. Determine the drive for the temporary outsourcing file, click OK.

Choose the commands Preferences and Scratch Disk... from the File
menu. Select that fastest drive for the temporary outsourcing file. Click
on OK.

 Now you have made all settings, which are necessary before digitizing
the first video clip.

7. Click on Record.

 Cue your player to that position, from which you want to begin
recording, and click on the Record button in the Movie Capture window,
in order to start recording.

 Click on the capture window or use the <Esc> button, in order to stop
recording.

 Record some clips of about 30 seconds length, in order to edit them later
on in Adobe Premiere.

VIEWING VIDEO CLIPS

After having recorded some clips, you can view them in Adobe Premiere or
in the media player.

In the Clip window under Adobe Premiere, you can playback single clips,
by clicking on the Play button.

If you are working in the construction window, and you have edited several
clips, you can view them via the File menu, the Export command and
miroINSTANT Video.

If you want to playback a clip via the media player, please choose the option
miroAVI Cache from the menu Devices, in order to produce a jerkyless
playback. The program miroAVI Cache is optimized for jerkylessly playing
back video clips.

Adobe Premiere

Media player
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EDITING VIDEO CLIPS

If you want to edit recorded clips with Adobe Premiere, you should consider
the following information:

� When creating a project (compositing several video clips), you
absolutely need to choose the same project preset as for video recording.

� The DC50 project presets determine a data rate for effect rendering, at
maximum video resolution 4MB/s. This rate is also used for video
capture
If you are using another rate for video capture, you should adapt the data
rate for effect rendering correspondingly (menu Make, command
Compression). Please check, if the hard disk, on which the .ppj project
file has been saved to, is fast enough.

� The settings, determined by the DC50 project presets, should not be
changed (video standard, resolution, codec).

For further details on how to work with Adobe Premiere, please refer to the
Adobe Premiere user's manual.

After mounting...

To use the features of miroINSTANT Video 5 you need Adobe
Premiere 5.1!

After having mounted the video clip, proceed as follows:

1. Save the project.

Save the project via the File menu and the Save command. Enter the
drive, the directory, and the file name, then click OK.

2. Press <Enter>.

In the activated timeline window press the <Enter> key to start the video
playback.

For further information on miroINSTANT Video, please refer to the
chapter „miroINSTANT Video“ starting on page 72.
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miroVIDEO Capture

miroVIDEO Capture is designed to benefit both inexperienced users and
video editing professionals. miroVIDEO Capture may only be used under
Windows NT 4.0. Using a project-oriented approach, the values for video
and audio quality, frame rate and size can be set just once and will be
applied to all captured clips of this project. Switching to another project is
possible at all times and miroVIDEO Capture will organize the clips into
separate folders for you.

STARTING miroVIDEO CAPTURE

You can start miroVIDEO Capture, by selecting the commands Programs,
miroVIDEO DC50, and miroVIDEO Capture from the Start menu.

The user surface is divided into several pages (tabs), from which always one
is visible and active. Switching between the tabs is possible by clicking on
the upper edges of the tabs.

� On the Projects tab projects can be generated and managed, and the
video and audio format can be chosen.

� On the Settings tab the settings for the connected video and audio
sources, the audio level adjustment included, can be determined.

� On the Record tab video clips can be recorded.

� On the Clips tab the recorded clips can be played back.

Right mouse button

Some tab areas provide context-sensitive menus: click the right mouse
button to access additional functions.
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PROJECTS

A project contains video sequences (clips) of the same image resolution and
audio sampling rate. This is important for working with miroINSTANT
Video later on. For the files of a project one or (if the project covers several
hard disks / partitions) several common folders exist. Project data is saved
under a filename with the .ppf  extension, the individual video clips are
saved with the .avi extension.

All settings you select in the Projects tab are saved automatically and cannot
be changed after you have captured the first clip. The settings apply to all
clips of this project.

After you have captured a video clip, you cannot change the settings
anymore. You have two possibilities to select new settings:

� Delete the project and create a new project with the desired settings.

� Delete all files in the Clips tab and make the desired settings.

•  Determine the Settings.

Determine the settings of Video Standard, Image Format, Audio.

The Help button gives detailed information about every page and each
element on it.

Changing the
settings
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SETTINGS

Via the Settings tab, you choose the input connectors of the breakout box, to
which the image and sound sources, supplying the material to be digitized,
are connected to. You can also determine on which hard disk / partition
further, digitized video clips are to be saved.

In addition to that you may decide on the image and sound quality of the
digitized video, by setting the data rate and adjusting the audio as well as by
changing the luminance, the contrast, etc.

On the Settings tab you can preview the video, i.e. you can see
immediately—with certain restrictions—the effects your settings have on
the capture of the video sequence. Below the video window you find the
status window, which displays different kinds of information.

In order to check the set quality without limitations, please use the Test
capture function.

•  Determine the Settings.

Determine the Image settings, the Audio level adjustment, the Input
selection, and the Data rate.

The Help button gives detailed information about each page and element on
it.
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RECORD

The Record tab lets you record and playback video clips.

The current settings are displayed in the top right corner.

When playing back a video sequence, you can copy a current frame into the
Windows Clipboard by clicking the left mouse button in the overlay
window. The mouse pointer will temporarily appear in form of a camera,
and the frame will be copied.

•  Record video sequences.

Record several video sequences with a duration of about half a minute.

The Help button gives detailed information about every page and each
element on it.
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Clips

The Clips tab allows you to playback, to rename, or to delete all digitized
video sequences of a project.

•  Playback Video Sequences, if necessary.

If you want to view the recorded video sequences, play them back via the
Clips tab.

The Help button gives detailed information about every page and each
element on it.
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miroINSTANT Video

This chapter only refers to miroINSTANT Video 5 under Adobe Premiere
5.1.! How to use miroINSTANT Video 2.0 with Adobe Premiere 4.2LE is
described in previous versions of this manual.

WHAT IS miroINSTANT VIDEO 5?
miroINSTANT Video 5 is a playback module for Adobe Premiere 5.1 that
works with miroVIDEO editing boards. It requires Premiere 5.1 compatible
software drivers for the editing board as well.

WHAT IS IT GOOD FOR?
When editing video tapes using Premiere 5.1, the use of miroINSTANT
Video 5 gives you three major advantages:

� The duration of the rendering process, that happens after you have done
the editing and before you can watch your production or print it to tape,
is being reduced a lot. This increases productivity.

� The amount of hard disk space required to do a production is being
reduced as well. In case of a simple cuts-only project miroINSTANT
Video 5 saves 50% hard drive space. This saves money.

� The maximum duration of your productions is being increased. Without
miroINSTANT Video 5, the whole production must fit into a single AVI
file, which is limited to a maximum size of 2GB.
This results in a maximum project duration of less than 7 minutes when
working at a data rate of 5 MB/s, for example.
Using miroINSTANT Video 5, the maximum project duration is 3
hours. This makes long format work on a PC possible.
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SYSTEM REQUIREMENTS

 To make use of miroINSTANT Video 5 you need a PC system that fulfills
both the system requirements for running Adobe Premiere 5.1 (see Adobe
documentation) and the requirements for running your DC50 board.

 You also need a graphics board that is capable of showing video overlay in
combination with your miroVIDEO editing board.

 HOW TO MAKE IT WORK?
In order to use miroINSTANT Video 5, you must have installed three things
in your PC:

� A DC50.

� Adobe Premiere 5.1.

� Driver software for the editing board that supports and includes
INSTANT Video 5.

Once the installation is done, it is simple to use miroINSTANT Video 5:

Start Premiere 5.1, click the load button in the settings dialog box and select
one of the miroVIDEO presets.

Important: If you do not use one of the presets supplied for your
miroVIDEO DC30 , or change the Adobe Premiere settings manually, then
miroINSTANT Video 5 may not work properly!

To work, miroINSTANT Video 5 must be selected as Editing Mode in the
Project/Settings/General Dialog, this is being done automatically by using
the miroVIDEO preset.

•  Now open a new Premiere project, and the miroINSTANT Video 5
window will appear. From now on miroINSTANT Video 5 will be
active and will handle the smooth video playback using the miroVIDEO
editing board.

Note that Premiere 5.1 projects must fulfill some conditions to be
compatible with miroINSTANT Video 5 and the miroVIDEO editing
boards. See the “Limitations” section later in this chapter. With
miroINSTANT Video 5, some things in Premiere work not exactly as
described in the Premiere manual. So please make sure to read all the
miroINSTANT Video 5 documentation.
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 HOW DOES IT WORK?
Whenever you play video clips or parts of the timeline in the Premiere 5.1
monitor window, miroINSTANT Video 5 does two things:

� It plays back the video using the miroVIDEO editing board, so that it
can be watched on a TV in addition to the usual display on your
computer screen

� It makes sure that all source clips and rendered effects play back
smoothly, without interruptions between the single AVI files. This way,
the playback from the timeline can directly be recorded to tape.
Without miroINSTANT Video 5, there would be stuttering and dropped
frames during the timeline playback, so you would have to render the
whole project before you’re able to print it to tape.

miroINSTANT VIDEO 5 WINDOW

When miroINSTANT Video 5 is installed, is selected as Editing Mode and
is active (see above), the miroINSTANT Video 5 window is visible. It is
displayed in front of other Premiere 5.1 windows, but may be hidden by
Premiere’s floating tool palettes—in this case move the palettes to see and
access the INSTANT Video 5 window.

The window indicates by it’s existence that miroINSTANT Video 5 is
active.

Speaker symbol
Whenever miroINSTANT Video 5 is playing back video, it will show a little
speaker icon in the INSTANT Video 5 window to indicate the current play
mode.

There are two possible audio modes:

� INSTANT audio output, indicated by a speaker
In this mode, the audio is being handled by INSTANT Video 5 and is
being output through your Pinnacle video board.
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� Premiere audio output, indicated by a crossed out speaker
In this mode, the audio is being played through your standard Windows
sound device. This means that there is probably no audio output to tape.

When you record your project to tape, the speaker symbol should not be
crossed out.

How to get rid of the crossed out speaker, and what determines the audio
play mode, is described in the section “Modes of Operation / Audio Output”
(see page 78) of this file.

 Film strip
Below the Pinnacle Systems logo there is a horizontal film strip. This acts as
an indicator for the INSTANT Video 5-playability of the whole project.

If all images in the strip are black, then the whole project from the
beginning to the end of the timeline can currently be played by
miroINSTANT Video 5.

If some of the images in the film strip are red, then some parts of the
timeline can currently not be played by miroINSTANT Video 5. This
indicates that either

� some video effects placed in the project have not yet been rendered,

� some clips have a format that does not match with the project settings,
and have not yet been converted to the correct format, or

� there are gaps in the timeline without any clips.

If you scrub or play, these non-playable parts will not show on the video
output of your miroVIDEO editing board.

To make the whole project playable, you have to activate the Premiere 5.1
Render Preview function, i.e. by hitting the <Enter> key.

Important: If your work area does not include the complete timeline, the
film strip in the INSTANT Video 5 window may still show red frames after
you called Render Preview. This is not a problem, because the non-playable
parts of the timeline are outside the work area, so the work area will play to
tape without problems.
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Status line
Normally there is a status line at the bottom of the INSTANT Video 5
window that shows different information, depending on the current mode of
operation of miroINSTANT Video 5.

The status line is not visible if the window has been minimized (see
miroINSTANT Video 5 menu below).

Dropped frames Indicator
If you are currently playing parts of the timeline, meaning that video plays
in the right video window within the Premiere 5.1 monitor window, the
status line shows the number of video frames that have been dropped during
the current playback. For smooth playback this number must be zero. If the
number of dropped frames is not zero, see the troubleshooting section
below. This message remains in the status line until you do another action.

miroINSTANT Video 5 menu
By moving the mouse pointer to any part of the miroINSTANT Video 5
window and clicking the right mouse button, you can activate the
miroINSTANT Video 5 menu. There are three menu items:

By default, audio scrubbing is switched on. This means, if your project
contains audio, you will hear the audio playback when playing clips or the
whole project as well as when scrubbing within the project (see the Premiere
5.1 manual for details on scrubbing and playing).
This is the standard Premiere 5.1 behavior, but it results in a slight
performance loss when scrubbing sections of audio that have not previously
been rendered (see the Premiere 5.1 manual for details on audio rendering
and how to see which parts have been rendered).

If you switch off Audio scrubbing in the miroINSTANT Video 5 menu by
selecting the Audio scrubbing menu item, there will be a different behavior:

You will hear audio only when playing clips or the project, but not when
scrubbing – and the scrubbing performance and frame rate will be higher.

You can access this miroINSTANT Video 5 online help by selecting the
menu item Help from the miroINSTANT Video 5 menu. Please do this if
you have any questions or problems using miroINSTANT Video 5.

Audio
scrubbing

Help
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The third item in the menu is used to change the size of the miroINSTANT
Video 5 window. If the window is at normal size the menu item is named
Minimize, and will reduce the window size so that only the window title bar
remains visible.

If the window is at minimized size the menu item is named Restore, and will
bring back the window to normal size. You may keep the miroINSTANT
Video 5 window minimized during editing to have the maximum space
available for other windows, and restore it to normal size for printing your
production to tape in order to see the dropped frames information.

MODES OF OPERATION

Video output
In Premiere 5.1 there are many modes of video display:

You can play, scrub or preview, you can use the trim or slip/slide tools, the
monitor window can be in single view or dual view mode with attached or
detached controls, and many more.

The Premiere 5.1 documentation describes what’s happening in all of these
modes on the PC screen—if you not use miroINSTANT Video 5.

When using miroINSTANT Video 5, the video display behaves different
from the descriptions in the Premiere 5.1 manual:

� In most modes of Premiere 5.1 operation you will get video output from
your Pinnacle editing board to your TV or video device.

� In some cases, the PC screen display is different from the standard
Premiere 5.1 behavior.

Here come the details (“shown on TV” means output by the miroVIDEO
editing board to connected video devices and/or screens):

� When playing or scrubbing single clips using the left set of controls in
the monitor window, they are shown on the PC screen and on TV in
parallel. You can use this mode to print single clips to tape. This does
only work if the clip has a format compatible with your Pinnacle video
board.

� When using the trim mode, the render-scrub mode or the slip and slide
tools, the video is shown on the PC screen only.

� When playing the work area after all effects have been rendered (Use the
<Enter> key to make Premiere 5.1 first render everything necessary,
then start the playback automatically), the timeline content will play
both on the PC screen and on TV out. The miroVIDEO board’s output
signal will be continuous, so this is the mode you should use for printing
your project to tape.

Minimize/
Restore
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� When you scrub or play parts of the timeline, the output depends on the
timeline content:
If you scrub through parts / effects that have not been rendered by
Premiere yet, there will be no TV output or one of the source clips will
be shown.
When playing, the same limitations apply to the PC screen output during
these parts of your project as well.
All parts of the timeline that need no rendering or have already been
rendered will be played on the PC screen and on TV out.

� When the source and program monitors are linked, the content of the
active monitor will be shown on the PC screen and on TV out, the other
monitor will display on the PC screen only.

 Audio output
The audio parts of the clips and projects you play back with miroINSTANT
Video 5 are being output using two different devices: Under Windows 95/98
it is the miroVIDEO editing boards, outputting audio through it’s analog or
digital connectors. During the installation the DC50 hardware has been
registered as the standard audio hardware in the Control Panel / Multimedia.

Under Windows NT audio is output via the standard Windows audio device,
i.e. your SoundBlaster card. The differences in audio output are explained
using the symbols below.

Audio is output through the miroVIDEO editing board (meaning the speaker
icon in the miroINSTANT Video 5 window is NOT crossed out) when you

� play an AVI file that is compatible with your DC50 editing board (see
details below) using the source monitor or a clip window

� do a playback of parts of the timeline, with ALL the audio in the work
area having been rendered into temporary audio clips by Adobe
Premiere 5.1before

The audio is output through the standard audio device in all other cases,
when you

� do scrubbing, if the audio scrubbing is not switched off in the
miroINSTANT Video 5 menu

� playback in the program monitor, and some parts of the audio in the
work area have not yet been rendered by Premiere

� play a clip in the source monitor or clip window, that has an
incompatible format
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 Rendering previews
You have read that the miroINSTANT Video 5 behavior depends on if the
audio and the video effects have already been rendered or not. Here’s a
summary about how you can do this rendering. The following always
applies to the currently selected work area in the timeline window, and only
renders things that haven’t already been rendered:

� To render audio only, select Project / Render Audio.

� To render audio and the necessary parts of the video, select Project /
Render Selection.

� To render audio and the necessary parts of the video, and immediately
start the playback of the work area (can be stopped by hitting the <ESC>
key), select Project / Preview or hit the <Enter> key.

While all of these functions belong to the “Preview” according to the
terminology of Adobe Premiere 5.1, when it comes to miroINSTANT Video
5 output, they are of the highest quality.

What to do to have the audio output through the
miroVIDEO editing board?
Set the work area to the timeline area you want to play, and hit the Enter key
to make Premiere render everything necessary and automatically start
playback.

If the speaker is STILL crossed out, this indicates that there are one or more
sections within the work area that contain no audio for a duration of ten
seconds or more, so that Premiere did not create audio temp files for these
sections.

You can locate these parts of your project by checking the timeline window.
At it’s top there is a small bar that indicates if audio temps exist for this
place of the timeline (see Adobe Premiere manual for details). You may
need to zoom in and scroll the timeline to locate the sections without audio
temps.

To force Premiere to create audio temps even for parts of the work area that
contain no audio, as required for miroINSTANT Video 5 playback, you can
add ‘dummy’ audio clips to these parts which either contain silence or have
their volume set to zero.

Hint: After the rendering took place, you may play the same area again by
either hitting <Enter> again or setting the timeline out point to any place
within the work area, setting the timeline cursor to any place in the work
area before the out point, and finally clicking the Play to out button in the
monitor window.
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 LIMITATIONS

Video clips that have any other speed than the standard 100% cannot be
played directly by miroINSTANT Video 5. To make these clips play, they
must first be rendered to the new speed. This happens automatically during
the Premiere 5.1 effect-render process if you use the project presets supplied
with your Pinnacle board.

Uncompressed still images or any clips that are not compressed with the
compression format supported by your miroVIDEO editing board cannot be
played to TV out directly, they must be rendered and transcoded to the
correct compression format first. The same applies to clips with the wrong
resolution – note that the resolution of a project is defined by the first video
clip, all others must have the same resolution to play back with
miroINSTANT Video 5 without transcoding.

•  To transcode all parts of the work area into the correct format use the
preview function (<Enter> key). Before transcoding, the incompatible
clips will not be shown on TV out.

All video clips in a project must have the same video resolution, the same
frame rate, the same compression format and the same audio format (same
sampling rate, same sample size and same number of channels) in order to
be played by miroINSTANT Video 5 without previous rendering.

miroVIDEO DC50 AND miroINSTANT VIDEO 5

� The required driver version for running miroINSTANT Video 5 is: 1.41
or higher.
You should always use the latest (highest version number) released
driver, please see http://www.pinnaclesys.com.

� Recommended audio settings
48 kHz 16 bits stereo.

� Supported video and compression formats
See miroDC50 presets.

When using Windows 95/98, the DC50 can act as the default audio
device and handle all audio output.

� Operating Systems
Windows 95 OSR 2.1 or Windows 98 recommended.

Windows NT 4.0 SP 3 recommended.

When using Windows NT 4.0, a separate sound card is required.

� Recommended graphics card:
Must support DirectDraw overlay surface, see compatibility list on
http://www.pinnaclesys.com.
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CHANGES FROM PREVIOUS VERSIONS

miroINSTANT Video 5 for Adobe Premiere 5.0 differs significantly from
the previous miroINSTANT Video for Adobe Premiere 4.2.
The new version works only with Adobe Premiere 5.0. There is no longer a
menu item in the Adobe Premiere menu to call miroINSTANT Video 5, nor
a special miroINSTANT Video play window. Instead, miroINSTANT
Video 5 is now fully integrated into the Adobe Premiere 5.0 user interface.
It is always active once it is selected as the Editing Mode.
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Pinnacle FreeFX

This chapter explains how the DV500 board works with video effects. The
DC50 board allows you to use all normal effects from Adobe Premiere.

In addition, Pinnacle FreeFX, these are accelerated 3D effects, are delivered
with the DC50:

Important: The accelerated 3D effects of the Pinnacle FreeFx are available
only in Windows 95, Windows 98, and Windows 98 SE!

What Is “Pinnacle FreeFX”?

Pinnacle FreeFX is an effects plug-in for Adobe® Premiere®.

The FreeFX effects are no real-time effects and therefore have to be
rendered.

FreeFX has a powerful 3D rendering engine offered in a complete and easy-
to-use interface. An installed graphics board with 3D acceleration is used by
FreeFX to strongly accelerate the rendering process.

System requirements for FreeFX

For the perfect function of FreeFX Microsoft DirectX 7.0 or higher has to
be installed on your system. DirectX is installed automatically during the
installation of the DC50. If you have not executed this installation step at the
beginning, please do this now.

Start FreeFX

Before starting Premiere, you should make sure that your VGA screen runs
at 16 bit (32,768 or 65,536) colors.

Many 3D accelerated graphics boards do not support proper FreeFX
rendering while running the Windows display  in TrueColor mode.

Start Premiere after the Pinnacle FreeFX installation. Open the transition
palette. The Pinnacle 3D transition should now be visible in the top area of
the screen window.

DirectX



Pinnacle FreeFX  83

When you access the Pinnacle FreeFX settings dialog for the first time, click
the Hardware button and set the slider to the proper position depending on
the graphics board used in your PC.

Important: If you are not sure if your graphics board and drivers support
full FreeFX acceleration, you should start working with FreeFX using the
lowest slider position.
For more information on the current compatible graphics boards, please visit
our FreeFX web site www.pinnaclesys.com/freefx.

Working with FreeFX

FreeFX works like using any other Premiere transition with custom settings:

In your Premiere project, drag the Pinnacle FreeFX transition from the list
in the transition palette to an appropriate position of the timeline window.

In the Pinnacle FreeFX window select one of the available effects, then
click OK.

That’s it!

Now you can preview, render and play the FreeFX the standard Premiere
way, and put the results to videotape with INSTANT Video.
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The options in the FreeFX window

Here you select the 3D effect you want to use for this transition by clicking
it from the list.

Some Pinnacle FreeFX reveal a (normally) black background on parts of the
screen which show neither video A nor B.

Here you can change the color of this background by clicking the Change
button and picking a color .

If you select a background bitmap as well, this color affects the tone of the
bitmap. The background can be reset to show the standard black by clicking
Reset to default.

Some FreeFX reveal a (normally) black background on parts of the screen
which show neither video A nor B.

Here you can select a bitmap to be shown as background by clicking the
Change button.

Effect to use

Background:
Color”

Background:
Bitmap to use”
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If you want to change the color of the bitmap, you may add a specific color
(see above) to it.

The bitmap must be in 256 colors or more, use true color for best results.

The bitmap will be scaled to the video size - to get best quality, the bitmap
size should be identical to your projects video resolution.

The background can be reset to show the standard black by clicking Reset to
default.

Important: With hardware acceleration enabled, background bitmaps can
use large amounts of the VGA board’s offscreen memory. If there is not
enough memory available on the VGA board, wrong render results or other
problems may occur. In this case you should use smaller bitmaps or no
bitmaps at all.

This option is normally checked for every Pinnacle 3D transition you apply.

This means that hardware accelerated rendering will be used for this effect if
the following conditions are met:

� a 3D accelerated graphics board is detected in your PC and

� there is enough off screen memory detected on the 3D graphics board
and

� hardware acceleration is generally enabled in the Pinnacle FreeFX 3D
system settings dialog (see below)

You should uncheck this option if the Pinnacle 3D effect that you have
selected causes problems with hardware rendering turned on. This could
mean bad looking results or other problems, like system crashes.

This switch only applies to one individual Pinnacle FreeFX transition on the
timeline, so you can turn off hardware rendering for one effect while leaving
it on for the others. To generally turn on and off hardware acceleration, use
the 3D system settings dialog.

This option is identical to the Reverse function in the standard Premiere
transition dialog, it makes the transition run from end to start.

This option is identical to the Swap Sources function in the standard
Premiere transition dialog, it makes the transition run video B to A instead
of A to B and vice versa.

This button opens the 3D system settings dialog. Here you can change the
general 3D hardware acceleration mode of Pinnacle FreeFX. Changes done
here apply to all Pinnacle FreeFX.

Use 3D
hardware to

render

Reverse

Swap Sources

Hardware
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The hardware compatibility slider offers three settings:

The topmost, called Full 3D hardware acceleration, makes the Pinnacle 3D
engine render the effects as fast as possible making full use of the available
3D graphics hardware. This may cause compatibility problems with some
VGA cards and drivers. With a modern 3D accelerator this results in render
times of less than 10:1, meaning a one second transition is being rendered in
less than ten seconds.

The center setting, called Reduced acceleration, still uses the 3D graphics
hardware for acceleration but does handle the image data transfer in a
slower mode and prevents using some sophisticated texture blending modes.
This can fix problems with some VGA cards.

The lowest setting, called No 3D hardware acceleration, does all 3D
rendering completely in software, using the CPU. This is slowest, but it
works with any VGA card and gives the lowest amount of possible
compatibility problems. This setting is required if your VGA card does not
support 3D acceleration, or has 8 MB or less of memory.

Click OK to close this dialog after doing your settings.

Clicking the Help button shows the ReadMe file. After reading the info you
need, click the button below to get back to the Pinnacle FreeFX window.

This button closes the Pinnacle FreeFX windows, applying all settings and
changes you have done.

This button closes the Pinnacle FreeFX windows without applying the
changes you did.

This button starts and stops the effect preview playback. This can also be
done by hitting the space bar.

The slider shows the current position within the effect. This is given as a
percentage. You can change the position by dragging the slider. The same
can be done with the left and right cursor keys.

Help

Ok

Cancel

Play

Slider
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The left and right brackets can be used to set the in and out points of the
effect. The current percentages are shown below. Setting both to the same
value will make the effect static, which is useful for picture-in-picture type
effects.

By default, the two video sources for the transition are represented in the
preview window by 'A' and 'B' bitmaps. Selecting this option will show the
actual source videos.

By default, the preview of a transition in this dialog has a fixed duration of
some seconds. Selecting this option makes the preview run at the same
duration the transition currently has in the timeline.

At the top of the FreeFX window, an indicator shows if the FreeFX
rendering is currently hardware accelerated (rendering in Hardware) or not
(rendering in Software).

How fast is FreeFX?

This depends on the Pinnacle editing board you use, on the speed of your
PC, CPU, and hard drive, on the FreeFX render mode you use, and (if you
use hardware rendering) on your VGA card and it's drivers.

Using a modern 500Mhz PC, a modern VGA board with proper drivers, and
a DC50 video editing board we have measured render times of about 12
seconds per second of FreeFX transition, being about 12:1.

If you see slow rendering, you should first check if hardware rendering is
being activated. This is shown on top of the FreeFX settings dialog. If it is
not active, check the following:

� the hardware slider must be set to medium or high position

� hardware rendering must not be disabled by the checkmark in the dialog

� your VGA must support 3D rendering, must have a Direct3D 6
compatible driver, and at least 8 MB of RAM.

Brackets

Show actual
sources

Show actual
length

Render mode
indicator
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How to use the Picture-in-Picture Effect

To create a static picture-in-picture (PiP) effect:

1. First place two video clips into the timeline, one each on video tracks 1A
and 1B, starting at the same time.

2. Next apply the Pinnacle FreeFX on the transition track between the two
videos.

3. In the FreeFX settings window, select the PiP effect and move the time
slider to 50%.

4. Click on both bracket icons to set both the start and end to 50%. Click
OK.

5. Adjust the position and length of the PiP effect by dragging it in the
timeline. Done!

To add a dynamic end movement to the PiP effect:

1. Add another FreeFX PiP effect, at the end of the one created above.

2. Set it's in point (using slider and left bracket) to 50% and the out point to
100%.

You can add start movements as well using the same method, and get
additional effects using the Reverse option.

If you have problems...

If you encounter any problems with FreeFX, please refer to Chapter
“Troubleshooting” of this manual first.
If you do not find any solution there, please use the FreeFX form available
on our web site for reporting—the link to this form is available at
http://www.pinnaclesys.com/freefx.

Static picture-
in-picture effect

(PiP)

Dynamic end
movement
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TitleDeko

WELCOME TO TITLEDEKO

Introduction

TitleDeko is a plug-in program for Adobe Premiere. This plug-in is
designed to work with your miroVIDEO DC50 board. As an integrated title
editor program, TitleDeko allows you to create professional quality titles
and graphics quickly and easily. Titles can contain words, shapes,
background colors, and photos or graphics imported from other programs.
TitleDeko offers professionally developed Preset Styles for quickly making
titles, along with virtually endless custom styling. You can modify titles for
a variety of effects, such as titles that roll in vertically or crawl horizontally.
You can also adjust the duration the title appears in your movie.

This chapter begins with a brief explanation of how titles are created, details
the more advanced features, and then guides you through several examples
of making and modifying titles.

How Titles Are Created

TitleDeko appears in a separate window with its own user interface. It
creates titles that are inserted in your Adobe Premiere  project. You can also
save titles separately to use in other Adobe Premiere movies.

You create the title in the Preview Area of the TitleDeko window. You type
in text, apply a style, and complete it by resizing, repositioning, or rotating
the text, and by adding shapes or pictures. When you’re done, save the title
and press <F12>. The title is automatically inserted into the Adobe Premiere
Project window. Titles and graphics are trimmed in Adobe Premiere. See the
Adobe Premiere User Guide for complete instructions on trimming.
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INSTALLING TITLEDEKO

To install TitleDeko, proceed as follows:

1. Switch on the computer.

If you have not done so already, switch on the computer.

2. Insert CD-ROM.

If have not done so already, insert the TitleDeko installation CD in your
CD-ROM drive.

The installation program should start automatically. If this is not the case,
the AutoStart function of your CD-ROM drive has probably been disabled.
In this case, you have to start the installation program manually. To do so,
elect the Run... command in the Start menu and enter [your drive
letter]:\AUTORUN.EXE. Click on OK to start the installation
program.

3. Follow the instructions.

Follow the instructions of the installation program.

LAUNCHING TITLEDEKO

You can launch TitleDeko from the Main Menu Bar of Adobe Premiere , or
in two ways from an existing Adobe Premiere project.

You can also start TitleDeko directly from Windows.

Launching from the Adobe Premiere Main Menu Bar

Choose Project > Create, then click TitleDeko.

Launching from the Adobe Premiere  Timeline

On the Timeline, double-click the title icon of an existing TitleDeko title.

You can only launch TitleDeko in this manner when there is a TitleDeko
title on the Timeline.

Launching from the Adobe Premiere  Project Window

In the Project window, double-click the title icon of an existing TitleDeko
title.

You can only launch TitleDeko in this manner when there is a TitleDeko in
the Project window.
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THE TITLEDEKO USER INTERFACE

TitleDeko is a separate application with its own user interface that offers
menus, windows and toolbars.
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TitleDeko Windows

TitleDeko windows follow standard Windows conventions—you can open,
close, move and resize them.

Menu Bar
The Menu Bar provides menus of commands and other choices (not shown
in illustration). Frequently used commands have Toolbar buttons.

Toolbars
Toolbars contain Tool Groups that can be ”torn off” or rearranged.

Preview Area
A Preview Area shows a what-you-see-is-what-you-get (WYSIWYG) view
of your work, along with lines denoting a “video safe area” always visible in
the final movie.

Preset Styles
A Preset Styles window shows the style presets that can be applied to text
and other objects. You can modify the Preset Styles and create new ones.
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Status Line
A Status Line provides information about the tool in use, text cursor
coordinates, movement setting (Coarse or Fine), and so forth.

Tool Functions

At the top and left of TitleDeko are Toolbars that offer fast access to
frequently used TitleDeko functions. In addition, all functions can be
selected via the menus. Frequently used functions also have keyboard
shortcuts.

New, Open and Save Files

These are standard Windows functions.

File Type

Select a File Type for the title. Choices include Still, Roll, and Crawl.
Choosing Still creates a title that appears on the screen, remains for a set
duration, and disappears. Choosing Roll creates a title that rises onto the
screen, moving from the bottom edge to the top. Choosing Crawl creates a
title that moves onto the screen from the right and progresses to the left.

Rolls and Crawls are rendered in Adobe Premiere.

Cut, Copy and Paste

These are standard Windows functions.

Typographical Characteristics

Before you can change typographical characteristics, select the text you
want to change. Click the drop-down list arrows to choose a typeface and its
size.

To preview the typeface before you select it, click the Typeface Browser
button, then choose the face you want from the browser window.

To make text bold, italic and/or underline, click the respective button.

Still, Roll,
Crawl

Fonts
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Look Browser / Edit Looks

Look Browser
Click the Look Browser button to display a window that contains all the
preset looks. Clicking on a specific look applies a set of appearance
attributes to the selected object.

Edit Look
Click the Edit Look button to modify the currently selected look. There are
numerous fine adjustments that are explained in greater detail later.

Grid / Horizontal / Vertical Alignment Browsers

Alignment browser tools are active depending on whether the selected
object is text or a non-text object (such a circle). For example, you can right
align a circle, but you can’t kern it like text by spreading out the words and
letters.

Grid
Click the Grid button for a browser that gives you a fast way to align
objects.

Horizontal and Vertical
To change the horizontal or vertical alignment and/or justification of text
characters, click the respective button and choose the type of alignment you
wish. Note that some alignments also work on objects.

Undo / Redo

Click Undo to undo the last action. Undo will undo multiple levels of action,
limited only by available memory. Redo undoes the last Undo.

Move/Resize, Rotate/Skew

 

Depending on the object handle selected, these controls have different
functions. Move the cursor over the object. The cursor shows the active
function.

Text Kerning/Leading

Spreads text lines vertically (leading), or adds/removes space between
individual letters and words horizontally (kerning).
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Add Rectangle, Ellipse

Click to add these shapes.

 

Insert Picture

Click to insert an image from your hard disk or other media. Pictures are
treated like other objects in that you can move, scale and size them. You
cannot, however, skew or rotate a picture.

Replace Background

Allows you to make adjustments to the color, opacity and other details of
the background.

Additional Menu Commands

Coarse / Fine

Cursor Movement
From the main menu bar, select Transform > Coarse or Fine to change the
increments used in cursor movement.

Bring to Front / Send to Back

Layering
From the main menu bar, select Layer > Bring to Front or Send to Back to
place the selection on the top or bottom layer.

Bring Forward One Layer / Send Back One Layer

From the main menu bar, select Layer > Bring Forward One Layer or Send
Back One Layer to move the selection one layer toward the top or bottom.

Find, Find Next and Replace

Search and Replace
From the main menu bar, select Edit > Find, Find Next or Replace to
perform text search and replace functions analogous to those of a word
processor.

Accept title, return to Premiere / Reject title, return to Premiere

Accept/Save Title
From the main menu bar, select File > Accept title, return to Premiere.
Accepts the title and returns you to Adobe Premiere. If you have not yet
saved the title, this command will first allow you to save, then return to
Premiere.
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Return to Premiere
From the main menu bar, select Reject title, return to Premiere. Rejects the
title and returns you to Adobe Premiere. Use this command when you do not
want to save changes to the title.

Clear Selected Text and Select All

Selection
From the main menu bar, select Edit > Clear Selected Text or Select All.
These functions are analogous to those of a word processor.

SELECTING TEXT AND OBJECTS

TitleDeko is character-oriented. Consequently, text selection feels a little
different than in other software, particularly word processors. The unique
ways TitleDeko selects text are expressly tuned for editing titles, and offer a
great deal of graphical flexibility, unlike a word processor. For example,
you can select a single character and resize it, skew it or even rotate it.

To select all text characters or objects

Type several lines of text, then try the following selection methods until text
selection seems comfortable

•  To select all text and objects, choose Select All from the Edit menu. To
select all text, click anywhere on the text field then press <Ctrl> +
<A>. A selection box with handles appears around the text.

If you click on the red dashed line indicating the video-safe area, a similar
looking box appears. However, this box is larger and surrounds the entire
image. You have selected the image area, not the text.



96  miroVIDEO DC50

To select a single word or object

•  Double-click the word or object. Or, use the arrow keys to move the
cursor to the beginning or end of the word, then hold Shift and press
the right or left arrow.

A selection border with handles appears around the word or object.

To select a random section of text spanning more than one line

•  Drag across, then down or up the text, or diagonally.

•  Or, position the cursor at the beginning or end of the desired selection
area, and press arrow keys while holding the Shift key. Also, the Tab
key moves the cursor from one word to the next.

Selected text within blocks is denoted by a series of fine parallel black
lines as shown in the following illustration. A selection box with handles
surrounds the entire box.

Deselection
To deselect text or objects, click anywhere outside the selected area.
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FORMATTING TEXT AND OBJECTS

You can format text and objects by choosing a style with preset attributes, or
manually by adjusting attributes such as boldness, size, typeface and
spacing.

To select and change the typeface, click the down arrow and choose the
typeface from the drop-down list, or click the Typeface Browser button for a
graphical display of typefaces, and double-click the one you want.

To change the point size of text, type a new value into the Size field or click
the arrow buttons.

To change text to bold, italic and/or underline, select the text to be changed.
For bold, italic and underline, click the corresponding button in the Editor
menu bar, or use the shortcuts (<Ctrl> + <B>), (<Ctrl> + <I>) and (<Ctrl> +
<U>).

Applying Looks to Text and Objects

One of TitleDeko’s most powerful features is its library of preset looks.
Looks include color, texture and transparency attributes that are applied to
the face, edge and shadow of objects. With a click of the mouse you can
instantly change the appearance of an object from glowing purple neon to
blue metallic.

To select and change looks, click the Looks button. The Looks browser
graphically displays the looks you can pick. Just double-click the look you
want.

Fonts
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Justifying Text

Justification operates differently in a video character generator than in a
word processor. TitleDeko uses justification controls to position all objects,
including rectangles and ellipses, as well as text. You can Justify objects via
menu selections, buttons, keyboard shortcuts and keypad shortcuts. The next
sections explain how to use these techniques.

Justification Buttons

Three buttons provide access to the same functions: Justify, Horizontal
Justify, and Vertical Justify.

The Justify button provides the same Bottom, Middle, Top functions as does
the Justify menu, and also has Left, Center, Right controls for each. Click the
Justify button to display a grid that resembles a tic-tac-toe grid. To use the
grid, select the text or object, and click the button that indicates how you
want the text justified, or where you want the object positioned.

The numeric keypad also emulates the functions of the grid, and thus offers
a quick way to position or justify text and other objects, which is
particularly useful if you have many repetitions to do. Hold down the Ctrl
key, and press one of the numbers on the numeric keypad to quickly justify
text (and objects) . Notice that the position of the marker in the grid button
changes as do the Horizontal and Vertical Justification buttons.
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The Horizontal and Vertical Justify buttons display controls to manipulate
text and objects in those axes. In addition, these buttons also contain Full
and Spread functions that apply only to text. Select the text or object, click
the button that indicates how you want the text justified or where you want
the object positioned. The choices are obvious except for Full and Spread.

Keypad
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Full Horizontal, Full Vertical and Spread Justification

Full horizontal justification makes the text flush or even with both the left
and right sides of the text field box, except for the last line of text which
remains left justified. Full vertical justification makes the text flush or even
with both the top and bottom of the text field box. Spread justification
makes all lines of text flush with both the left and right sides of the text field
box, including the last line.

  

TOOLS AND SELECTION HANDLES

Three buttons (Move/Resize, Rotate/Skew, and Kerning/Leading) have dual
functions depending on the handle you select. The current function is
denoted by cursor shape. The following text explains these cursor shapes
and how they function on text and other objects.

  

When you select an object, handles appear on the corners and midpoints as
shown in the illustration on the left. In the case of Rotate and Skew, a single
handle appears in the upper right corner as shown on the right.

Kerning/Leading Tool

 

Kerning/leading Tool

This multifunction tool is used to change several characteristics. The
Kerning and Leading cursors appear only on the handles.

 



100  miroVIDEO DC50

Kerning

Kerning is adjustment of the space between words and letters. Kerning is
typically used for very large letters. Some characters in combination
produce spacing that is visually unpleasant.

  

To kern text, click the Kerning/Leading button, select the characters to kern,
hold down Alt and press the right/left arrows to increase/reduce the space
between selected characters. Or, use the cursor to drag the handle at either
side of the selected text.

Leading

  

Leading is the amount of space between lines of text. To change the leading,
click the Kerning/Leading button, select the text, and use the cursor to drag
one of the handles above or below the text block.

Layers

Layers allow you to put one object in front of another. To move a layer
forward or backward, select the object. From the Layer menu, choose one of
the menu commands such as Layer > Send Back One Layer, or press its
command key equivalent (<Ctrl> + <->).
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TRANSFORMING TEXT AND OBJECTS

Move/Resize Tool

Moving

The Move cursor indicates moving is enabled. It appears anywhere on the
selection box except at the handles.

Resizing

Corner handles control height and width together; middle handles on the
right or left control width only; and middle handles on the top or bottom
control height only. Hold down Ctrl while dragging a corner handle to
constrain the aspect ratio during scaling.

In the following example, the word in the center has not been changed. The
widths of the words on the left and right are narrowed and expanded
respectively.

  

Rotate/Skew Tool

Rotating

The Rotate cursor indicates rotating is enabled. It appears anywhere on the
selection box, except at the upper right handle.

Skewing

The Skew cursor appears only when you position it on the upper right
handle. Use the Skew function to make objects appear slanted.
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USING AND MODIFYING LOOKS AND STYLES

About Looks and Styles

A you have seen, applying a look changes the appearance of text and
objects. A look consists of a face, edge and shadow. Each of those has a
variety of parameters you can also adjust.

A style includes a look, plus any other formatting or transformations that
can be applied to text or objects. For example, styles can include typeface,
size, and rotation, in addition to a look.

Applying Looks to Text and Objects

•  To select and change looks, click the Looks button.

The Looks browser graphically displays the looks you can pick. Just double-
click the look you want.

Editing Looks

To create your own custom effect, change the detail attributes of the current
look. You cannot save your changes in the Looks browser. However, you
can save them as part of a style.

Each look detail (face, edge or shadow) has its own set of attributes such as
color, size and blur, which you change to create a custom look. The face is
the font rendered in the current attributes. The edge is an additional line
around the face, and the shadow is an offset second image of the face and
the edge.

Select View > Look Editor, or click the Edit Current Look button. The Look
Editor window appears, with a tab for each of the three details.

Looks

Styles

Details
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The Details and Attributes

Most of the Attribute controls are obvious, so the following does not explain
those in depth. In addition, a small preview window in the lower left corner
shows your adjustments, which makes it easy for you to experiment.

Face Edge Shadow

Face, edge and shadow details have several items in common:

� Choice of solid or gradient colors. These operate the same was as
described later in this chapter in the section on Backgrounds.

� A Blur slider, which varies the fuzziness of the face, edge or shadow
detail. You can adjust the slider, or type in a precise number.

Face, edge and shadow details differ in these respects:

� The face detail has a checkbox that turns off the face altogether, leaving
only the edge and shadow.

� The edge and shadow details allow adjustment of the edge or shadow
size and thickness. Make adjustments either with the slider, or by typing
in a precise value.
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� The shadow detail also allows you to change the direction of the
imaginary light source that creates the shadow.

Accessing the Style Window

Styles are accessed in the Style window.

To display the Style window, select View > Preset Styles or Window >
Styles from the menu bar. The Style window contains graphic
representations of 24 Preset Styles. To select a style, double-click on it.

Creating your own Styles

You can replace any of the 24 Preset Styles with a style of your own. Create
text or an object with the attributes you want for your new style. right-click
on the Preset Style you wish to replace. Select Deposit Current Style Here.
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THE BACKGROUND

Backgrounds fill the screen behind all the text and objects. Titles can have a
transparent background, in which case the text and objects appear directly
on top of the video. They can alternatively have a solid or gradient color
background. A color background can either be opaque (no underlying video
is visible), or semi-opaque (allowing the video to show through the color
background). TitleDeko also allows the option of importing a picture to use
as the background.

Replace Background Window

You control all aspects of the background with the Replace Background
window.

Transparent Backgrounds

Select Background is transparent to create a transparent title with no
background. This is the default choice for Background.

For a transparent or semitransparent title, you must also select Alpha
Channel as your Key Type from the Adobe Premiere Transparency Settings
window.

Solid Color Backgrounds

To use a solid color as a background, select Background is a solid color.
This creates a background consisting of a single color. This background
could be semitransparent, if the opacity is set between 0 and 100 percent.

Gradient Backgrounds

To use a gradient background, select Background is a color gradient.
Gradient backgrounds consist of two or more colors that are blended
smoothly together. Each color can have its own level of opacity.
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To make the top a single color that merges into a single color at the bottom,
choose the same color for both the top and bottom sets of Color buttons.

Picture Backgrounds

To use a picture as the background, select Background is a picture. Type in
the path name, or click the Browse button, navigate to the directory that
contains the file, and choose the file.

Selecting Colors and Opacity

Colors

To select color and opacity for a solid or gradient background, click on the
corresponding Color button. The Color Picker appears. Except for opacity,
the choices in this screen are self-explanatory and conform to Windows
Color Picker standards.

Opacity

The following illustrations show that, as you adjust the Opacity slider down
from 100%, the background becomes increasingly transparent.

Color Picker
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LET’S MAKE A TITLE

Example 1 creates a basic title and inserts it into the Timeline in Adobe
Premiere . Examples 2, 3,and 4 build on this basic title to show more
advanced TitleDeko features.

Example 2 enhances the text in a number of ways, including resizing,
rotating and skewing. This example also adds a shape behind the text, to
which a style is applied.

Example 3 creates a Roll. This allows the title to roll vertically from the
bottom of the screen to the top. It also trims the title from the Adobe
Premiere  Timeline.

Example 4 creates a scrollable crawl. This allows the more than one frame
of title text to crawl horizontally from the left of the screen, toward the right.
You also trim the title from the Main Menu Bar of Adobe Premiere .

Example 1:
Creating a Basic Title

This example launches TitleDeko from Adobe Premiere, creates a basic
title, and returns you to Adobe Premiere .

1. Launch TitleDeko from the Main Menu Bar of Adobe Premiere.
Choose Project > Create, then click TitleDeko.
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2. Enter the title text.

TitleDeko launches and a text I-Beam cursor awaits text entry. Type the
words: Happy Birthday You will change the type size and apply a
new style to it, but you must first select the text.

3. Select the text.

Press <Ctrl> + <A> to select the text. A selection box, with handles on
its sides, now surrounds the text.

4. Apply a Preset Style to the text.

A sampling of styles is displayed in the window to the right of the
Preview Area. (If the Style window is not visible, select View > Preset
Styles.) Scroll down to number 5 and click it.
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5. Check your progress.

The style characteristics are applied to the text:

6. Proportionally shrink the text.

Click the Move/Resize tool button. To resize the text, click anywhere on
the text field then press <Ctrl> + <A> to select it, then position the cursor
on the lower right handle while pressing the <Ctrl> key to proportionally
shrink the text.

7. Center the text horizontally.

To center the text, click the Horizontal Justify button to display its pop-
up choices. Click the center button.

8. Check your progress.

Your title is centered, and appears as follows:
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9. Save the title.

Click the Save button to save the Still.

10.Return to Adobe Premiere.

Press <F12> to accept the title and return to Adobe Premiere.

Trim the title.
You return to Adobe Premiere  from TitleDeko. Adobe Premiere places
the title in the Project window.

From here, drag the title to the Timeline and place it on Video 2, or the
top video channel. On the Timeline, place the cursor on the title icon.
Right click the icon.

Select Video > Transparency to view the Transparency Settings window.
From the Key Type drop down list, choose Alpha Channel. Click OK.
Click the Player buttons to preview your work.
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Example 2:
Modifying the Text

In this example, you enhance the title created in Example 1 by rotating and
skewing the text.

1. Launch TitleDeko from an existing Premiere project.

Double-click the title on the Timeline, or in the Project window.

2. Move the title text.

Click the Move/Resize button. Select the text and position the cursor
anywhere within the text or on the border (except on the handles) so the
cursor is a Move symbol that looks like a cross. Experiment with moving
the text.

3. Rotate the text.

Click the Rotate/Skew button. Rotate the text.
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4. Apply a combination of formatting techniques.

In the following illustration, Style 4 was applied to the text. The selection
was rotated, made bold, and resized. The Rotate/Skew tool was used to
skew the text, by grabbing the upper right handle with the Skew cursor.

5. Add and transform a rectangle.

Click the Rectangle button. A white rectangle appears. Click the
Move/Resize button and resize the rectangle. Click the Rotate/Skew
button, grab the upper right handle and skew the rectangle. Position the
Rotate/Skew cursor over the shape and rotate it to match the text angle.
Click the Style 8 icon. Move the shape over the text and select Layer >
Send to Back from the menu bar.

6. Save the title.

Click the Save button to save the Still.

7. Return to Adobe Premiere

Press <F12> to accept the title and return to Adobe Premiere .
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Example 3:
Creating a Roll

In this example, you create a title selecting Roll as the File Type. This will
allow the title to roll vertically from the bottom of the screen, to the top.
You also trim the title from the Timeline.

1. Launch TitleDeko from the Main Menu Bar of Adobe Premiere.

Choose Project > Create, then click TitleDeko.

2. Enter the title text.

TitleDeko launches and a text I-Beam cursor awaits text entry. Type the
words: Best Wishes from Your Fan Club on Your
Birthday. You will change the type size and apply a new style to it,
but you must first select the text.

3. Select the text.

Press <Ctrl> + <A> to select the text. A selection box, with handles on
its sides, now surrounds the text.

4. Apply a Preset Style to the text.

A sampling of styles is displayed in the window to the right of the
Preview Area. (If the Style window is not visible, select View > Preset
Styles.) Scroll down to number 2and click it.

5. Center the text horizontally.

To center the text, click the Horizontal Justify button to display its pop-
up choices. Click the center button.

6. Fully Justify the Text Vertically.

Click the Vertical Justify button to display its pop-up choices. Click the
Full button.

7. Make the title a Roll.

Click the File Type drop-down arrow. Select Roll.

8. Save the title.

Click the Save button to save the Roll.

9. Return to Adobe Premiere.

Press <F12> to accept the title and return to Adobe Premiere.

10.Trim the title.

Right click the title icon on the Timeline. Do one of the following:

� Select Duration, and enter a new duration. Click OK.

� Select Speed, and enter a new rate. You can also enter a new duration
from this Clip Speed window. Click OK.

Selecting Roll or Crawl allows you to use more text than will fit in the video
safe area. Select File > Scrollable to roll or crawl additional text.
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Example 4:
Creating a Scrollable Crawl

In this example, you launch TitleDeko and create a scrollable crawl. This
will allow the title to crawl horizontally from the left of the screen, toward
the right. You also trim the title from the Main Menu Bar of Adobe
Premiere.

1. Launch TitleDeko from the Main Menu Bar of Adobe Premiere.

Choose Project > Create, then click TitleDeko.

2. Enter the title text.

TitleDeko launches and a text I-Beam cursor awaits text entry. Type the
words: Happy Birthday to You! Happy Birthday to
You! Happy Birthday, Dear You!

3. Select the text.

Press <Ctrl> + <A> to select the text. The text is now surrounded by a
selection box with handles on its sides.

4. Apply a Preset Style to the text.

A sampling of styles is displayed in the window to the right of the
Preview Area. (If the Style window is not visible, select View > Preset
Styles.) Scroll down to number 3 and click it.

5. Make this title a Crawl.

Click the File Type drop-down arrow. Select Crawl.

6. Allow more than one frame of text to crawl.

Click File > Scrollable.

7. Save the title.

Click the Save button to save the Crawl.

8. Return to Adobe Premiere.

Press <F12> to accept the title and return to Adobe Premiere.

9. Trim the title.

Do one of the following:

� Select Clip > Duration, and enter a new duration. Click OK.

� Select Clip > Speed, and enter a new rate. You can also enter a new
duration from this Clip Speed window. Click OK.

You can also adjust the duration of the title by dragging the left and right
edges of the title icon on the Timeline.
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Video SpiceRack

KEY CONCEPTS OF VIDEO SPICERACK

Video SpiceRack offers a collection of 300 top-quality transitions and
dynamic effects. The key concepts and possibilities are explained below:

� Video SpiceRack uses grayscale “gradient” images - specially designed
for video - to create custom transitions and effects.

For further details, please refer to the section “How does a gradient
image make a transition?”.

� To easily choose from the vast range of Video SpiceRack alternatives,
we’ve organized our effects into distinct categories.

Video SpiceRack gradients are organized into five groups, as shown in
the section “Video SpiceRack Categories”. The five groups together hold
several categories of transitions. Each category is visually distinct and in
a separate folder, making it relatively easy to compare and choose from
the available effects.

HOW DOES A GRADIENT IMAGE MAKE A TRANSITION?

In short, the magic is in a gradient’s grayscales (also known as the
luminance).Your host editing application reads the grayscale value - from 0
(black) to 255 (white) - of each pixel in a gradient image that you select.
Those values then generate a wipe transition - a line, shape, texture or
pattern that will “wipe” away one image to reveal the next image. Pixels in
Image B will replace Image A first where the gradient’s darkest pixels
reside, then in progressively lighter gray areas, and finally where the
brightest pixels sit.

By reducing opacity along the moving edge, most editing applications can
soften a gradient transition much more than other transitions. You can
therefore create intriguing directional dissolves, soft dynamic mattes, or
split-screens, and more. From a base of 300 spices, you really have the
seasoning for an incredible number of visual effects.

To help you select transitions quickly, we’ve included a quick-reference
card in your Video SpiceRack package. It illustrates our effects, organized
by the same visual categories.



116  miroVIDEO DC50

VIDEO SPICERACK CATEGORIES

Cool Wipes

More than seventy “coolest of the cool” transitions:

� Patterns - Attractive wipes formed by simple, repeated geometries

� Progressions - Playful pixels that fill the frame in progressive steps

� TransActive - A killer collection of stunning eye-catcher transitions

� Videogami - Unique folding wipes that evoke origami as they open.

Pure & Simple

Over seventy simple, elegantly flowing transitions:

� Edge2Edge - Fresh wipes that travel cleanly across the frame

� Iris Essentials - Meaningful symbols and shapes that grow to reveal

� Splits -Creative new approaches to splitting images in half

� Thirds - Transitions that flow along third-points in the frame

� TruQuads -Useful ways to slice and wipe in frame quadrants.

Organix

Break from the usual with seventy live edges:

� Kaleidos - Amazing kaleidoscopic patterns that open images

� Livelrises - Irises featuring a wide variety of dynamic edges

� LiveWipes - Cool edge dynamics applied to standard wipe styles

� Textures - Natural textures that organically evolve to reveal.

WonderBands

Fifty band effects to extend your visual repertoire:

� Radiant - Novas, rays, waves and other effects

� Uniform - New styles of uniform-size bands that move and grow

� Variable - Variable-size band-like effects.

Standards Plus

Iris and wipe transition standards you can easily soften or customize to an
unlimited degree - leading to fresh visual treatments.
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Tips & Tricks

There are several possibilities in order to optimize the performance for
editing videos. These possibilities are based on the following aspects:

� System settings

� Source material

� Capturing

� Editing video sequences.

SYSTEM SETTINGS

General information

IRQs have different priorities in the system. When configuring your system
for the usage of DC50 you should consider the following aspects:

� An interrupt higher in numbers than the IRQ, related to the SCSI
adapter, should be assigned to the DC50 board. The interrupt assigned to
the DC50 board must not be higher than IRQ 11.

Not every BIOS allows assigning an interrupt.

� In this case an interrupt of 9 or IRQ 10 must be assigned to the SCSI
adapter.

� The DC50 board and the SCSI adapter must not share the assigned
interrupt (no interrupt sharing!).

Hard Disk

If your system contains a SCSI hard disk, you can apply the following
measures in order to optimize the system:

� Deactivate the Parity Checking feature of the hard disk. Please refer also
to the hard disk's manual.

� Activate the hard disk's write cache. For this purpose use for example
EZ-SCSI by Adaptec.

� Deactivate any kind of hard disk power management. For this purpose
use for example the SCSI explorer by Adaptec.

� Optimize the hard disk for video editing (continuous writing and
reading). For this purpose use for example DR. SCSI by Peripheral Test
Instruments Inc.

SCSI
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If you system contains a E-IDE hard disk, you can apply the following
measures in order to optimize the system:

� The hard disk must not be connected to the same E-IDE interface, to
which the CD-ROM drive is connected.

� Deactivate any kind of hard disk power management in the computer's
BIOS.

� Install the busmaster driver for the motherboard and activate the DMA.
Therefore open the Start menu, click on Settings, Control Panel, System
and Device Manager. Select the Properties button and activate the check
box DMA.

� Activate "Fast E-IDE" in the BIOS while the computer is booting up.
Please refer also to the computer's user manual.

Windows 95/98

To use the functions under Windows 95/98 in the most effective way, please
consider the following aspects:

� Use the Windows Media Player and the miroAVI Cache, located in the
Media Player under Devices, in order to playback a video sequence. If
you wish to playback a complete project, in the activated timeline
window press the <Enter> key to start the video playback.

� Open the Start menu, click on Settings, Control Panel, System and on
the tab Performance. Click on the File System... button and set the Read-
ahead optimization to None.

� Open the Start menu, click on Settings, Control Panel, System and on
the tab Performance. Click on the File System...button, activate the tab
Troubleshooting and the option Disable write-behind caching for all
drivers.

� Open the Start menu, click on Settings, Control Panel, System and on
the tab Device Manager. Select your CD-ROM drive and click on the
Properties... button. Activate the Properties button and deactivate the
option Auto insert notification.

� Open the Start menu, click on Settings, Control Panel, Display and on
the tab Screen Saver. Deactivate the screen saver (Choose the option
None).

E-IDE
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Windows NT

To profit from the possibilities under Windows NT in the most effective
way, consider the following aspects:

� Windows NT needs a maximum amount of memory space (RAM) for
running rapidly and without any problems. For video editing 64 MBytes
are the minimum, 256 Mbytes are recommended.

Some motherboards are not able to address memories of more than 64
Mbytes via the system cache. These systems experience a performance loss
when more than 64 Mbytes of RAM are used. Please consult your retailer in
order to find out, if your system can be improved(Tag-RAM).

� Deactivate the AutoRun function of your CD-ROM drive: Open in the
directory \winnt the program regedit.exe.
Change the value for

KEY_LOCAL_MACHINES\SYSTEM\CurrentControlSet\
Services\Cdrom\Autorun

from “1” to “0”.

� When using E-IDE hard disks you should install an IDE busmaster
driver under Windows NT. Such a driver is usually supplied together
with the computer / motherboard. In order to check, if an IDE busmaster
driver is installed and is able to operate, start the Task Manager (<Ctrl>
+ <Alt> + <Del>). Choose the tab Performance. Under the menu item
View activate the option Show Kernel Times. Start a capturing process. If
the display CPU-Usage mounts to more than 30%, no IDE busmaster
driver is installed under Windows NT.

� If the video hard disk is connected to an SCSI adapter, which is not
connected to the system hard disk, deactivating the SCSI adapter's BIOS
can increase the performance. Please refer to the SCSI adapter's user
manual. After having deactivated the SCSI adapter's BIOS, you need to
repartition the video hard disk.

� Format the video hard disk always with FAT16 and not with NTFS.

� Open the Start menu, click on Settings, Control Panel, Display and on
the tab Screen Saver. Deactivate the screen saver (None).

� Open the Start menu, click on Settings, Control Panel, System and open
the dialogue box System Properties. Click on the tab Performance and
activate the option Maximum in order to increase the performance of
applications in the foreground.

� Deactivate the network board and the network functions. (Don't log in.)
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SOURCE MATERIAL

The better (without noises, well exposed) the source material, the better the
compression, without any visible compression losses. Problems occur with
noisy image material as it is the case after copying video material several
times. Even if the video material itself does not have a high level of detail,
the noise must still be compressed, which results in a considerable quality
loss.

CAPTURE

Deactivating Network drivers and applications

As network operations  often cause interruptions during recording and
playback, it is better not to work in a network.

Color depth adjustment

For graphics boards, it generally applies that a high Windows resolution
together with a high color depth and high refresh rates will, among other
things, result in poor overlay quality. Reducing the resolution, color depth
and/or the refresh rate will probably produce better overlay quality.

The overlay setting effect only the display on the computer monitor, while
recorded sequences will always appear in TrueColor at the video output!

Format

Decide on one format (one resolution) before you begin a project. This
applies to both the video as well as to bitmaps and animation. Doing so
saves a lot of time during computations and allows a conversion via
miroINSTANT Video.

Cropping

When digitizing video images, it is not necessary to include the entire
image, because the frame will contain invisible and unimportant areas
around its borders. These areas can be cropped without the loss of any
information.

Cropping reduces the amount of data and, in turn, permits digitizing to be
carried out at a higher level of quality and without dropping frames.
Therefore choose the option [672x544]: TV-Cropping as Capture resolution
in the DC50 Video Format dialogue box.
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Closing programs / applications

You should always close all programs / applications (e.g. mail, screen saver)
which are not used at the moment and – if necessary, in order to increase the
memory – possibly delete the background picture via the Control Panel.

EDITING

Text

If you wish to add text to digitized video sequences during editing, make
sure you have prepared your text in advance.

Text has very sharp contours / edges. During compression, sharp edges
produce very high frequency elements that will be lost during JPEG
compression. If a video sequence that contains text and that has been JPEG
compressed is output to an analog device, the quality of the text will be
unacceptable if the video sequence is not recompressed at a maximum data
rate.

To avoid this, you should use a suitable graphics program to soften any text
entries before adding them to a video sequence.

Refer also to the section "JPEG Problems" in the appendix.

DC50 and Adobe Premiere

If you use Adobe Premiere in order to create digitized video sequences,
please note the following to achieve optimum results.

Use one of the default settings for DC50, that was copied to the hard disk
during installation. If you installed Adobe Premiere after the DC50, you can
go back later and install the project default files (preset-).

Record all clips belonging to the same project in the same format (e.g.
always with half resolution, both fields, PAL). Thus you can avoid Premiere
having to go through the long and computer-intensive process of bringing
all movies to one size when the final movie is being created.

Please use the Cropping: TV setting when recording video images to the
hard disk. One video signal generally contains more information than is
displayed on a television (overscan area). In some cases, camcorders and
VCRs will hide image problems (e.g. defects, incomplete or flickering lines)
in these normally invisible areas. If you change the position of an image
with Premiere (e.g. during a dissolve of fade with Wipe or Zoom), these
problems will become visible.

This will also apply to all other videos or animation (e.g. .FLI / .FLC) and
images (bitmaps, TIFs, GIFs, etc.), to be included in the project.

General
Information
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DC50 and Computer Animation

If you edit computer animation (e.g. Flics) with the DC50 or want to link
them to a digital video, please note the following important information:

� Match frame sizes
Create your animation in the same frame size and image refresh rate as
your original video: 720 x 576 x 25 [PAL] / 720 x 468 [NTSC] (full
format) or as TV cropping 672 x 560 [PAL] / 672 x 464 [NTSC]. Failure
to do this will result in unnecessarily long format conversions and, after
the conversion, faults will be visible when the animation is played back.

� Specify TrueColor format
Computer animation in FLC format is saved in 8 bit pallatized format by
default. To save computer animation in Motion-JPEG format, you need
to convert it to a TrueColor format (24 Bit) before compression.

� Compress Motion-JPEG
Before editing computer animation with a video editing program as for
example Adobe Premiere, you should compress it in Motion-JPEG
format. This will drastically reduce processing time.

� Specify maximum frame size
The DC50 supports maximum formats up to 720 x 576 [PAL] / 720 x
468 [NTSC] pixels. For the highest quality, the frame size should be
horizontally divisible by 16.

For further information on using animation software under  Windows
NT, please refer to the ReadMe file.
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Troubleshooting

INSTALLATION

Hardware was not found during the DC50 hardware test.
1. From the Start menu and the Settings command, open the Control 

Panel.

2. Under System, select the Device Manager and the Sound, video- and
game controllers option.

3. If necessary, delete the following entry:

PCI Multimedia Video device
DC50, MotionJPEG Capture/CODEC board.

4. Restart Windows 95 / 98.

The following message should appear during startup:

New hardware component detected!
Insert data medium.

If this message does not appear during startup, install the DC50 in a
different PCI slot. If this still does not solve the problem, either the DC50
is defective or the video board is having problems with your system's
motherboard.

5. Confirm with OK.

6. Place the DC50 CD-ROM in your CD-ROM drive and enter the drive
identifier for your CD-ROM drive (i.e., D:) in the Windows command
line.

7. Click OK.

8. Restart the hardware test from the DC50 configuration program.

VSYNC IRQ was not activated by the DC50 hardware test.
The PCI slot, in which the DC50 is installed was not assigned an IRQ in the
BIOS.

If you cannot explicitly assign an IRQ to the PC slot in the BIOS, you must
define an IRQ as AVAILABLE for the PCI bus.

In this case, each PCI board must be assigned an IRQ via the corresponding
PCI slot during installation.

The DC50 supports IRQ sharing, that is, the DC50 shares the IRQ with
another PCI board (of course, this board must also support IRQ sharing!).
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This operating mode can, however, lead to performance loss when recording
and playing back videos.

My computer crashes when I start the DC50 hardware test or the
Capture program.
The DC50 is being used in conjunction with a graphics board based on an
S3 chip.

With graphics boards using a Vision968 S3 processor, there is sometimes a
problem because the 968 chip only requests 32 MB for itself, while actually
accessing 64 MB. The system maps the DC50 directly behind the graphics
boards, so that the graphics driver is reaching into the DC50 area. You must
change the graphics board mapping manually.

If the DC50 memory area is located directly after one of the graphics board's
memory areas, you must use the device manager to move the graphics board
memory resources to a different area. For example, the current setting is

graphics board: at F0000000-F1FFFFFF,
DC50: at F2000000-F2FFFFFF,

you must move the graphic board memory to, for example E0000000-
E1FFFFFF.

Proceed as follows to change the mapping for your graphic board's memory
area:

1. From the Start menu and the Settings command, open the Control Panel.

2. Click the System folder and activate the Device Manager.

3. In the Device Manager, select Computer and Graphic Cards. The current
graphics board is displayed.

4. Mark the graphics board and click Settings.

5. In the next window, click on the Resources register.

6. Deactivate the Automatic adjust control box.

7. Click on the Change Settings... switch.

8. Select a new memory area, then click OK.

Windows 95 must not indicate any other conflict, otherwise you must select
a different free area!

9. Exit the Device Manager.

10.Restart Windows 95 / 98, so your changes take effect.
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OPERATION

No output to video or to the PC monitor.
The AVI file to be output was not compressed with Motion-JPEG.

You must first import this file to, for example, Premiere, then, using Make
Movie, to convert to an AVI file with Motion-JPEG compression.

No output to video (Windows 95 / 98 only).
The DC50 can operate in two modes that can be selected from the DC50
Control.

After Windows has started the DC50 Control program is located in the
taskbar as a .

Double-click the  to open the miroVIDEO DC50 Control.

Under the DC50 Control Video Output activate the Video output & Preview
check box.

No output to the PC monitor.
You deactivated the overlay.

Windows 95 / 98
Open the miroVIDEO DC50 Control:

Double-click the  to open the miroVIDEO DC50 Control.

Click on the More button and activate the Activate overlay check box.

Windows NT
Open the miroVIDEO DC50 Control:

1. From the Start menu select miroVIDEO DC50, Tools, and miroVIDEO
DC50 Control.

2. Select the General tab and activate the Overlay.

When using a component device as source wrong colors appear.
Windows 95 / 98
Open the dialog box “miroVIDEO DC50 video Input”:

1. Start Adobe Premiere and select the File menu and the commands
Capture and Movie Capture.

 The Movie Capture menu appears.

2. Click on Movie Capture, VfW Settings and on the Video Input button.

 The dialog box miroVIDEO DC50 Video Input appears.

3. Click on the Extended button and use the Sync delay button to adjust the
wrong colors.
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Windows NT
Open the miroVIDEO DC50 Control:

1. From the Start menu select miroVIDEO DC50, Tools, and miroVIDEO
DC50 Control.

2. Select the Comp. In. tab and use the Sync delay button to adjust the
wrong colors.

PERFORMANCE PROBLEMS DURING DIGITIZING

Images are missing from the recording.
Your hard disk’s transfer speed is too low.

In some computer combinations, the value determined by miroVIDEO
EXPERT may be wrong.

In this case, you must continue reducing the data rate until no more frames
are dropped.

When working with some E-IDE hard disks, the playback may “jump” when
an AVI file is played back at higher data rates. This can be traced back to
the fact that the hard disk carries out a recalibration while reading the file,
thus interrupting playback.

This problem is not caused by the DC50, but is the result of the manner in
which the hard disk operates and interacts with other system components.

There are several solutions you can use to increase the speed of your hard
disk:

1. From the Start menu and the Settings command, open the Control Panel.

2. Open the System file, then activate the Performance, File System, and
Troubleshooting commands.

3. Activate the Disable write-behind caching for all drives option and click
OK.

4. In the Control Panel, click System, Performance, File System and Hard
Disk.

5. Set the Read-ahead optimization option to None.

In general, this will result in an increase in the data transfer rate.
CAUTION: In some hard disks, however, this can result in a decrease in
the write rate!.

When running the DC50 under Windows 95 / 98, we recommend using
Adobe Premiere to capture AVI files.

When recording very short video sequences, you should capture them
directly to the hard disk and not to your unit's virtual memory.

For playback, use the Windows 95 / 98 media player.
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Inadequate image quality.
Compression is set too high or the data rate is set to low.

If possible, use a faster hard disk.

PROBLEMS PLAYING BACK AND EDITING VIDEOS

Video and audio are asynchronous.
Load the video sequence in your video processing software (Adobe
Premiere, U-LEAD Video Editor) and create a new movie from it. Under
Output Options, select Sound after every frame.

No frames were dropped during digitizing with sound, but the movie
“jerks” when played back.
Load the video sequence in your video processing software (Adobe
Premiere, U-LEAD Video Editor) and create a new movie from it. Under
Output Options, select Sound after every frame.

In some cases it may also be necessary to deactivate the Optimize still frame
option in the Compress command of the Make Movie menu.

No frames were dropped during digitizing with sound, but the video
sequence "jerks" after editing with video processing software (Adobe
Premiere).
Note the number of recorded frames after capture. Use this number to
calculate the resulting movie length (duration). At 25 frames/sec., this is:

Number of frames / 25 (PAL) = Time.

Load the clip in your video processing software and select the menu item to
redetermine clip duration. Enter the calculated time here.

Caution: in many programs, the last two clip duration places are not tenths
of seconds, but number of frames (0-24).
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VIDCAP32

VidCap32 aborts with a General Protection Fault.
Internal VidCap32 application failure.

Known problems:

The standard VidCap32 setting is to place the capture file on
C:\CAPTURE.AVI. To use a different drive, change the drive designator.

After doing this, VidCap32 may abort because a “supposed” protection
violation. Immediately restart VidCap32, ignore the error message stating
that the desired device is already in use, and specify the desired drive. Then
close VidCap32 and restart Windows 95.

ADOBE PREMIERE

The DC50 project presets are not displayed when starting Premiere.
Start the installation program and install the presets.

1. Place the DC50 CD-ROM in your CD-ROM drive. Select the Run…
command from the Start menu.

2. Enter d:\setup\setup in the command line, where d:\ represents
the CD-ROM drive designator.

The installation program starts.

3. In the Setup type window, select the Custom option and click on Next.

4. In the Select Components window, activate Project defaults for Adobe
Premiere and click Next.

The installation copies the project default settings to PLUG-INS
directory.

When an attempt is made to play and AVI back with Adobe Premiere,
the following error message appears:

MCI error.
Unable to open the AVI-MCI driver.
Too many drivers loaded.

1. Before calling up Adobe Premiere, open Windows Explorer. Then open
the AVI file under Premiere.

2. Close Windows Explorer: you can now start the AVI file.

3. Under Premiere, put the capture file on a different drive.

In Adobe Premiere, the drive used for recording is determined by the
drive entry for Adobe's virtual memory.

In Adobe Premiere, this menu item is listed under the File menu and the
Preferences and Scratch Disk / Device Control commands.
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WINDOWS 95 / 98

Hardware not found during installation.
Solution
1. From the Start menu and the Settings command, open the Control Panel.

2. Under System, select the Device Manager and the Sound, video- and
game controllers option.

3. Delete the following entry if it exists:

PCI Multimedia Video device
DC50, MotionJPEG Capture/CODEC board.

4. Restart Windows 95 / 98.

The following message should appear during startup:

New hardware component detected!
Insert data medium.

If this message does not appear during startup, install the DC50 in a
different PCI slot. If this still does not solve the problem, either the DC50
is defective or the video board is having problems with your system's
motherboard.

5. Confirm with OK.

6. Place the DC50 CD-ROM in your CD-ROM drive and enter the drive
identifier for your CD-ROM drive (i.e., D:) in the Windows command
line.

7. Click on OK.

8. Restart the hardware test from the DC50 configuration program.

General crash or error function.
Make sure the DC50 driver has been completely installed in Windows 95 /
98.

Use the Control Panel, Multimedia, Advanced, Video Capture Devices to
configure the DC50, Motion-JPEG Capture/CODEC board driver.

The Use this capture device option must be activated if you want to use the
DC50 to record.

If other drivers are listed under Video Capture Devices, make sure the DO
NOT use this capture device option is activated for them.
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WINDOWS NT

The DC50 driver outputs the following error messages in case of
malfunctions:

Device not found - 0x0001.
No DC50 board has been installed in your computer or the hardware is
defective.

Install the DC50.

Memory allocation failed - 0x0002.
Not enough memory available.

Upgrade the memory of your computer. The memory has to have at least 32
MByte. Use the Device Manager to remove drivers you do not need. (Start
menu, Settings, System Settings, System, Device Manager).

Resource allocation failed - 0x0003.
Not enough system resources available.

Use the Device Manager to remove drivers you do not need. (Start menu,
Settings, System Settings, System, Device Manager).

Symbolic link failed - 0x0004.
Deinstall the DC50 driver. Install this driver again after restarting the
system.

Connecting to interrupt failed - 0x0005.
No interrupt could be allocated to the PCI slot where the
DC50 has been inserted.

Insert the DC50  board into another PCI slot.

or

The DC50 board has to share an interrupt with another board and this
device does not support interrupt sharing.

Insert the DC50 board in another PCI slot or allocate a separate interrupt to
the DC50 in the computer BIOS.

Init failed - 0x0006.
I22 component defective.

Consult you retailer.

or
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No DC50 board has been installed in your computer but another I22-based
hardware.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.

Decoder init failed - 0x0007.
Decoder defective.

Consult you retailer.

or

No DC50-Board has been installed in your computer but another I22-based
hardware.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.

Encoder init failed - 0x0008. .
Encoder defective.

Consult your retailer.

or

No DC50-Board has been installed in your computer but another I22-based
hardware.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.

Switcher matrix init failed - 0x0009.
Switcher Matrix defective.

Consult your retailer.

or

No DC50-Board has been installed in your computer but another I22-based
hardware.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.
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Coder init failed - 0x000A.
Coder defective.

Consult your retailer.

or

No DC50 board but another I22-based hardware is installed in your
computer.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.

Z016 init failed - 0x000B. .
Z016 defective.

Consult your retailer.

or

No DC50 board has been installed in your computer but another I22-based
hardware.

If the DC50 board has been installed in your computer, remove the board
from its slot and reboot the system. If  this does not solve the problem,
another I22-based board is installed in your computer. Insert the DC50
board in a PCI slot which is located in front of the other hardware.

miroINSTANT VIDEO

When using miroINSTANT Video there are dropped frames during the
playback.
This problem is typically present during transitions.

The Limit Data Rate setting in Adobe Premiere may not be set.

Open the project. Choose Make menu and the Compression command, then
select Limit Data Rate. Set the Limit Data Rate value to the same data rate
of your captured clips for this project.

When using miroINSTANT Video the quality of the transitions is poor
or of a lesser quality than the rest of the video.
The video may be recompressing. Either the Limit Data Rate setting in
Adobe Premiere may be set too low or the Quality slider may not be set to
100%.

Open the project. Choose Make menu and the Compression command, then
select Limit Data Rate. Set the Limit Data Rate value to the same data rate
of your captured clips for this project.

Or

Open the project. Choose Make menu and the Compression command, then
set the Quality slider to 100%.
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When I try to access miroINSTANT Video by choosing the File menu
and the Export command, I cannot find the miroINSTANT Video
command.
Under Adobe Premiere 5.1 the miroINSTANT Video command does not
exist.

In the activated timeline window press the <Enter> key to start the video
playback.

After moving clips all edited sections have to be recalculated.
Use the multitrack tool when moving the clips.

Select the multitrack button from the toolbar of the Construction Window.
All selected video clips can then be moved without Premiere forgetting
where the effects have been inserted. The Edit menu item and the Select all
command let you move the whole project.
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Technical data

GENERAL

32-bit PCI board with bus-mastering

ZORAN ZR36050

Standby: 4 Watt
Operation: 7 Watt

Pentium or compatible PC (133 MHz or higher) with a free PCI slot
at least 64 MByte memory (256 MByte recommended)
Sufficient hard disk capacity
Microsoft Windows 95 or Windows NT 4.0

PAL, NTSC, SECAM, PAL-N, PAL-M

Internal color representation always YUV 4:2:2 (24 bit RGB)

up to 7MBytes/s sustained data rate to hard disk for compressed data,
up to 5.5MBytes/s sustained data rate to graphics board for video overlay.

Brightness, contrast, saturation, sharpness
cropping
recording format
data rate
compression

Level: -10 dBu
Input Headroom: 16 dB
Output Headroom: 15 dB
SNR: 78 dB @ 1 kHz
THD+N: 0.025% @ 1 kHz, 20 Hz - 20 kHz bandwidth
Frequency response: +0 dB, -0.6 dB, 20 Hz - 20 kHz bandwidth
Input gain: -6 dB to +16.5 dB in steps of 1.5d B
(Reference: 0 dBu = 0.775 Vrms)

Board

JPEG Processor

Power supply

System
requirements

TV standards

Colors

Data rate

Settings

Unbalanced
Audio
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Level: +4 dBu
Input Headroom: 12 dB
Output Headroom: 10 dB
SNR: 72 dB @ 1 kHz
THD+N: 0.025% @ 1 kHz, 20 Hz - 20 kHz bandwidth
Frequency response: +0 dB, -0.4 dB, 20 Hz - 20 kHz bandwidth
Input gain: -6 dB to +16.5 dB in steps of 1.5 dB
(Reference: 0 dBu = 0.775 Vrms)

CONNECTORS

Video inputs/video outputs

1 x S-Video input
Mini DIN 4 connector, Y: 1Vpp, 75 Ohm, negative sync C: 0.30 0Vpp,
75 Ohm
1 x Composite video input
BNC connector, 1Vpp, 75 Ohm, negative sync, subcarrier burst
1 x Component video input
BNC connector x 3, Y: 1Vpp, 75 Ohm, negative sync, Cr, Cb: 0.300 Vpp,
75 Ohm
1 x Reference input
BNC connector, 1Vpp, 75 Ohm, negative sync, subcarrier burst

1 x S-Video output
Mini DIN 4 connector, Y: 1Vpp, 75 Ohm, negative sync C: 0.30 0Vpp,
75 Ohm
1 x Composite video output
BNC connector, 1Vpp, 75 Ohm, negative sync, subcarrier burst
1 x Component video output
BNC connector x 3, Y: 1Vpp, 75Ohm, negative sync, Cr, Cb: 0.300 Vpp,
75 Ohm
1 x Reference input
BNC connector, 1Vpp, 75 Ohm, negative sync, subcarrier burst

You can select the inputs, using the software. The video is output on both
outputs in best signal quality in parallel.

Balanced Audio

Video inputs

Video outputs
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Audio inputs/audio outputs

Connector data

Sampling rate: max. 48 kHz
Resolution: 16 bit linear per channel
Frequency range: 20 Hz - 20 kHz ± 3dB
Signal-to-noise ratio: >82dB

Impedance: 20 kOhm
Input amplification for microphone sensitivity + 20dB

(adjustable via software,
for dynamic microphones)
for Line sensitivity 0 dB (adjustable via software)

Max. input for microphone sensitivity 0.1 Vrms
voltage: for Line sensitivity 1 Vrms

Unbalanced Audio
2 x cinch connector, on external breakout box, -10 dBu input impedance 10
KOhm, 4 pin header, on PCB for CD-ROM connection, -10 dBu input
impedance 7 KOhm

Balanced Audio
2 x XLR connector (female), +4 dBu, input impedance min. 15 KOhm
(Reference: 0 dBu = 0.775 V)

Connector; 4-pin connector
No. Function

1 Left
2 Ground
3 Ground
4 Right

Impedance: 10 kOhm
Input amplification: 0 dB
Max. input
Voltage: 1 Vrms or 1.27 Vrms

Impedance: 600 Ohm
Min. load impedance: 10 kOhm
Max. output
voltage: 0.707 Vrms

Unbalanced Audio
2 x Cinch connector, on external breakout box, -10 dBu output impedance
600 Ohm, external load impedance min. 10 KOhm

Balanced Audio
2 x XLR connector (male), +4 dBu, output impedance 50 Ohm, external
load impedance min. 600 Ohm (Reference: 0 dBu = 0.775 Vrms)

Audio
inputs/outputs

Audio inputs

Audio input
(internal)

Audio output
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Appendix A:
Identifying the Windows version

To identify the installed Windows 95 version, you have to start the MS-
DOS Prompt.

1. In the Start menu, select the Programs command and the
MS-DOS Prompt.

2. In the MS-DOS Prompt window type ver, and press <Enter>.

The installed Windows 95 version will be displayed.

The Windows 95 OSR 2 (OEM-Service-Release 2) version has the
version number Windows 95. [Version 4.00.1111] or [Version
4.00.950b]; the August Windows 95 Release has the version number
Windows 95. [Version 4.00.950].

3. Close the MS-DOS Prompt.
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Appendix B:
JPEG image data compression

JPEG IMAGE DATA COMPRESSION

What is JPEG image data compression?

JPEG image data compression is a so-called “lossy” compression procedure,
i.e. a portion of the original data is lost during compression.

JPEG data compression provides considerably higher compression factors
than loss-free procedures. Lossless compression procedures can only
compress at a factor of 2:1, which is not sufficient for the compression of
image data.

A total of 21 Mbytes must be processed for one second of digitized
PAL/SECAM video material.

The lower the compression factor during compression, the better the result.

How does JPEG image data compression work?

JPEG data compression occurs in the following steps:

The first step of JPEG data compression is the image conversion from the
RGB format (i.e. computer image) to the YUV format. In this format Y
contains the brightness information (luminance), U and V deliver the color
information (chrominance).

Since the human eye can discern differences in brightness better than
differences in color, the Chrominance Subsampling method (reduced
scanning of color information) can be used to capture video. The
miroVIDEO DC50 uses the 4:2:2 ratio where there are four bits for
brightness information and two bits for color information: the U and V color
information of every second pixel only is used.

A TV image delivers YUV signals so that no information is lost when
digitizing video.

Each TV image delivers one brightness signal and two color signals per
pixel. The DCT (Discrete Cosine Transformation) converts these signals
into a frequency coefficient containing the color and the brightness
information.

Then the signals can be compressed more easily. The Discrete Cosine
Transformation is the most computation-intensive step of the JPEG data
compression. The DCT is lossless.

4:2:2
Subsampling

Discrete Cosine
Transformation
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By applying complex mathematical operations the quantization ensures that
image parts which are important to the human eye are represented precisely
and irrelevant information is represented with less precision.

The Run Length Encoding (RLE) method makes use of the fact that many
parts have the value “zero” after the DCT and the quantization operation
have been applied. Instead of saving all “zeros” individually, “zero” is only
saved once, together with a counter, which states how often it occurs in
succession.

The last step of image compression is the Huffman Coding method which
makes use of the statistical properties of the data to be coded. This method
evaluates how often and with what probability certain values occur. Values
that seldom occur, receive a long code, while values occurring often receive
a short code.

When playing back video the JPEG image compression steps occur in the
reverse order.

JPEG PROBLEMS

During compression with the JPEG algorithm, low JPEG quality can
produce two types of problems:

� A checkerboard pattern appears at sharp color transitions and edges
(light – dark).

� Unequal color distribution in uniform, soft shadows.

Sharp color transitions and edges

In order for JPEG image data compression to occur, a video image is first
divided in 8 x 8 image point blocks for Y portions (or 8 x 16 image points
for UV portions). During discrete cosine transformation, Y, U, and V
information is converted into frequency coefficients for each of these
blocks. After this conversion, sharp color transitions and edges produce high
frequency elements. During quantification, the data is reduced by, among
other things, any high frequency elements being "rounded off", and thus
more inaccurately displayed. The lower the specified JPEG quality, the
larger the “rounding-off factor”, and the more inaccurately any high
frequency elements will be displayed.

If the JPEG-compressed image is recalculated for analog output,
inaccuracies will arise. These will be greater, the lower the JPEG quality of
the original was. In the analog image, this calculated inaccuracy appears in
the form of deviating brightness and color information. Because the reverse
calculation is also performed block-by-block (see above), the deviant
information only reaches the exact frame limit, thus producing a flickering,
checkerboard pattern.

Quantization

Run Length
Encoding

Huffman-
Coding

Playback
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Soft shadows

Aside from the inaccurate reproduction of high frequency elements, other
data are also reduced during quantification. Here, the brightness and color
are also inaccurately shown.

When a JPEG-compressed image is recalculated, inaccuracies will also
result in this area. In the analog image, this calculated inaccuracy results in
surfaces that previously were the same color and brightness or were softly
shadowed, now exhibit a sudden color jump between individual blocks.
Here too, the problem only occurs on a block-by-block basis.

Computer monitors are particularly sensitive to JPEG problems. Recording
with a VCR will rectify these problems to a certain extent. For quality
control purposes, we therefore recommend that you perform a complete
work cycle, and then view the results from a VCR.
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Appendix C :
Multimedia Glossary

GLOSSARY

Multimedia terminology contains computer and video terminology. The
most important terms are defined in the following.

Cross references are marked with �.

Software interface by Microsoft for the control of multimedia devices under
Windows. � DirectShow, DirectMedia

Abbreviation for Adaptive Delta Pulse Code Modulation. It is a method of
storing audio information in a digital format, and is the audio encoding and
compression method used in CD-I and CD-ROM production.

All available saving positions in a computer are numbered (addressed). By
means of these addresses each saving position can be occupied. Some
addresses are reserved for special hardware components and may not be
used any longer. If two hardware components are using the same address,
this is called "address conflict".

An inaccurate display of an image due to the limitations of the output
device. Typically, aliasing appears in the form of jagged edges along curves
and angled shapes.

A method of smoothing out jagged edges in bitmap images. This is usually
accomplished by shading the edges with similarly colored pixels to the
background, thus making the transition less apparent. Another method of
anti-aliasing involves using higher resolution output devices.

The ratio of width to height in an image or graphic. Keeping the aspect ratio
means any change to one value is immediately reflected in the other.

Abbreviation for Audio Video Interleaved, standard format for digital video
(� Video for Windows).

This is an automated process which uses an Edit Decision List to locate and
re-capture specific clips from a videotape, usually at a higher data rate than
the clip was originally captured. A file under DOS in which commands
listed one below the other are executed in order from top to bottom.

Broadcast quality 1/2 inch video cassette format developed by Sony. This
system has continued to be developed over the years to offer models for the
industrial and professional markets.

Basic Input Output System. Basic In- and Output commands saved in a
� ROM, PROM, or EPROM. The essential task of the BIOS is the control
of Input and Output. When the system has been started, the ROM-BIOS
carries out some tests. � Parallel port, IRQ, I/O.

Aa - Fr

Pi - Uw

Je - Ph

Aa - Fr

Pi - Uw

Je - Ph

ActiveMovie

ADPCM

Address

Aliasing

Anti-aliasing

Aspect ratio

AVI

Batch Capture

Betacam

BIOS
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Binary Digit. The smallest element of a computer’s memory. Among other
things, bits are used to record the color values of pixels in an image. The
more bits used for each pixel, the greater the number of available colors. For
example:

- 1-bit: each pixel is either black or white.
- 4-bit: each pixel can be any one of 16 colors or gray shades.
- 8-bit: each pixel can be any one of 256 colors or gray shades.
- 16-bit: each pixel can be any one of 65,536 colors.
- 24-bit: each pixel can be any one of 16.7 million colors.

An image format made up of a collection of dots or “pixels” arranged in
rows.

The process of preparing a videotape for insert editing by recording video
black and continuous control track on the entire tape. If the recording deck
supports time code, then continuous time code will be recorded
simultaneously.

An image that contains only black and white pixels.

 File extension for � bitmap files.

Also “luminance”. Indicates the brightness of a video.

One byte corresponds to eight � bit. With one byte, exactly one character
can be displayed (i.e. letter, number). The encoding is binary, this means in
“zeros”" (0) and “ones” (1).

CD-ROMs are mass storage media for digital data, such as digital video.

Classifications of information in a data file to isolate a particular aspect of
the entire file. For example, color images use different channels to classify
the color components in the image. Stereo audio files use channels to
identify the sounds intended for the left and right speakers. Video files use
combinations of the channels used for image and audio files.

 That quality of colors which embraces both hue and saturation. White,
black, and grays have no chroma.

Any media type that goes on the Storyboard or Timeline. Can be video
images, video scenes, images, or audio files.

A temporary storage area shared by all Windows programs used to hold data
during cut, copy, and paste operations. Any new data you place onto the
clipboard immediately replaces the existing data.

 Rate at which individual commands are processed in a processor. The higher
the clock frequency, the quicker the commands are processed.

� GOP

Abbreviation for Compressor/Decompressor, compresses (packs) and
decompresses (unpacks) image data. There are different compression
methods (software CODECs and hardware CODECs).

Number of bits delivering the color information for each pixel. In the black-
and-white operation 1-bit color depth means 21=2 colors, 8-bit color depth
supply 28=256 colors, 24-bit color depth 16,777,216 =224 colors.

A color model is a way to mathematically describe and define colors and the
way they relate to each other. Each color models has a specific purpose; the
two most common color models are RGB and YUV

Bit

Bitmap

Blacking

Black and white

 BMP
Brightness

Byte

CD-ROM
Channel

 Chroma

Clip

Clipboard

 Clock frequency

Closed GOP
CODEC

Color depth

Color model
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Intensity of a color.

Complementary colors are opposite in value to primary colors. If you were
to combine a color with its compliment, the result would be white. For
example, the complimentary colors of red, green, and blue are cyan,
magenta, and yellow respectively.

A serial port located on the back of your computer for attaching modem,
plotter, printer, or mouse to a system.

Composite video encodes luminance and chrominance information into one
signal. VHS and 8mm are formats which record and playback composite
video.

A method for making files smaller in size on disk. There are two types of
compression: lossless and lossy. Files compressed with a lossless scheme
can be restored to their original state with no change to their original data.
Lossy schemes discard data during compression, so the file, when reopened
is slightly different.

Choosing the area of an image to be displayed.

 A cut is the switch from one camera angle to another.

 Digital Audio Tape. A format for storing music on magnetic tape, developed
in the mid-1980s by Sony and Philips.

Data per second, i.e. amount of data which a mass storage medium (hard
disk or CD-ROM) saves/plays back per second or the amount of data of a
video sequence per second.

The measurement of the speed at which information passes between storage
mediums, (ex. CD ROM or Hard Disk), and the display device, (ex. Monitor
or MCI device). Depending on the devices used, some transfer rates may
offer better performance than others.

Abbreviation for Discreet Cosine Transformation. Part of the JPEG image
data compression: The brightness and color information is saved as
frequency coefficient.

A unit of sound measurement that expresses the loudness of sound.

Digital videotape format which records DV-coded audio and video data on
Hi8 tapes. Currently sold only by Sony, Digital8 camcorders/VCRs can play
Hi8 and 8mm cassettes.

Digital video stores information bit by bit in a file (in contrast to analog
storage media).

System extension by Microsoft for multimedia application under Windows.
� ActiveMovie.

System extension by Microsoft for multimedia applications under Windows.
� ActiveMovie.

Direct (X) Extensions is a bundle of several system extensions developed by
Microsoft for Windows 95 (among others DirectDraw, Direct3D) to make
possible video and game acceleration.

A transitional effect in which the video is faded from one scene to the next.

The number of colors is increased for the human eye artificially by the
application of color patterns.

Color
saturation

Complementary
Color

COM Port

Composite
video

Compression

Cropping
 Cut

 DAT

Data rate

Data transfer
rate

DCT

Decibel
Digital8

Digital video

DirectMedia

DirectShow

DirectX

Dissolve
Dithering
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Abbreviation for Direct Memory Access.

A file containing information needed to operate peripherals. The Studio
capture driver operates the Studio capture board, for example.

Digital videotape format for recording digital audio and video on ¼”-wide
Metal Evaporated tape. Mini DV tapes hold up to 60 minutes of content,
while standard DV tapes can hold up to 270 minutes of content.

 The DV cassette features 500 lines of � resolution, component recording,
� signal-to-noise ratios (54dB) better than � Betacam, three times the
� chroma bandwidth of � Hi8 and � S-VHS (1.5MHz, the same as
Betacam), � time code, 16-bit � DAT-quality audio (or four tracks of 12-
bit, 32kHz), separate video and audio insert editing, and direct digital input
and output based on � IEEE-1394 for multiple video-stream transfers and
editing with no generation loss.

 On DV tapes, the video and audio data, the additional information (index
signals, time codes, etc.) and the ITI section (ITI= insert and track
information) are written to the DV tape as follows.

 

A d d itio n a l in fo rm a tio n

1 2  track s  =  1  fu ll im a g e  (PA L )

1 0  track s  =  1  fu ll im a g e  (N T S C )

V id eo  d a ta

A u d io  d a ta
IT I  sec tio n

 Recording format of a DV tape

Abbreviation for Enhanced Compatible Port. Enables an accelerated bi-
directional data transfer via the � parallel port, a slight data compression
may arise. � EPP

A list of clips and effects in a particular order that will be recorded onto
your output tape or AVI file. Studio allows you to create and edit your own
edit decision list by adding, deleting and reordering clips and effects in the
Storyboard or Timeline view of the Movie window.

Abbreviation for Enhanced Compatible Port. Enables an accelerated bi-
directional data transfer via the � parallel port. � ECP

Abbreviation for Erasable Programmable Read Only Memory. Memory
chip that after programming saves it's data without power supply. The
memory contents may be erased with ultraviolet light and can be re-written.

A digital effect that fades up from black at the beginning the clip or down to
black at the end of the clip.

A frame of video consists of horizontal lines and is divided into two fields.
All odd lines of a video frame are Field 1. All even-numbered lines are Field
2.

DMA
Driver

DV

 DV cassette

 DV recording
format

ECP

Edit decision list
(EDL)

EPP

EPROM

Fade To/From
Black
Field
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 All common TV systems (NTSC, PAL, SECAM) use the following trick to
avoid image flicker: Instead of creating a complete frame 30 (or 25 for PAL)
times per second, half the lines are displayed at 60 (50) times a second and
then the other half are woven in at 60 times per second in a process called
interlace scanning. First, all odd lines (lines 1,3,5 etc.), then, all even lines
(2,4,6 etc.) are drawn. The images consisting of either odd or even lines are
called fields.

The ways in which a computer stores images or information on a disk.

Tools that alter data to produce special effects.

Apple Computer’s trademarked name for the IEEE-1394 serial data
protocol.

A single image in a video or animation sequence. If using full NTSC or PAL
resolution, one frame consists of two interlaced fields.

Frame rate defines how many frames of a video sequence are played in one
second. The Frame rate for NTSC video is 30 frames per second. The frame
rate for PAL video is 25 frames per second.)

The maximum size for displaying image data in a video or animation
sequence. If an image intended for the sequence is larger than the frame
size, it must be cropped or scaled to fit.

A number of periodically recurring processes (i.e. sound signals, images,
alternating voltage per unit of time, normally per second (Hertz).

In � MPEG compression the data stream is divided into different sections
first, the so called GOPs (Group of Pictures), each containing several
frames. One GOP contains three types of frames: I-Frames, P-Frames and
B-Frames.

The GOP size defines, how many I-, B-, or P-Frames (pictures) are included
in one � GOP. Current GOP sizes are for example 9 or 12.

Compression method which creates compressed digital video sequences.
These video sequences need special additional hardware to be
recorded/played back and offer a better image quality than data compressed
with software CODECs.

Improved version of Video8 using S-Video recorded on Metal Particle or
Metal Evaporated tape. Because of higher luminance resolution and wider
bandwidth, the result is sharper pictures than Video8.

For images, this normally means a 16-bit (5-6-5) data type that can contain
up to 65,536 colors. TGA file formats support images of this type. Other file
formats require prior conversion of a HiColor image into True Color. For
displays, HiColor normally refers to 15-bit (5-5-5) display adapters that can
display up to 32,768 colors.

Differentiation of colors with terms like red, yellow, orange.

Part of the JPEG image data compression. seldom occurring values receive a
long code, while constantly-occurring values receive a short code.

Acronym for Integrated Device Electronics. A hard drive-interface that
combines all drive control electronics on the drive itself.

 Field

File format
Filters

FireWire

Frame

Frame rate

Frame size

Frequency

GOP

GOP size

Hardware
CODEC

Hi8

HiColor

Hue

Huffman-
Coding

IDE
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 The Institute of Electrical and Electronics Engineers, boasting a membership
of over 320,000, is the world's largest professional society. The IEEE was
formed by a 1963 merger of the American Institute of Electrical Engineers
(AIEE) and the Institute of Radio Engineers (IRE).
 One of the most important functions of the IEEE is the coordination,
development, and publication of standards for electrical and electronic
devices and systems.

 Many IEEE standards are adopted by international standards bodies. As the
major manufacturers of consumer audio/video components and personal
computers adopt IEEE-1394, it is likely to become one of the most widely-
implemented IEEE bus standards.

 All IEEE standards begin with a Project Authorization Request (PAR). The
PAR for � FireWire, originally called “A High Performance Serial
Backplane Bus Interface Standard” was approved on September 26, 1991,
establishing P1394 as the designation for the proposed standard. After more
than four years of continuous deliberations on the part of the P1394
Working Committee, the IEEE Standards Board approved the IEEE-1394-
1995 Standard for a High Performance Serial Bus on December 12, 1995.

 IEEE-1394 – sometimes referred to as � FireWire® – is an international
standard, low-cost digital interface completed in 1995 by the � IEEE. Sony
calls this interface i.LINK.
IEEE-1394 integrates entertainment, communication, and computing
electronics into consumer multimedia. Sony´s DCR-VX700 and DCR-
VX1000 digital video camcorders were the first commercial products to
implement IEEE-1394.

In general, IEEE-1394 is:

� A hardware and software standard for transporting data at 100, 200, or
400 megabits per second.

� A digital interface allowing a seamless connection between computer
and peripherals – there is no need to convert digital data into analog.

� A physically small interface.

� “Hot pluggable” – users can add or remove 1394 devices with the bus
active.

An image is a reproduction, or picture of something. In this case, the term is
used to describe digitized pictures, consisting of pixels, which can be shown
on a computer display and manipulated by image enhancement software.

Method to reduce the amount of data of digital image and video files.

In an insert cut, an individual clip is copied into a longer one.

one.

Interlaced describes the refresh method which the PAL and other TV
systems use: The PAL TV image consists of two image halves (fields) of
3121/2 lines each. The NTSC TV image consists of two image halves of
2421/2 lines each.

 IEEE

 IEEE-1394

Image

Image
compression

Insert cut

Interlaced
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An arrangement of audio and video to promote smoother playback and
synchronization or compression. The standard AVI format equally spaces
audio and video.

Abbreviation for Input/Output.

Irrelevant (unimportant) information can be eliminated during the image
data compression, since the human eye does not realize that this information
is missing.

Interrupt Request. Interrupt in a running process of the computer. Interrupts
can be requested both by the hardware (i.e. keyboard, mouse) and the
software.

Insert & Track Information. Information that is saved on the digital
videotape by means of � insert cuts and tracks.

Abbreviation for Joint Photographic Experts Group. Also refers to a
standard for compressing digital frames based on Discrete Cosine
Transformation.

One KByte (Kilobyte) corresponds to 1024 � Byte. The “K” always stands
for the number “1024”.

A color made transparent so that a background image can show through.
Most commonly used when overlaying one video sequence on top of
another, allowing the underlying video to display wherever the key color
appears.

A method to help in the compression of video files, which works by
assigning certain frames as key frames whose video data is completely
saved at the time of compression. The video data of any intervening frames
between two key frames is then only partially saved. On decompression
these partial frames reconstruct their data from the key frames (e.g. MPEG).

Medium which stores analog video. Information on laser disks can only be
read, but not changed.

Long shots later provide the viewer with an overview and establish the
scene of the action. However, these scenes can also be used later to shorten
longer scenes. When you cut from a close-up to a long shot, the viewer no
longer sees the details and it is thus easier to make a chronological jump.
Showing a spectator in a semi-long shot can also distract briefly from the
actual action.

� Parallel port

� Brightness

MPEG file that contains video data only. � MPA, MPG

One MByte (Megabyte) corresponds to 1024 � KBytes or also 1024 x
1024 bytes.

In video editing, the mark in and mark out times refer to the starting and
ending time codes that identify the portions of clips to be included in the
project.

Media Control Interface. Developed by Microsoft as a means to play audio
and video data. It is also used to connect a computer to an external video
source such as a VCR or laser disc.

A method for the transmission of electrical information.

Interleave

I/O
Irrelevance

IRQ

ITI

JPEG

KByte

Key color

Key frame rate

Laser disk

Long shots

LPT
Luminance

M1V
MByte

Mark In / Mark
Out

MCI

Modulation



XII  miroVIDEO DC50

Video for Windows format for JPEG-compressed video sequences specified
by Microsoft.

MPEG file that contains audio data only. � M1V, MPG

Abbreviation for Motion Pictures Experts Group. Standard for the
compression of moving images. Compared to M-JPEG, it offers 75-80%
data reduction with the same visual quality.

MPEG file that contains both video and audio data. � M1V, MPA

MPEG file that contains video data only. � MPA, MPG

Image refresh method, where the complete image is generated without
skipping lines. A non-interlaced image (like your computer monitor) flickers
much less than an interlaced image (like your TV).

Abbreviation for National Television Standards Committee; also, a color
TV standard created by this group in 1951 using 525 lines and 60 image
fields per second. NTSC is used in North and Central America as well as
other countries.

Abbreviation for Phase Alternation Line. Color TV standard developed in
Germany using 625 lines and 50 image fields per second. It is the
predominant European TV standard.

By the parallel port data is transmitted via a 8-bit data line. This means that
8 � bit (1 � byte) can be transmitted at the same time. This kind of
transmission is much faster than via a � serial port, but it is very sensitive
over long distances. Parallel ports are indicated with LPT and a number (i.e.
LPT1).

Peripheral Component Interconnect. Local Bus concept by Intel: 32-bit bus,
a PCI bus can transfer 132 MByte per second (max.) at a � clock
frequency of 33 MHz. (� PCI slot)

There are two kinds of expansion slots on most PCs: PCI and ISA. PCI slots
are usually made of white plastic and are much smaller than ISA slots.

Abbreviation for picture element. Pixels are the smallest elements of a
monitor image.

Electrical transfer point for the adaptation of audio, video or control data
between two devices. � serial port, parallel port

The colors that are the basis of the RGB color model: red, green, and blue.
By varying how these colors are blended on screen, it is possible to create
any other color.

Quarter Standard Image Format. � MPEG I format describing the
resolution which is 176 x 144 under PAL and 176 x 120 under NTSC.
� SIF

Part of the JPEG image data compression. Relevant details are represented
precisely, less relevant details for the human eye are represented with less
precision.

Random Access Memory. A RAM component is a write-read component
from which data can be read and to which data can be written. The memory
of computers is equipped with RAM components. RAM components are
volatile, that is their content will be deleted after the computer has been
switched off.

Motion-JPEG
(M-JPEG)

MPA
MPEG

MPG

MPV
Non-interlaced

NTSC

PAL

Parallel port

PCI bus

PCI slot

Pixel

Port

Prime colors

QSIF

Quantization

RAM
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The area of a video display that is covered by sweeping the electron beam of
the display in a series of horizontal lines from upper left to lower right (from
viewer’s perspective).

Redundant (superfluous) information can be eliminated during the image
compression. During decompression the images can be restored completely.

A database in Windows 98 in which configuration data is stored. Among
other things, the registry contains: the Windows 98 system settings, the
configuration data for Windows-98-compatible applications, and user-
specific configuration data.

The number of pixels which can be displayed on the monitor horizontally
and vertically. The higher the resolution, the more details can be displayed.

Abbreviation for Red, Green and Blue, the basic colors of additive color
mixing. RGB describes the method used in computer technology where
image information is transferred by dividing it into the three basic colors.

Abbreviation for Read Only Memory. Memory chip that keeps it's data
without power supply after being programmed once. � EPROM

The RLE = Run Length Encoding method is part of the JPEG compression.
Repeating values are not saved individually but with a counter, which states
how often the values occurs in succession.

Adaptation to the desired image size.

One or more video clips that belong together thematically.

Abbreviation for Small Computers System Interface. SCSI is used as hard
disk interface for high-performance PCs because of its high data rate. Up to
eight  SCSI devices can be connected to a computer at the same time.

A number that identifies a SCSI device which is connected to a � SCSI
host adapter.

Normally, a SCSI host adapter is a supplement board which connects the
computer (host) and the SCSI bus. (Here, the DV500 board is also called a
host adapter.)

Electrical circuit at the end of a cable which prevents the reflection of
electrical signals when they reach the cable. Each SCSI bus (only) needs
two terminators. The terminators have to be fixed at the outermost ends of
the SCSI cables and not in the middle of a bus.

Abbreviation for Sequential Couleur à Mémoire. Color television
transmission system used in France and Eastern Europe developed on the
basis of the PAL system operating with 625 lines and 50 image halves per
second.

By the parallel port data is transmitted via a 1-bit data line. This means that
during a transmission of 8 � bit (1 � byte) these bits have to be
transmitted one after the other. Thus, this kind of transmission is much
slower than via a � parallel port. Serial ports are indicated with COM and
a number (i.e. COM2).

Standard Image Format. � MPEG I format describing the resolution which
is 352 x 288 under PAL and 352 x 240 under NTSC. � QSIF

The ratio of noise to good signal (picture) information usually expressed in
dB.

Raster

Redundance

Registry

Resolution

RGB

ROM

Run Length
Encoding

Scaling
Scene
SCSI

SCSI-ID

SCSI
host adapter

SCSI
terminator

SECAM

Serial port

SIF

Signal-to-noise
ratio
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A single frame is part of a series or sequence. When this series is watched
with enough speed, a "moving picture" is be created.

Compression method to compress digital video sequences which can be
played back without special hardware. The quality of these sequences
depends on the performance of the complete system. VHS quality is not
achieved.

Method of creating still images (or “freeze-frames”) from video.

Improved version of VHS using S-Video and Metal Particle tape to deliver
higher luminance resolution, resulting in sharper pictures than VHS.

With S-Video (Y/C) signals, the brightness (luminance or “Y”) and the
color (chrominance or “C”) information are transferred separately using
multiple wires, avoiding modulating and demodulating the video and the
resulting loss of picture quality.

The time code identifies the position of a frame in a video sequence with
respect to a starting point, (usually, the beginning of the clip). Its usual form
is Hours:Minutes:Seconds:Frames (e.g., 01:22:13:21). Unlike a tape counter
(which can be “zeroed” or reset at any point in a tape), time code is an
electronic signal written on a videotape, and is permanent once it is
assigned.

Transitions divert the viewer’s attention from the actual action, enabling
filmmakers to make chronological jumps, for example, without the viewer
being conscious of them.

An image that contains enough color to appear ”true” to life. For an image,
this normally means 24-bit color, providing up to 16.7 million colors.

TWAIN defines a standardized software interface for communication
between graphics and/or capture programs and devices that supply graphical
information. If the TWAIN driver is installed, the capture function of the
respective program (i.e. MS Imagine) can be used to load images directly
from your video source into the graphics program.

The TWAIN driver supports 32-bit programs only and captures images in
24-bit mode.

Abbreviation for Videocassette Recorder.

Abbreviation for Video Home System. System commonly used for home
VCRs to record and play back images and sound using a 1/2" tape. VHS
systems use & composite signals consisting of brightness and color
information.

Video system using a 8 mm tape. Video8 recorders generate composite
signals.

CD-ROM standard with � MPEG compressed videos.

Converts digital information into analog signals.

Converts analog signals into digital information.

Video for Windows is a Microsoft Windows system extension which
records, stores and plays back video sequences from hard disk (digital
video).

A protocol used by several devices for controlling external video sources
from computers.

Single frame

Software
CODEC

Still-Video
S-VHS

S-Video

Time Code

Transition

TrueColor

Twain driver

VCR
VHS

Video8

Video CD
Video decoder
Video encoder

Video for
Windows

VISCA
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Frequency with which the video signal is scanned onto an image display.
The higher the video scan rate the higher the image quality and the less
noticeable the flicker.

File format for audio signals, generally also the file extension for audio files
(*.wav).

In an electronic camera the amplifiers for the three color channels red,
green, and blue are adapted to each other in a way that white image parts of
a scene are played without color cast and thus all colors within the color
area of the TV are played correctly.

Y/C is a signal consisting of two components: Y = Brightness information,
C = Color information.

Color model of a video signal where Y delivers the brightness information
and U and V the color information.

Video scan rate

Wav

White balance

Y/C

YUV
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Appendix D:
Support questionnaire

------------------------------------------------------------------------------------------

From:

Mr./Ms./Company: ____________________________________________

Street, No.: ____________________________________________

Postal code, City : ____________________________________________

Phone : ____________________________________________

Fax : ____________________________________________

------------------------------------------------------------------------------------------

Dear customer,

In case of technical problems please read the enclosed manual first or
consult your retailer.

In case this is not sufficient, please keep the following information ready.

System configuration

1. Which type of computer do you use?

Manufacturer:   _______________   model name:   ______________

Motherboard:   ___________________   chip set:   _________________

Processor:
Manufacturer: ________________   Type:_____________   _____ MHz

Dual CPU    Yes   No

2. At which clock rate does your computer operate?   _____ MHz
At which clock rate does the I/O bus operate?   _____ MHz

3. How many RAMs are installed in your computer?  _____ MB RAM
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4. Which Microsoft Windows version do you use?   

 Windows 95    Version:   _________

 Windows 98    Version:   _________

 Windows NT   Version:   _________    Service Pack:  ___________

 Windows 2000    Version:   _________

Computer peripheral

1. Which hard disk controller type is installed in your computer?

System Hard Disk
(hard disk, on which the operating system is installed)

 E-IDE   SCSI   Wide SCSI   Ultra Wide SCSI

 others   _____
Manufacturer and type:  _______________________________________

Video Hard Disk
(hard disk, on which the video data is digitized and edited)

 E-IDE   SCSI   Wide SCSI   Ultra Wide SCSI

 others   _____
Manufacturer and type:  _______________________________________

2. Which primary graphics board is installed in your computer?

Manufacturer and type: ______________________________________

Graphics chip: ______________________________________

3. Which base addresses (Hex), interrupts (Int) and DMA channels are used
by other hardware components? (i.e. scanner, fax,
modem, sound board, serial interface etc.) To make things clear, please
add a printout of the device manager under Windows 95.

__________________________________________________________

__________________________________________________________

__________________________________________________________

__________________________________________________________

__________________________________________________________

__________________________________________________________

__________________________________________________________
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miroVIDEO / Pinnacle Systems products

1. Which boards are installed in your computer?

1: miroVIDEO________________ ; 2: miroVIDEO________________

2. Which board version does the inserted board have?

1. Version:   _______ ;   2. Version:   _______

3. Which installation CD version do you use?
(see label on the installation CD)

1: Version:   _________ , date:   ________  , for Pinnacle:   _________
2. Version:   _________ , date:   ________  , for Pinnacle:   _________

4. Which addresses do the miroVIDEO board/s use?

1. Address:_____________h   Interrupt:______
2. Address:_____________h   Interrupt:______

5. Which video editing software do you use?

1. Manufacturer: ___________________ , version:_________________
2. Manufacturer: ___________________ , version:_________________

6. Which audio device do you use?

 miroVIDEO DC50

 Other sound board
       Manufacturer and type: __________________________________

7. Which video resolution and video data rate do you use?

Video resolution: _______ x _______

Video data rate: ________ MByte/s

Refresh rate: ________ Frames/s

 PAL  NTSC  SECAM
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Video devices

1. Which video devices do you use?

Player

Manufacturer and type: __________________________

Recorder

Manufacturer and type: __________________________

2. Which input / output of the miroVIDEO product do you use?

Input

 Component (Y, B-Y, R-Y)    S-VHS    Composite

Output

 Component (Y, B-Y, R-Y)    S-VHS    Composite

3. Do you use an external sync signal?

 Yes   No

4. Which device sends this signal?

_____________________________________________

5. Do you use a device control? If yes, which one?

_____________________________________________

Important

Please explain the problem you have with the installation or the operation of
your board in detail on a separate sheet of paper.
In addition to the questionnaire, please fax us a printout of your computer
configuration (e.g. the printout of the device manager, if you use Windows
95).

Thank you very much for your cooperation and for answering the questions!

Kind regards,

���������	
���
���������	�



XX  miroVIDEO DC50

Appendix E:
License agreement

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS
BEFORE USING THIS PROGRAM. USING THIS PROGRAM
INDICATES YOUR ACCEPTANCE OF THESE TERMS AND
CONDITIONS. IF YOU DO NOT ACCEPT OR UNDERSTAND THEM,
YOU SHOULD PROMPTLY RETURN THIS PRODUCT TO YOUR
VALUE-ADDED RESELLER OR DEALER.

The export and re-export of Pinnacle software products are controlled by the United States
Export Administration Regulations and such software may not be exported or re-exported to any
country to which the United States embargoes goods. In addition, Pinnacle software may not be
distributed to persons on the Table of Denial Orders, the Entity List, or the List of Specially
Designated Nationals.

By downloading or using an Pinnacle software product you are certifying that you are not a
national of any country to which the United States embargoes goods and that you are not a
person on the Table of Denial Orders, the Entity List, or the List of Specially Designated
Nationals.

Proprietary Property
This product, the Pinnacle Systems DV500 hardware, Pinnacle Systems’ trademarks, product
names, user manuals, documentation and other support materials are either patented,
copyrighted, trademarked, constitute valuable trade secrets (whether or not they or any portion
thereof may be copyrighted or patented) or are otherwise proprietary to Pinnacle Systems. In
addition, this program may contain the proprietary property of others which has been licensed to
Pinnacle Systems (such as utility or plug-in software or programs, clip art and sample files).
You agree not to remove any product identification or notices of the proprietary restrictions
from Pinnacle Systems’ products or manuals.

License and Prohibitions
You may:

(a) use the enclosed program, Pinnacle Systems DV500 hardware, and accompanying written
materials („programming materials“) in connection with a single computer. A copy of the
program is being furnished to you along with this license agreement. If you wish to use this
program on more than one computer, you must license additional copies of the program;

(b) use the program and accompanying written materials on a licensed computer network. A
„computer network“ is any combination of two or more terminals or computers that are
electronically linked and capable of sharing the use of a single software program. A
„licensed computer network“ is a computer network for which you have purchased from
Pinnacle Systems, or its dealer, sufficient copies of this program so that the number of
concurrent users of this program on the computer network at any given time is not greater
than that number of copies of the program so purchased;

(c) copy the program once only solely for backup purposes in support of your use of the
program so long as you prominently label the backup copy with the appropriate copyright
notice;

(d) use the program for your personal use or in your business or profession. Permitting
unauthorized users access to the program and program materials is a violation of this license
agreement; and
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 (e) transfer the program and license to another party if the other party agrees to accept the terms
and conditions of this agreement. If you transfer the program, you must at the same time
either transfer all copies to the same party or destroy any copies not transferred. If you
transfer possession of any copy of the program to another party, your license is
automatically terminated.

Prohibited Uses
You may not, without explicit prior written permission from Pinnacle Systems:

(a) use, modify or transfer the program, or copy the program in whole or in part, except as
expressly provided herein;

(b) reverse-engineer, decompile or otherwise recreate the program or hardware in whole or in
part;

(c) make copies of or distribute, for profit or otherwise, or authorize the copying or distribution
of the program, hardware, or materials related thereto, except as herein provided;

(d) make alterations to the program or merge it into any other software;

(e) grant sublicenses and leases or other rights in the program or program materials to others;

(f) make verbal or media translations of the program, in whole or in part, or of the program
materials;

(g) modify the program for use on non-compatible hardware;

(h) make telecommunications data transmissions of the program in whole or in part;

(i) distribute the program on either a permanent or temporary basis to others;

(j) make available any part of the program or program materials to any third party, other than
your own properly authorized employees; or

(k) make any alteration, modification, connection, disconnection, improvement or adjustment
of any kind to or use the Pinnacle Systems DV500 hardware except as explicitly
contemplated in the enclosed programming materials.

It is agreed that the violation by you of any of the prohibitions described above shall be a
material breach by you of this license agreement, and any attempt to sublicense, assign, or
transfer any of the rights, duties, or obligations under this agreement, except as expressly
provided herein, is void.

Term
The license is effective until terminated. You may terminate it at any time by destroying the
program together with all copies in any form. It will also terminate upon conditions set forth
elsewhere in this agreement or if you fail to comply with any term or condition of this
agreement. You agree that upon such termination you will destroy the program together with all
copies in any form.

Limited Warranty
The program is provided „as is“ without warranty of any kind, either expressed or implied,
including but not limited to the implied warranties of merchantability and fitness for a particular
purpose, with the sole exception of defective diskette(s) and Pinnacle Systems DV500 hardware,
described below. The entire risk as to the quality and performance of the program is assumed by
you. If the program proves defective, you (and not Pinnacle Systems, its Licensors, or its
dealers) assume the entire cost of all necessary servicing, repair or correction.
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Pinnacle Systems warrants to the original licensee that Pinnacle Systems DV500shall be free
from defects in material and workmanship only for a period of thirty (30) days from the date of
original purchase. If a defect covered by this warranty occurs during this period, and it is
returned to the dealer from whom it was purchased not later than five (5) days after the end of
such period, the dealer shall, at its option, either repair or replace the item. This warranty is in
lieu of all other express or statutory warranties, and the duration of any implied warranty,
including but not limited to the implied warranties of merchantability and fitness for a particular
purpose, is hereby limited to said thirty (30) day period.

Pinnacle Systems warrants to the original licensee that Pinnacle Systems DV500 shall be free
from defects in material and workmanship only for a period of one (1) year from the date of
original purchase. If a defect covered by this warranty occurs during this period, the licensee
may request a Return Material Authorization (RMA) number from Pinnacle Systems. Upon
receipt of the returned item(s), Pinnacle Systems shall, at its option, either repair or replace the
item(s). Items returned to Pinnacle Systems without RMA numbers will not be accepted. This
warranty is in lieu of all other express or statutory warranties, and the duration of any implied
warranty, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose, is hereby limited to said one (1) year period.

Pinnacle Systems’ and its Licensors’ liability is limited solely to the repair or replacement of the
enclosed media and Pinnacle Systems DV500 hardware, as set out above, and shall not in any
event include damages for loss of use or loss of anticipated profits, savings, costs, expenses or
other incidental or consequential damages arising out of the use or inability to use the program,
including without limitation, any damages arising from data or information lost or rendered
inaccurate, regardless of the form of action whether in contract, tort (including negligence),
strict product liability or otherwise, even if Pinnacle Systems, its Licensors, or its dealer has
been advised of the possibility of such damages.

Pinnacle Systems and its Licensors do not warrant, guarantee or make any representations that
the functions contained in the program will meet your requirements or that the use or operation
of the program or that the results of such use will be correct, accurate, reliable, current,
uninterrupted or error free; and you rely on the program and results of its use solely at your own
risk.

Some jurisdictions do not allow the exclusion or limitation of implied warranties, so the above
exclusion and limitation may not apply to you. Some jurisdictions do not allow the exclusion of
liability for incidental or consequential damages so the above exclusion may not apply to you.
This warranty gives you specific rights and you may also have other rights which vary from
jurisdiction to jurisdiction.

Updates
Periodically Pinnacle Systems may introduce new versions or releases of the software. To
qualify for notification of the availability of these new versions or releases and their prices, you
must first complete and return the enclosed program registration card. All new versions or
releases which are provided to you shall become part of the program and shall be governed by
the terms of this license agreement..
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KONFORMITÄTSERKLÄRUNG
DECLARATION OF CONFORMITY

Geräteart : Video Editor
Type Auf equipment : Video Editing Device

Produkt / Product : miroVIDEO DC50

Das bezeichnete Produkt stimmt mit den Vorschriften folgender EU-Richtlinie(n) überein :
The aforementioned product complies with the following European Council Directive(s) :

89/336/EWG Richtlinie des Rates zur Angleichung der Rechtsvorschriften der Mitgliedstaaten über die
elektromagnetische Verträglichkeit
Council Directive 89/336/EEC on the approximation of the laws of the Member States relating to
electromagnetic compatibility

Zur vollständigen Einhaltung dieser Richtlinie(n) wurden folgende Normen herangezogen :
To fully comply with this(these) Directive(s), the following standards have been used :

EN 55022 Class B : 1994 / A1: 1995 class B
EN 50082-1 : 1992 (ICE 801-2,-4 / ENV50140 / ENV 50141)

Dieser Erklärung liegt zugrunde : Prüfbericht(e) des EMV-Prüflabors
This certification is based on: Test report(s) generated by EMI-test laboratory

Aussteller / Holder of certificate : Pinnacle Systems GmbH
Frankfurter Straße 3c
D - 38122 Braunschweig

Braunschweig, 2. Juni, 1998
Braunschweig, June 2nd, 1998

................................................ ................................................
Oliver Hoheisel Georg Blinn
Engineering Manager Geschäftsführer / Managing Director

(Rechtsverbindliche Unterschrift / Legally binding)
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NOTES
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Index

4

4:2:2 Subsampling  II

A

Accept title, return to
Premiere  94, 112
Activate reference output  48
ActiveMovie  V
Address  V
Adobe After Effects  3
Adobe Premiere  3, 16, 51, 65,
89, 90, 94, 95, 105, 107, 110,
114, 121, 128
Adobe Premiere  89
Aliasing  V
Alignment  93
Alpha Channel  105, 110
Animation  121, 122
Anti-aliasing  V
Appearance  93, 97
Aspect ratio  101, V
Attributes  93, 97, 102, 103,
104
Audio data  38
Audio input  136
Audio inputs  136
Audio output  136
Audio playback  52
Audio recording  38
AVI  V

B

Background  94, 103, 105, 106
Balanced Audio  135, 136
Batch Capture  V
Betacam  V
BIOS  V
Bit  VI
Bitmap  VI
Blacking  VI
Blur  102, 103

Bold  92, 97
Breakout box  1, 20
Brightness  II, VI
Bring Forward One Layer  94
Bring to Front  94
Byte  VI

C

Cables  8
Capture resolution  49
Capturing  117
Channel  VI
Chroma  VI
Chrominance  II
Clear Selected Text  95
Clip  113, 114
Clock frequency  VI
Coarse  92, 94
CODEC  VI
Color  94, 97, 102, 103, 105,
106
Color depth  120, VI
Color Depth  120
Color display  45
Color model  VI
Color saturation  VII
Colors  134
COM Port  VII
Complementary Color  VII
Composite video  VII
Compression  2, 50, VII
Compression factor  38, 45
Computer system  6, 36
Configuration dialogue  38
Configuration program  36
Connector  47
Connectors  135
Constrain  101
Coordinates  92
Copy  92
Crawl  92, 107, 114
Create  107, 113, 114
Cropping  120, VII
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Cursor  92, 93, 94, 96, 99, 100,
101, 111
Cut  92

D

DAT  VII
Data rate  38, 45, 50, 126, 134
Data transfer rate  126
DCT  II, VII
DDraw overlay surface  36
DDraw primary surface  36
Decibel  VII
Decompression  2
Defragmentation  10
Deinstallation  10, 17
Deposit Current Style Here  104
Deselect  96
Digital8  VII
DirectDraw  6, 7, 36
DirectMedia  VII
DirectShow  VII
DirectX  VII
Dissolve  VII
Dithering  VII
DMA  VII
Duration  113, 114
DV  VIII
DV cassette  VIII
DV Recording Format  VIII

E

ECP  VIII
Edge  97, 102, 103
Edge2Edge  116
Edit  93, 94, 95, 97, 102
Edit decision list (EDL)  VIII
Editing  117
Editor menu bar  97
Effects  115
E-IDE  118
Ellipse  94, 98
EPP  VIII
EPROM  VIII
Error function  129

F

Face  97, 102, 103
Fade To/From Black  VIII
Field  IX

File  94, 113, 114
File Type  92, 113, 114
Film length  127
Find  94
Find Next  94
Fine  92, 94
FireWire  IX
FLC  122
Font  102
Format  38, 97, 102, 120
Frame  IX
FreeFX  82
Full justification  98
Function fault  37

G

General  57
GOP  IX
Gradient background  105, 106
Gradient colors  103
Gradient image  115
Grid  93, 98

H

Handles  93, 95, 96, 99, 100,
101, 111, 114
Hard Disk  117
Hardware  2
Hardware CODEC  IX
Hardware test  123, 129
Height  101
Hi8  IX
HiColor  IX
Horizontal  93, 98, 99, 109, 113
Hue  IX
Huffman Coding  III
Huffman-Coding  IX

I

I/O  XI
I-Beam cursor  108, 113, 114
IDE  IX
IEEE  X
IEEE-1394  X
Image  X
Image area  95
Image quality  127
Insert cut  X
Insert Picture  94, 105, 106
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Installation  11
DC50-Software  33

Interlaced  X
Interleave  XI
Iris Essentials  116
IRQ  XI
IRQ sharing  123
Irrelevance  XI
Italic  92, 97
ITI  XI

J

JPEG  XI
JPEG algorithm  III
Justification  93, 98, 99
Justify  98, 109, 113

K

Kaleidos  116
KByte  XI
Kerning  93, 99, 100
Kerning/Leading  93, 99, 100
Key color  XI
Key frame rate  XI
Key Type  105, 110
Keypad  98

L

Laser disk  XI
Launch  90, 107, 114
Layer  94, 100, 112
Leading  93, 99, 100
Livelrises  116
LiveWipes  116
Long shots  XI
Look  93, 97, 102
LPT  XI
Luminance  II, XI

M

M1V  XI
Mark In / Mark Out  XI
Marker  98
MByte  XI
MCI  XI
Media player  51, 65
Memory area  124
Menu  91, 92, 98

Menu Bar  91, 94, 95, 104, 107,
112, 114
miroINSTANT Video  2, 35, 43
miroVIDEO Capture  67
miroVIDEO DC50 Control  26,
56, 125
miroVIDEO Expert  2, 37
miroVIDEO EXPERT  37
miroVIDEO EXPERT  126
Modulation  XI
Motion JPEG  125
Motion-JPEG  XII
Move  93, 99, 101, 111
Move/Resize  93, 99, 101, 109,
111, 112
MPA  XII
MPEG  XII
MPG  XII
MPV  XII

N

Network Operations  120
New  92
Non-interlaced  XII
NTSC  8, XII

O

Object  93, 94, 96, 97, 101, 102
Online manual  35, 43
Opacity  94, 105, 106
Open  92
Overlay  120

P

Package contents  9
PAL  8, XII
Parallel port  XII
Parameters  102
Paste  92
Patterns  116
PCI bus  XII
PCI slot  XII
PCI storage link  38
Performance capabilities  37
Picture  94, 106
Pinnacle-FreeFX  82
Player

component video device  23
Composite video device  22
s-video device  21
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Player buttons  110
Playing  III
Point size  97
Port  XII
Position object  98
Power supply  134
Preset  121
Preset Styles  91, 97, 104, 108,
113, 114
Presets  29, 35, 40, 43, 128
Preview Area  89, 91, 108, 113,
114
Processor  134
Progressions  116
Project  67, 89, 90, 107, 113,
114
Project window  110, 111
Projects  68

Q

QSIF  XII
Quality settings  50
Quantification  III
Quantization  III, XII

R

Radiant  116
RAM  XII
Raster  XIII
Rate  114
Real-time overlay  45
Record  70
Record quality  45
Recorder

component video device  25
Composite video device  24
S-Video device  24

Recording control  54
Recording Control  52
Rectangle  94, 98, 112
Redo  93
Redundance  XIII
Refresh Rate  120
Registry  XIII
Reject title, return to
Premiere  94
Replace  94
Replace Background  94
Resize  93, 95, 99, 101, 107,
109, 112

Resolution  120, XIII
RGB  XIII
Roll  92, 107, 113
ROM  XIII
Rotate  93, 94, 95, 99, 101, 102,
107, 111, 112
Rotate/Skew  99, 101, 111, 112
Run Length Encoding  III, XIII

S

Save  92, 110
Save button  112, 113, 114
Scale  94
Scaling  101, XIII
Scene  XIII
Scrollable  107, 113, 114
SCSI  117, XIII
SCSI host adapter  XIII
SCSI terminator  XIII
SCSI-ID  XIII
Search and replace  94
SECAM  8, XIII
Select  92, 95, 96, 97, 98, 100,
108, 111, 113
Select All  95
Selected  93, 96, 100
Selection box  95, 96, 99, 101,
111, 114
Send Back One Layer  94, 100
Send to Back  94, 112
Serial port  XIII
Settings  69, 134
Setup type  33, 41
Shadow  97, 102, 103, 104
Shadows  IV
Shape  94, 107, 112
Shortcuts  92, 96, 97, 98, 100,
101, 108, 109, 110, 112, 113,
114
SIF  XIII
Signal-to-noise  XIII
Single frame  XIV
Size  92, 94, 97, 102, 108, 113
Skew  93, 94, 95, 99, 101, 107,
111, 112
Software  2, 33, 40
Software CODEC  XIV
Solid background  106
Solid color  103, 105
Sound recording  54
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Sound settings  52
Source material  117
Speed  113, 114
Splits  116
Spread justification  98, 99
Stand. In.  57
Stand. Out.  57
Status line  92
Still  92
Still-Video  XIV
Style  102, 104, 107, 108, 109,
113, 114
S-VHS  XIV
S-Video  XIV
System configuration  6, 7
System requirements  6, 134
System settings  117
System software  34, 43

T

Test  37
Text  93, 94, 95, 96, 97, 100,
102, 112, 121
Texture  97
Textures  116
Thirds  116
Time Code  XIV
Timeline  90, 107, 110, 111,
113, 114
Tips & Tricks  45
Title icon  90, 110, 113, 114
Titles  89
Tool  91, 92, 99, 101, 109
Toolbar  91, 92
TransActive  116
Transfer speed  126
Transform  94, 101
Transition  XIV
Transitions  115
Transparency  97, 105, 110
Trimming  89, 107, 113, 114
TrueColor  XIV
TruQuads  116
TV standards  134
Twain driver  XIV
Typeface  92, 97, 102
Typographical
Characteristics  92

U

Unbalanced Audio  134, 136
Underline  92, 97
Undo  93
Undo/Redo  93
Uniform  116
User interface  89, 91
Utilities  34, 43

V

Variable  116
VCR  XIV
Vertical  93, 98, 99
VHS  XIV
VidCap32  128
Video  110
Video CD  XIV
Video channel  110
Video for Windows  XIV
Video format  49
Video input  8, 47
Video inputs  135
Video loopthrough  47
Video output  8
Video outputs  135
Video safe area  91, 95, 113
Video scan rate  XV
Video settings  48
Video SpiceRack  9
Videogami  116
View  102, 104, 108, 113, 114
VISCA  XIV

W

Wav  XV
White balance  XV
Width  101
Window  104
Windows 95

OSR 2  31
Release August 95  30

Windows 98  32
Wipes  116

Y

Y/C  XV
YUV  II, XV
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